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About This Document

Purpose
This document describes the configuration of different types of services in the following terms:
l Basic concepts

l Networking diagram

l Signal flow and timeslot allocation

l Configuration process

Related Versions
The following table lists the product versions related to this document.

Product Name Version

OptiX OSN 500 V100R002

OptiX iManager T2000 V200R007C02

Intended Audience
This document is intended for:

l Data configuration engineers

l System maintenance engineers

l Installation and commissioning engineers

Organization
This document is organized as follows.

Topic Description

1 Starting the T2000 Describes the basic operations to quickly start of the T2000.
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Topic Description

2 Creating the Network Describes how to create an NE, how to create boards, how
to create fibers and cables, how to configure the protection
subnet, and how to configure SDH services, and how to
configure the clock on the T2000.

3 Configuring SDH Services Describes how to configure SDH services on the T2000.

4 Configuring Ethernet
Services

Describes how to configure Ethernet services on the T2000.

5 Configuring Broadcast
Data Services

Describes how to configure broadcast data services on the
T2000.

6 Modifying the
Configuration Data

Describes how to modify the configuration data on the
T2000.

7 Task Collection Describes the common operations required for configuring
various services on the T2000.

9 Glossary Lists the terms used in this document.

10 Acronyms and
Abbreviations

Lists the acronyms used in this document.

Conventions

Symbol Conventions
The symbols that may be found in this document are defined as follows.

Symbol Description

DANGER
Indicates a hazard with a high level of risk, which if not avoided,
will result in death or serious injury.

WARNING
Indicates a hazard with a medium or low level of risk, which if
not avoided, could result in minor or moderate injury.

CAUTION
Indicates a potentially hazardous situation, which if not avoided,
could result in equipment damage, data loss, performance
degradation, or unexpected results.

TIP Indicates a tip that may help you solve a problem or save time.

NOTE Provides additional information to emphasize or supplement
important points of the main text.
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General Conventions

Convention Description

Times New Roman Normal paragraphs are in Times New Roman.

Boldface Names of files, directories, folders, and users are in boldface.
For example, log in as user root.

Italic Book titles are in italics.

Courier New Examples of information displayed on the screen are in Courier
New.

Command Conventions

The command conventions that may be found in this document are defined as follows.

Convention Description

Boldface The keywords of a command line are in boldface.

Italic Command arguments are in italics.

[ ] Items (keywords or arguments) in brackets [ ] are optional.

{ x | y | ... } Optional items are grouped in braces and separated by vertical
bars. One item is selected.

[ x | y | ... ] Optional items are grouped in brackets and separated by vertical
bars. One item is selected or no item is selected.

{ x | y | ... }* Optional items are grouped in braces and separated by vertical
bars. A minimum of one item or a maximum of all items can be
selected.

[ x | y | ... ]* Optional items are grouped in brackets and separated by vertical
bars. Several items or no item can be selected.

GUI Conventions

The GUI conventions that may be found in this document are defined as follows.

Convention Description

Boldface Buttons, menus, parameters, tabs, window, and dialog titles are
in boldface. For example, click OK.

> Multi-level menus are in boldface and separated by the ">" signs.
For example, choose File  > Create > Folder.

Keyboard Operations

The keyboard operations that may be found in this document are defined as follows.
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Format Description

Key Press the key. For example, press Enter and press Tab.

Key 1+Key 2 Press the keys concurrently. For example, pressing Ctrl+Alt
+A means the three keys should be pressed concurrently.

Key 1, Key 2 Press the keys in turn. For example, pressing Alt, A means the
two keys should be pressed in turn.

Mouse Operations
The mouse operations that may be found in this document are defined as follows.

Action Description

Click Select and release the primary mouse button without moving the
pointer.

Double-click Press the primary mouse button twice continuously and quickly
without moving the pointer.

Drag Press and hold the primary mouse button and move the pointer
to a certain position.

Update History
Updates between document issues are cumulative. Therefore, the latest document issue contains
all updates made in previous issues.

Updates in Issue 01 (2009-01-20)
Initial formal release.
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1 Starting the T2000

About This Chapter

The following pages introduces some preparation operations that will ensure a smooth, trouble-
free launch of the T2000.

1.1 Starting or Shutting Down the T2000
The T2000 uses the standard client/server architecture and multiple-user mode. So, you are
recommended to start or shut down the T2000 by strictly observing the following procedure, in
order not to affect other users that are operating the T2000.

1.2 Entering the T2000 Common Views
In the common views of the T2000, you can manage the topology, equipment, protection subnet,
trail and clock.
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1.1 Starting or Shutting Down the T2000
The T2000 uses the standard client/server architecture and multiple-user mode. So, you are
recommended to start or shut down the T2000 by strictly observing the following procedure, in
order not to affect other users that are operating the T2000.

Background Information
l Start the computer and the T2000 application in the following steps:

1. Start the computer.
2. Start the T2000 server.
3. Start the T2000 client.

l Shut down the T2000 application and the computer in the following steps:

1. Exit the T2000 client.
2. Stop the T2000 server.
3. Shut down the computer.

1.1.1 Starting the Computer
To avoid computer damage or data loss, refer to the procedure provided to start the computer.
The startup procedures of the workstation are different from those of a normal PC. Follow the
correct procedure to perform the operations as required.

1.1.2 Starting the T2000 Server
After starting the computer, you need to start the T2000 server. Then you can log in to the
T2000 to manage the network.

1.1.3 Viewing the T2000 Process Status
When you fail to log in to the T2000 client or abnormally exit the T2000 client, you can use the
System Monitor to view the T2000 process status to decide whether the server is faulty.

1.1.4 Logging In to the T2000 Client
You can manage the network in the graphic user interface (GUI) only after logging in to the
T2000 client.

1.1.5 Exiting a T2000 Client
Before restarting the T2000 client or shutting down the T2000 server, you must exit the
T2000 client.

1.1.6 Shutting Down the T2000 Server
When the T2000 server is managing the system normally, do not perform this operation. In
special circumstances, for example, when modifying the system time of the computer where the
T2000 resides, or when upgrading the version, you can use the System Monitor to shut down
the T2000 server.

1.1.7 Shutting Down the Computer
Normally, do not shut down the computer. In special situations, for example, when the computer
becomes faulty, shut down the computer in the correct sequence. The shutdown procedures of
the workstation are different from those of a normal PC. Follow the correct procedure to perform
the operations as required.
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1.1.1 Starting the Computer
To avoid computer damage or data loss, refer to the procedure provided to start the computer.
The startup procedures of the workstation are different from those of a normal PC. Follow the
correct procedure to perform the operations as required.

Prerequisite
l The T2000 must be installed correctly.

l The power cable of the workstation or the computer, the power cable of the monitor, data
line and Ethernet line must be connected correctly.

l If there is printer, modem or other peripherals, their power line and data line must be
connected correctly.

Background Information

The T2000 can run in the UNIX or Windows operating systems. The functions are the same in
each operating system. To learn about the recommended hardware configuration, refer to the
OptiX iManager T2000 Product Description.

Procedure
l On UNIX

1. Power on the printer, modem and other peripherals.

2. Power on the workstation and the Solaris is automatically started. The Prompt dialog
box is displayed.

3. Enter the Username and the Password in the Login dialog box. For example, User:
t2000 (by default); Password: t2000 (by default).

4. Click OK to open the Common Desktop Environment (CDE) window.

l On Windows

1. Power on the printer, modem and other peripherals.

2. Power on the computer and the Windows is automatically started.

3. Enter the Username and the Password in the Login dialog box. For example, User:
t2000 (by default); Password: t2000 (by default).

4. Click OK to open the Windows user interface.

----End

1.1.2 Starting the T2000 Server
After starting the computer, you need to start the T2000 server. Then you can log in to the
T2000 to manage the network.

Prerequisite
l The computer where the T2000 is installed must be started correctly.

l The operating system of the T2000 server must be running correctly.
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l The T2000 license must be in the correct directory. If the T2000 server is installed on UNIX,
copy the license to the directory /T2000/server/license/. If the T2000 server is installed on
Windows, copy the license to the directory \T2000\server\license\.

l On UNIX, the Sybase must be started and work normally. On Windows, the SQL Server
must be started and work normally.

Procedure

Step 1 Double-click the T2000Server icon on the desktop of the T2000 server.

Step 2 In the Login dialog box, enter User Name, Password and Server. For example, User Name:
admin, Password: T2000 (T2000 is the default password of the admin user.) and Server:
Local.

NOTE

Periodically change the password and memorize it.

If the System Monitor logs in to the server that is installed on another computer, you need to set the server
to be logged in to in advance. The settings are similar to the settings of the server that a client logs in to
remotely. For details, see Set the server parameters.

Step 3 Click Login. Wait until the database process, T2000 core process, and the processes that are
optional according to the actual situation are in the Running state. Now the T2000 server is
started successfully.

Step 4 Optional: When needed, right-click on the process, and choose Start Process from the shortcut
menu to start the Extended NE Management Process, NGWDM NE Management Process,
RTN NE Management Process, SDH NE Management Process, WDM NE Management
Process, ASON SDH Management Process, ASON WDM Management Process, End-to-
End Common Management Process, End-to-End Eth Management Process, End-to-End
OTN Management Process, End-to-End SDH Management Process, and Northbound
Interface Module(SNMP) Process processes manually.

NOTE

If the System Monitor application is started, you can restart the T2000 server on the System Monitor.
Perform the following step:

Choose System > Start Server on the Main Menu of the System Monitor. Wait until the database process,
T2000 core process, and the processes that are optional according to the actual situation are in the
Running state, the T2000 server is started properly.

----End

1.1.3 Viewing the T2000 Process Status
When you fail to log in to the T2000 client or abnormally exit the T2000 client, you can use the
System Monitor to view the T2000 process status to decide whether the server is faulty.

Background Information
To view the status of the T2000 processes by UNIX command line, run the following command:
# /T2000/server/bin/showt2000server
If each process entered has a corresponding process ID and the specific ID does not change, the
T2000 processes are normal.
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Procedure

Step 1 Start and log in to the System Monitor.

Step 2 In the user interface of the System Monitor, click the Process tab, and view whether the status
of each process is Running.
l If the process status is Stopped, right-click on the process, and choose Start Process from

the shortcut menu. In this manner, the process is in the Running state.
l If the manual startup fails, it indicates that the process is abnormal.

l To save resources, you can close unwanted processes. Set the startup mode of the desired
process to Manual, and then select Stop Process.

----End

1.1.4 Logging In to the T2000 Client
You can manage the network in the graphic user interface (GUI) only after logging in to the
T2000 client.

Prerequisite
The T2000 server must be started correctly.

Background Information
When the T2000 server and the T2000 client are not on a computer, you need to install the client
on the computer where the server resides. Set ACL on the client and then issue the ACL setting
to the server.
l On the T2000 client, choose System > NMS Security Settings > ACL from the Main

Menu.
l Click Add. In the dialog box displayed, enter related information.

– Select IP Address or Segment and set an IP address or network section that can be
accessed according to the Example of format.

– Select Start IP address to end IP address and set the rang of IP addresses that can be
accessed according to the Example of format.

Procedure

Step 1 On the computer of  the T2000 client, double-click the T2000Client icon on the desktop. 

Step 2 Enter the User Name, Password of the T2000 client. For example, User Name: admin;
Password: T2000.

NOTE

l After the automatic login is selected, you do not need to enter the user name and password.

l By default, the initial user name is admin, and the password is T2000. To protect the T2000 from
unauthorized logins, you need to immediately change this password.

l The administrator needs to create new T2000 users and assign them to certain authority groups.

Step 3 Optional: Set the server parameters.

1. Click  to display the Server Setting dialog box.
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2. Click New to display another Add Server dialog box.
3. In the Add Server dialog box, specify the IP Address, Mode and Server Name.

NOTE

l The IP Address is the IP address used by the T2000 server.

l The Mode has two options including Common and Security (SSL). When you choose the
Security (SSL) mode, the communication between the client and the server is encrypted.

l The communication mode of the client must be consistent with that of the server. Otherwise, the
client cannot log in to the server. To view the communication mode of the server, choose
System > Communication Mode Settings on the Main Menu of the System Monitor.

l You need not enter the Port number. After the Mode is specified, the system selects a Port
number automatically.

4. Click OK to complete adding a server.
5. Click OK to complete the server settings.

Step 4 Select a server and click Login to access the T2000.

----End

1.1.5 Exiting a T2000 Client
Before restarting the T2000 client or shutting down the T2000 server, you must exit the
T2000 client.

Prerequisite
The T2000 client must be started normally.

Procedure

Step 1 Choose File > Exit from the Main Menu.

Step 2 Click OK in the Confirm dialog box.

NOTE

If the layout of the view is changed and not saved, the Save Coordinates dialog box is displayed. Make a
selection and then exit the client automatically.

----End

1.1.6 Shutting Down the T2000 Server
When the T2000 server is managing the system normally, do not perform this operation. In
special circumstances, for example, when modifying the system time of the computer where the
T2000 resides, or when upgrading the version, you can use the System Monitor to shut down
the T2000 server.

Prerequisite
All the T2000 clients connected to the T2000 server must be shut down.

Background Information
When performing the operations related to the database (such as initializing the T2000
database, restoring T2000 databases and restoring T2000 MO data) or the operations related to
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the T2000 (such as the upgrade, installing patches and re-installing the T2000), you need to shut
down the T2000 server first. You are recommended to shut down the T2000 server in the way
of "shut down the T2000 server and the System Monitor".

Procedure
l Shut down the T2000 server only.

NOTE

In this case, the MDP process is not shut down and the database cannot be initialized.

1. In the System Monitor, choose System > Stop Server from the Main Menu.

2. Click OK in the confirmation dialog box. When all the processes are in the
Stopped status, the T2000 server is stopped normally.

l Shut down the T2000 server and the System Monitor.

NOTE

After all the T2000 processes are finished, you can initialize the database.

1. In the System Monitor, choose System > Shutdown System from the Main Menu.

----End

1.1.7 Shutting Down the Computer
Normally, do not shut down the computer. In special situations, for example, when the computer
becomes faulty, shut down the computer in the correct sequence. The shutdown procedures of
the workstation are different from those of a normal PC. Follow the correct procedure to perform
the operations as required.

Prerequisite
The T2000 server and client applications must be stopped.

Precaution

CAUTION
To avoid equipment damages or data loss, perform the following step one by one to shut down
the workstation.

Procedure
l On UNIX platform

1. Enter the following commands in the terminal window, the UNIX workstation shuts
down automatically:
% su root
Password: rootkit
# sync;sync;sync;sync;sync
# shutdown -y -g0 -i5
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NOTE

l rootkit is the default password of super user root. If the password is changed, enter the
new password.

l To restart the Sun workstation, the last command is # shutdown -y -g0 -i6.

2. Turn off the peripheral equipment.

l On Windows platform
1. Choose Start > Shut down from the Windows desktop.
2. Choose Shut down and click OK in the dialog box. The computer shuts down

automatically.
3. Turn off the monitor and the peripheral equipment.

----End

1.2 Entering the T2000 Common Views
In the common views of the T2000, you can manage the topology, equipment, protection subnet,
trail and clock.

1.2.1 Opening the Main Topology
On the Main Topology, you can manage topologies, protection subnets, and trails.

1.2.2 Opening the NE Explorer
The NE Explorer is the key interface for the T2000 to configure a single station. After opening
the NE Explorer, you can configure, manage and maintain each NE, board or port in a
hierarchical manner.

1.2.3 Opening the Clock View
After opening the Clock View, you can set an NE clock, query a network clock synchronization
status, or trace a clock.

1.2.1 Opening the Main Topology
On the Main Topology, you can manage topologies, protection subnets, and trails.

Prerequisite
You must be an NM user with "NE monitor" authority or higher.

Procedure
l To open the Main Topology, log in to the T2000 client.

l Choose Window > Main Topology from the Main Menu.

----End

1.2.2 Opening the NE Explorer
The NE Explorer is the key interface for the T2000 to configure a single station. After opening
the NE Explorer, you can configure, manage and maintain each NE, board or port in a
hierarchical manner.
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Prerequisite
You must be an NM user with "NE monitor" authority or higher.

Background Information
You can open a maximum of five NE Explorer windows at the same time.

Procedure
Right-click an NE on the Main Topology and choose NE Explorer from the shortcut menu.

----End

1.2.3 Opening the Clock View
After opening the Clock View, you can set an NE clock, query a network clock synchronization
status, or trace a clock.

Prerequisite
You must be an NM user with "NE monitor" authority or higher.

Procedure
Choose Configuration > Clock View from the Main Menu.

----End
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2 Creating the Network

About This Chapter

NEs and fibers or cables can be managed on the T2000 only after their topologies are created.

2.1 Creating NEs
Each equipment is represented as an NE on the T2000. Before the T2000 manages the actual
equipment, you need to create the corresponding NEs on the T2000. There are two ways of
creating NEs: creating a single NE and creating NEs in batches. When you need to create a large
number of NEs, for example, during deployment, it is recommended that you create NEs in
batches. When you need to create just a few NEs, it is recommended that you create the NEs
one by one.

2.2 Configuring the NE Data
Though an NE is successfully created, it is not configured. You need to configure the NE first
so that the T2000 can manage and operate the NE.

2.3 Checking Board Parameters
To learn about board parameter status, you can check board parameters. Before actual
configuration operations in networking, you need to check board parameters, to make sure that
the board parameter status meets the requirements of actual networking.

2.4 Creating Links
You can create fibers, Ethernet cables, serial port cables, extended ECC and virtual fibers by
using the T2000.

2.5 Creating a Topology Subnet
The subnet created here is based on a topological concept to facilitate management. In the case
of topology objects in the same network area or with similar attributes, you can allocate them
in one topology subnet.

2.6 Configuring the Protection Subnet
The OptiX OSN 500 supports various network level protection schemes, including the linear
MSP and ring MSP.

2.7 Configuring Clocks
A clock is the basis for the normal running of NEs. You must configure clocks for all NEs prior
to configuring services. In addition, you need to configure clock protection for complex
networks.
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2.8 Configuring Orderwire
You can configure orderwire for NEs by using the T2000.
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2.1 Creating NEs
Each equipment is represented as an NE on the T2000. Before the T2000 manages the actual
equipment, you need to create the corresponding NEs on the T2000. There are two ways of
creating NEs: creating a single NE and creating NEs in batches. When you need to create a large
number of NEs, for example, during deployment, it is recommended that you create NEs in
batches. When you need to create just a few NEs, it is recommended that you create the NEs
one by one.

2.1.1 Creating a Single NE
After the NE is created, you can use the T2000 to manage the NE. Although creating a single
NE is not as fast and exact as creating NEs in batches, you can use this method regardless of
whether the data is configured on the NE or not.

2.1.2 Creating NEs in Batches
When the T2000 communicates properly with the GNE, you can create NEs in batches by
searching for all NEs that communicate with the GNE, by using the IP address of the GNE or
the network segment to which the IP address is associated, or by using the NSAP address of the
NE. This method is quicker and more accurate than manual creation.

2.1.1 Creating a Single NE
After the NE is created, you can use the T2000 to manage the NE. Although creating a single
NE is not as fast and exact as creating NEs in batches, you can use this method regardless of
whether the data is configured on the NE or not.

Prerequisite
l You must be an NM user with "NM operator" authority or higher.

l The license must be installed and the license must support creating the NE of the type.

l The NE Explorer instance of the NEs must be created.

Context

First create a GNE, and then create a non-gateway NE.

For easy management, create optical NEs before creating NEs in batches. Otherwise, new NEs
are allocated to idle optical NEs automatically.

If the NE is not created properly or the communication between the NE and the T2000 is
abnormal, the NE is displayed in gray color.

Procedure

Step 1 Right-click in the blank space of the Main Topology and choose New  > Device from the shortcut
menu. The Add Object dialog box is displayed.

Step 2 Select the NE type from the Object Type tree.

Step 3 Complete the following information: ID, Extended ID, Name and Remarks.
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Step 4 To create a GNE, proceed to Step 5. To create a non-gateway NE, proceed to Step 6.

Step 5 Choose Gateway Type, Protocol and set the IP address and NSAP address or serial port no.
and serial port rate.
1. Select Gateway from the Gateway Type drop-down list.
2. Select the Protocol type.

If the T2000
communicates with
NEs through

Do...

IP protocol Select IP from the Protocol drop-down list. Enter the IP
Address and use the default value for the Port number of
the GNE.

OSI protocol Select OSI from the Protocol drop-down list. Enter the
NSAP Address of the GNE.

NOTE

The NSAP address is a hexadecimal number that contains a maximum of 20 bytes. Its format is:
domain address+08003e+NE ID+NSEL.
The domain address that contains a maximum of 13 bytes is entered by the user. NSEL is the port
number of the network-level protocol, with a fixed value of 1d (one byte).

Step 6 Select Non-Gateway from the Gateway Type drop-down list. Select the GNE to which the NE
is associated to from the Affiliated Gateway drop-down list.

Step 7 Enter the NE User and Password.

NOTE
The default NE user is root, and the default password is password.

Step 8 Optional:  If you do not want to apply the NE configuration data in the T2000 to the NE, check
the NE Preconfiguration check box, and set NE Software Version.

NOTE
If you apply the configuration data of the preconfigured NE to the actual NE when the configuration data
on the preconfigured NE is inconsistent with that on the actual NE, the actual services will be affected.

Step 9 Click OK. Click in the blank space of the Main Topology and the NE icon appears in the position
where you clicked.

----End
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Result
After an NE is successfully created, the system automatically saves the information, such as the
IP address, NSAP address, subnet mask, and NE ID to the T2000 database.

Postrequisite

After an NE is created, if you fail to log in to the NE, possible causes are listed as follows:

l The communication between the T2000 and the NE is abnormal. Check the settings of
communication parameters, such as the IP address of the NE and NE ID.

l The password for the NE user is incorrect. Enter the correct password for the NE user.

l The NE user is invalid or the NE user is already logged in. Change to use a valid NE user.

2.1.2 Creating NEs in Batches
When the T2000 communicates properly with the GNE, you can create NEs in batches by
searching for all NEs that communicate with the GNE, by using the IP address of the GNE or
the network segment to which the IP address is associated, or by using the NSAP address of the
NE. This method is quicker and more accurate than manual creation.

Prerequisite
l You must be an NM user with "NE administrator" authority or higher.

l The T2000 must communicate properly with the GNE.

l The NE Explorer instance of the NEs must be created.

Procedure

Step 1 Choose File > Search for NE from the Main Menu. The Search for NE window is displayed.

Step 2 Click Add and the Input Search Domain dialog box is displayed.

Step 3 Set Address type to IP Address Range of GNE, IP Address of GNE or NSAP Address, and
enter the information of the search address. Click OK.
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NOTE
You can repeat Steps 2 through 3 to add more search fields. You can delete the system default search field.

l If you use IP address to search for NEs, and the IP address of the T2000 computer and that of the GNE
are within the same network segment, you can select IP Address Range of GNE or IP Address of
GNE.

l If the IP addresses are not within the same network segment, select only IP Address of GNE.

l If you use NSAP address, you can only select NSAP address.

Step 4 Click Start. The NEs found are displayed after the search.

Step 5 When the search ends or if you click Stop, select the uncreated NEs in the Result list and click
Create. The Create dialog box is displayed.

Step 6 Enter the NE user name and password.
NOTE

l The default NE user is root.

l The default password is password.

Step 7 Click OK.

----End

Postrequisite
After an NE is created, if you fail to log in to the NE, possible causes are listed as follows:

l The password for the NE user is incorrect. Enter the correct password for the NE user.

l The NE user is invalid or the NE user is already logged in. Change to use a valid NE user.

2.2 Configuring the NE Data
Though an NE is successfully created, it is not configured. You need to configure the NE first
so that the T2000 can manage and operate the NE.

2.2.1 Configuring the NE Data Manually
By configuring NE data manually, you can configure the board slot information of an NE.

2.2.2 Replicating the NE Data
During the network planning, virtue NEs are used to simulate the entire network. In this situation,
you need to configure a lot of identical NE data. The function of duplicating the NE configuration
data can simplify your operation and improve the efficiency.

2.2.3 Uploading the NE Data
By uploading the NE data, you can synchronize the current NE configuration data to the network
management system directly.

2.2.1 Configuring the NE Data Manually
By configuring NE data manually, you can configure the board slot information of an NE.

Prerequisite
You must be an NM user with "NE operator" authority or higher.
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The NE must be created successfully.

Procedure

Step 1 Select the NE whose data you want to configure.

If the NE to be configured is the You need

SDH equipment Double-click the unconfigured NE on the
Main Topology. The NE Configuration
Wizard dialog box is displayed.

Step 2 Choose Manual Configuration and click Next. The Confirm dialog box is displayed indicating
that manual configuration clears the data on the NE side.

Step 3 Click OK. The Confirm dialog box is displayed indicating that manual configuration interrupts
the service on the NE.

Step 4 Click OK. The Set NE Attribute dialog box is displayed.

Step 5 Set NE Name, Equipment Type, NE Remarks and Subrack Type and then click Next. The
NE slot window is displayed.

Step 6 Optional: Click Query Logical Information to query the logical boards of the NE.

Step 7 Optional: Click Query Physical Information to query the physical boards of the NE.

NOTE
The Query Logical Information and Query Physical Information operations cannot be performed for
a preconfigured NE.

Step 8 Right-click on the slot to add a board. Click Next to display the Send Configuration window.
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Step 9 Choose Verify and Run as required and click Finish.

NOTE
Verification is to run the verification command. Click Finish to deliver the configuration to NEs and the
basic configuration of the NEs is complete. After the successful verification, the NEs start to work normally.

----End

2.2.2 Replicating the NE Data
During the network planning, virtue NEs are used to simulate the entire network. In this situation,
you need to configure a lot of identical NE data. The function of duplicating the NE configuration
data can simplify your operation and improve the efficiency.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

The NE must be created successfully.

The NE type and NE software version of the source NE must be consistent with those of the
copied NE.

Procedure

Step 1 Select the NE whose data you want to Replicate.

If the NE to be configured is the You need

SDH equipment Double-click the unconfigured NE on the
Main Topology. The NE Configuration
Wizard dialog box is displayed.

Step 2 Choose Copy NE Data and click Next. The NE Replication dialog box is displayed.

Step 3 Select the NE in the drop-down list and click Start. The Confirm dialog box is displayed
indicating that the replication operation copies all the data of the source NE.

NOTE

After the NE data is replicated, only the data on the T2000 side is changed, but the data on the equipment
side is not changed.
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Step 4 Click OK. The Confirm dialog box is displayed indicating that the replication operation results
in the loss of the original data of the NE to which the data is copied.

Step 5 Click OK to start the replication. Wait for a few seconds. The Operation Result dialog box is
displayed.

Step 6 Click Close.

----End

2.2.3 Uploading the NE Data
By uploading the NE data, you can synchronize the current NE configuration data to the network
management system directly.

Prerequisite

You must be an NM user with "NE operator" authority or higher.

The NE must be created successfully.

Procedure

Step 1 Select the NE whose data you want to Replicate.

If the NE to be configured is the You need

SDH equipment Double-click the unconfigured NE on the
Main Topology. The NE Configuration
Wizard dialog box is displayed.

Step 2 Choose Upload and click Next. The Confirm dialog box is displayed indicating that the upload
may take a long time.

Step 3 Click OK to start the upload. The Operation Result dialog box is displayed when the uploading
is completed.

Step 4 Click Close.

----End

2.3 Checking Board Parameters
To learn about board parameter status, you can check board parameters. Before actual
configuration operations in networking, you need to check board parameters, to make sure that
the board parameter status meets the requirements of actual networking.

Procedure

Step 1 Select the corresponding navigation path and check the related board parameters.

1. Check SDH board parameters. For the SDH board parameters, see Table 2-1.
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Table 2-1 SDH board parameters

Boar
d
Type

Paramet
er

Navigation
Path Application Scenario

SDH

MSP
sharing

a. In the NE
Explorer,
select a board.

b. Choose
Configuratio
n > SDH
Interface
from the
Function Tree.

c. Click By
Board/Port
(channel) and
select Port
from the drop-
down list.

When configuring MSP shared services on an
optical interface of a board, enable this
parameter.

Laser
Switch

When configuring services on an optical
interface of a board, enable this parameter.

Optical
(Electrical
)Interface
Loopback

l Non-loopback: It is a normal state. When
the equipment runs normally, set this
parameter to non-loopback.

l Inloop: The loop is performed toward the
local NE.

l Outloop: The loop is performed toward the
opposite NE. Inloop and outloop of an
optical interface affect services. They are
used to locate faults.

Hardware
REG
Enable

In the REG working mode, the board
processes only the framer header and
regenerator section overheads. In the case of
the non-REG service configuration, set this
parameter to Disabled.

2. Check PDH board parameters. For the PDH board parameters, see Table 2-2.

Table 2-2 PDH board parameters

Boar
d
Type

Paramet
er

Navigation
Path Application Scenario

PDH

Tributary
Loopback

a. In the NE
Explorer,
select a board.

b. Choose
Configuratio
n > PDH
Interface
from the
Function Tree.

c. Click By
Board/Port
(channel) and
select Port
from the drop-
down list.

l Non-loopback: It is a normal state. When
the equipment runs normally, set this
parameter to non-loopback.

l Inloop: When input service signals reach
the tributary board of the target NE, the
signals revert to the original trail. This
function is used to locate faults of each
service path.

l Outloop: When input service signals reach
the tributary board through the input port of
the local NE, the signals are looped back
directly to the service output end.
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Boar
d
Type

Paramet
er

Navigation
Path Application Scenario

Service
Load
Indication

l Non-loaded: The service path does not
process the services that are carried, to
suppress alarms in non-loaded service
paths.

l Load: The service path processes the
services that are carried. In the case of a
tributary board that has services, set this
parameter to Load.

3. Check RTN board parameters. For the RTN board parameters, see Table 2-3.

Table 2-3 RTN board parameters

Boar
d
Type

Paramet
er

Navigation
Path Application Scenario

RTN

Radio
Work
Mode

a. In the NE
Explorer,
select a board.

b. Choose
Configuratio
n > IF
Interface
from the
Function Tree.

c. Click By
Board/Port
(channel) and
select Port
from the drop-
down list.

Specifies the microwave working mode. Its
formats are service capacity, working
bandwidth and modulation mode.
The transmit end and the receive end must
have the same settings of the microwave
working mode.

Radio
Link ID

Radio Link ID: 1 to 4094

IF Port
Loopback

Sets the loopback status of an intermediate
frequency interface on the equipment.
Non-Loopback  refers to the normal status. It
is not required to set loopback during normal
equipment operation.
Outloop means that the input signal passes
through the ingress port and reaches the
intermediate frequency board at the local NE
and then is directly loopbacked to the service
egress end.
Inloop means that the input signal returns
from the intermediate frequency board of the
destination NE along the original trail.
This function is usually used to locate faults
for various IF interfaces. Performing loopback
on an intermediate frequency interface is a
diagnosis function which may affect services
of related ports. Exercise caution before
performing this function.
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Boar
d
Type

Paramet
er

Navigation
Path Application Scenario

2M
Wayside
Enable
Status

Enables or disables a 2 Mbit/s bypath service.
This parameter is available only when you set
Radio Work Mode to STM-1,28MHz,
128QAM.

ATPC
Enable
Status

When the ATPC is enabled, according to the
current receive power of the ODU and the set
ATPC thresholds, the ATPC module inserts
the ATPC overhead. According to the ATPC
overhead, the opposite ODU adjusts the
transmit power.
When the ATPC is disabled, the ATPC
module does not insert any ATPC overhead.

4. Check data board parameters. For the data board parameters, see Table 2-4.

Table 2-4 Data board parameters

Boar
d
Type

Parame
ter Navigation Path Application Scenario

Ethern
et

Enabled/
Disabled

a. In the NE Explorer,
select a board.

b. Choose
Configuration >
Ethernet Interface
Management >
Ethernet Interface
from the Function
Tree.

c. Click External
Port.

d. Click the Basic
Attributes tab.

When configuring Ethernet board port
services, set the port to Enabled.

Working
Mode

Set the working mode of Ethernet ports
according to networking configuration
requirements.

Maximu
m Frame
Length

When a packet exceeds the maximum
frame length that is set, the packet is
discarded. Alternatively, the packet
length is minimized to satisfy the
specified frame length. By default, the
value is set to 1522, unless otherwise
specified.

MAC
Loopbac
k

l Non-loopback: It is a normal state.
When the equipment runs normally,
set this parameter to non-loopback.

l Inloop: Inside the equipment, services
from the cross-connect side are
looped back to the cross-connect side.
This operation affects services
configured on ports and is used to
locate faults.
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Boar
d
Type

Parame
ter Navigation Path Application Scenario

PHY
Loopbac
k

l Non-loopback: It is a normal state.
When the equipment runs normally,
set this parameter to non-loopback.

l Inloop: Inside the equipment, services
from the cross-connect side are
looped back to the cross-connect side.
This operation affects services
configured on ports and is used to
locate faults.

TAG
a. In the NE Explorer,

select a board.
b. Choose

Configuration >
Ethernet Interface
Management >
Ethernet Interface
from the Function
Tree.

c. Click External
Port.

d. Click the TAG
Attributes tab.

l Tag Aware: If the client-side
equipment sends tag packets, set the
TAG attribute of external ports to Tag
Aware.

l Access: If the client-side equipment
sends untag packets, set the TAG
attribute of external ports to Access.

l Hybrid: If the client-side equipment
sends tag and untag packets, set the
TAG attribute of external ports to
Hybrid.

Entry
Detectio
n

This parameter is used to identify tags in
data packets. During the configuration of
VLAN services, set this parameter to
Enabled.

ATM

Port
Type

a. In the NE Explorer,
select a board.

b. Choose
Configuration >
ATM Interface
Management >
ATM Interface
Management  from
the Function Tree.

c. Click External
Port.

l UNI: The maximum number of VPI
bits is 8. The UNI is used on edge
nodes between the user network and
ATM network.

l NNI: The maximum number of VPI
bits is 12. The NNI is used between
ATM networks.

UPC/
NPC
Enabled/
Disabled

l Enabled: When the traffic parameter
is valid and strict control of traffic is
required, set this parameter to
Enabled.

l Disabled: When the traffic parameter
is invalid (excepting the PCR of CBR
services) and service burst and
grooming are permitted, set this
parameter to Disabled.

Loopbac
k

Inloop is used to locate faults. During
normal service configuration, set this
parameter to No Loopback.
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Boar
d
Type

Parame
ter Navigation Path Application Scenario

Laser
Switch

This parameter is used to set the on/off
status of a laser. During normal service
configuration, set this parameter to
Open.

Step 2 Modify board parameters according to service planning and actual board configurations. For
details, see 6.2.3 Modifying Board Configuration Parameters.

----End

2.4 Creating Links
You can create fibers, Ethernet cables, serial port cables, extended ECC and virtual fibers by
using the T2000.

2.4.1 Creating Fibers Automatically
By using the fiber search feature, you can check whether the specified optical interface is
connected to a fiber. You can quickly create a fiber for this optical interface by using the T2000.
For a newly created network, after configuring boards on the T2000, you can search for all optical
interfaces to create fibers for the entire network. In this way, you can monitor the actual working
status of fibers.

2.4.2 Creating Fibers Manually
Before you configure services, you need to create the required fibers. You can create a small
number of fibers manually one after another.

2.4.3 Creating Virtual Fibers
When the T2000 manages the SDH, PTN and WDM equipment at the same time, you can create
virtual fibers for SDH or PTN equipment with WDM equipment in between, to facilitate
administration.

2.4.4 Creating DCN Communication Cable
The T2000 can communicate with NEs through the Ethernet port or serial port. The NEs also
communicate with each other through the extended ECC. Depending on the communication
mode, different types of cables can be created on the T2000.

2.4.1 Creating Fibers Automatically
By using the fiber search feature, you can check whether the specified optical interface is
connected to a fiber. You can quickly create a fiber for this optical interface by using the T2000.
For a newly created network, after configuring boards on the T2000, you can search for all optical
interfaces to create fibers for the entire network. In this way, you can monitor the actual working
status of fibers.

Prerequisite
l You must be an NM user with "NE maintainer" authority or higher.

l The optical interfaces of every NE must be connected using fibers.
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l The boards of every NE must be created on the T2000.

Context
l If conflicting fibers are found during the creation, delete the conflicting fibers on the T2000

before you start creating fibers.
l When a fiber between two SDH NEs passes through a WDM NE, if the normal fiber

between an SDH NE and a WDM NE has been created on the T2000, the fiber found by
the trail search function is created as a virtual fiber. If the WDM NE is not created on the
T2000, the fiber is created as a normal fiber.

l When a fiber is created, it is usually bidirectional. But when the fiber is connected to the
ports of the REG functions or the SDH and WDM equipment, the fiber is unidirectional.

Procedure

Step 1 Choose  File  > Search for Fiber/Cable  from the Main Menu.

Step 2 In the left pane select some ports from one or more NEs and click Search to search for the fibers
or cables. A progress bar is displayed showing the progress of the search.

NOTE

l If you check the Do not search for ports of created fibers on T2000 check box, the system only
searches for the ports that do not have fibers.

l To check if the created fiber is consistent with the actual fiber connection, leave the check box
unchecked.

l If you check the Do not search for ports of created fibers on T2000 check box, and if all the selected
ports have fibers created, the system displays a message indicating that the search field is null.

Step 3 A prompt appears telling you that the operation was successful. Click Close.

Step 4 To create fibers, select one or more fibers from the Newly Searched Fiber list and click Create
Fiber/Cable.

NOTE

l When one or more fibers are selected in the Newly Searched Fiber list, fibers that conflict with the
selected fibers, are shown in the Existing Conflicting Fiber list. If there is any conflicting fiber,
proceed to Step 5 and delete it before creating fibers.

l During fiber creation, if all the selected fibers are in an Already created state, the system displays the
message – No fiber to create.

Step 5 To delete the conflicting fibers, from the Existing Conflicting Fiber list select one or more
fibers whose values are Yes for the Existing Conflicting link (Y/N) parameter in the
Misconnected Fiber list. Click Delete Fiber/Cable.

----End

2.4.2 Creating Fibers Manually
Before you configure services, you need to create the required fibers. You can create a small
number of fibers manually one after another.

Prerequisite
l You must be an NM user with "NE maintainer" authority or higher.
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l The required boards must be created on each NE.

Context
Generally, the fiber that is created are bidirectional. If the fiber is connected to a port that has
the REG function, SDH equipment, or WDM equipment, however, the fiber is unidirectional.

Procedure

Step 1 Right-click in the Main Topology and choose  New > Link from the shortcut menu. Then, the
Add Object dialog box is displayed.

Step 2 Choose Link > Fiber/Cable from the left pane.

Step 3 Click the button in Source NE. Select the source board and source port in the Select the source
end of the link dialog box that is displayed.

Step 4 Click OK. Then, the cursor changes to a + sign.

Step 5 Click the sink NE of the fiber in the Main Topology.

Step 6 Click the button in Sink NE. Select the sink board and sink port in the Select the sink end of
the link dialog box that is displayed.

TIP
If an incorrect sink NE is selected, right-click and click OK in the Object Selection dialog box that is
displayed to exit.

Step 7 Click OK. Set the corresponding attributes of the fiber in the Add Object dialog box that is
displayed.

Step 8 Click OK.
Then, the created fiber is displayed between the source NE and the sink NE in the Main Topology.

Step 9 Right-click the created fiber and choose Detect Link from the shortcut menu.
The Operation Result dialog box is displayed, indicating the information on the fiber
connections.

----End

2.4.3 Creating Virtual Fibers
When the T2000 manages the SDH, PTN and WDM equipment at the same time, you can create
virtual fibers for SDH or PTN equipment with WDM equipment in between, to facilitate
administration.

Prerequisite
l You must be an NM user with "NE maintainer" authority or higher.

l You must create fiber connections according to the true fibers that connect the SDH and
WDM equipment.

Context
l For SDH equipment, the virtual fibers ensure the independence of automatic fiber search

and SDH trail management. .
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l For WDM equipment, when true fibers change into virtual fibers at the bearer layer,
wavelength management is not affected even if the true fibers are deleted

l The source and sink ports of the virtual fibers must be the SDH ports. On the source and
sink ports, there must be two physical fibers that are connected to the WDM equipment.

l The virtual fiber does not support the expansion function.

Procedure

Step 1 Right-click in the blank space of the Main Topology, and choose New > Link  from the shortcut
menu.

Step 2 In the Add Object dialog box, choose  Link > Virtual Fiber/Cable .

Step 3 Set the attributes of the fiber or cable in the right-hand list.

Step 4 Click OK.

----End

2.4.4 Creating DCN Communication Cable
The T2000 can communicate with NEs through the Ethernet port or serial port. The NEs also
communicate with each other through the extended ECC. Depending on the communication
mode, different types of cables can be created on the T2000.

Prerequisite
You must be an NM user with "NM operator" authority or higher.

Procedure

Step 1 Right-click in the blank space of the Main Topology and choose New > Link  from the shortcut
menu.

Step 2 Select a cable type from the expanded items.

Step 3 Enter the cable attributes in the right-hand pane.

Step 4 Click OK. The cable is displayed on the Main Topology between the T2000 and the GNE.

----End

2.5 Creating a Topology Subnet
The subnet created here is based on a topological concept to facilitate management. In the case
of topology objects in the same network area or with similar attributes, you can allocate them
in one topology subnet.

Prerequisite
You must be an NM user with "NM operator" authority or higher.

Context
A topology subnet is created only to simplify the user interface and has no impact on the NEs.
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Procedure

Step 1 Right-click in the blank space of the Main Topology and choose New > Subnet  from the shortcut
menu.

Step 2 Click the Properties tab in the Add Object dialog box. Enter the attributes of the subnet.

Step 3 Click the Select Objects tab. Select the created NEs or subnet from the Available Objects pane.
Click . 

NOTE

In the case of a similar dialog box for selecting objects,

l  indicates that to select the objects to be selected on the left to the selected objects on the right.

l  indicates that to select all the objects to be selected on the left to the selected objects on the right.

Step 4 Click OK. Click in the blank space of the Main Topology, the  icon appears in the position
where you clicked.

----End

2.6 Configuring the Protection Subnet
The OptiX OSN 500 supports various network level protection schemes, including the linear
MSP and ring MSP.

2.6.1 Configuring a Non-Protection Chain
If a service in the chain does not need to be protected, you can configure a non-protection chain.
In this case, all the timeslots in the chain can be used to transmit the service.

2.6.2 Configuring a Non-Protection Ring
When services on a ring need not be protected, you can configure a non-protection (NP) ring.
All timeslots on the ring can be used to transmit services.

2.6.3 Creating an MS Ring Protection Subnet
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Generally, the MS ring protection is configured on the public ring network whose protection
paths are used to transmit extra services. By running the APS protocol, it achieves the MS level
protection.

2.6.4 Creating a Linear MS Protection Subnet
In a chain network, an NE can protect the services in different fiber sections after a linear MS
protection subnet is created.

2.6.1 Configuring a Non-Protection Chain
If a service in the chain does not need to be protected, you can configure a non-protection chain.
In this case, all the timeslots in the chain can be used to transmit the service.

Prerequisite
l You must be an NM user with "network maintainer" authority or higher.

l On the NM, the data of each NE must be configured, and fibers must be created correctly.

Procedure

Step 1 Choose Protection Subnet > Create SDH Protection Subnet > NP Chain from the Main Menu
to display the Create SDH Protection Subnet dialog box.

Step 2 Enter the name of the protection subnet.
Generally, enter the default name, for example, non-protection chain_1.

Step 3 Select the capacity level of the protection subnet,
for example, STM-4.

Step 4 Select Resource Sharing and Assigned by VC4 as needed.

NOTE

l Resource Sharing indicates that a port is mapped into multiple protection subnets. When multiple
protection subnets occupy a port of a board, Resource Sharing must be selected. When different
protection subnets occupy different ports of a board, Resource Sharing is not required.

l Assigned by VC4 indicates that different VC4s belong to different protection subnets to achieve virtual
optical path protection. For example, in the case of an STM-16 fiber, the first through fourth VC4s
belong to an STM-4 MS shared protection, while the fifth through eighth VC4s belong to a non-
protection ring. If you enable multiple MSPs for a single optical port, you can configure multiple MSP
rings by VC4 for the optical port.

Step 5 Select a node to create a non-protection chain. Double-click an NE in the Main Topology and
add it to the left node list. At the same time,  is displayed on the NE icon. Double-click the
NE icon again to cancel the selection.

Step 6 Click Next to display the Select Link dialog box. Set parameters, such as Physical Link
Information.
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Step 7 Click Finish to deliver the configuration data. Then the Operation Result prompt box is
displayed. Click Close.

----End

2.6.2 Configuring a Non-Protection Ring
When services on a ring need not be protected, you can configure a non-protection (NP) ring.
All timeslots on the ring can be used to transmit services.

Prerequisite
l You must be an NM user with "NE maintainer" authority or higher.

l The NE data must be configured, and fibers must be created properly.

Procedure

Step 1 Choose Protection Subnet  > Create SDH Protection Subnet > NP Ring from the Main Menu.
Then, the Create Protection Subnet dialog box is displayed.

Step 2 Enter the name of the protection subnet.
Generally, the default name is used, for example, NP_Ring_1.

Step 3 Select the capacity level of the protection subnet,
for example, STM-4.

Step 4 Select Resource Sharing and Assigned by VC4 according to the requirement.

Step 5 Select the nodes that belong to the protection subnet that needs to be created. Double-click the
selected NE in the Main Topology to add the NE to the NE list on the left. In addition,  is
displayed on the NE icon. If you need to cancel the selection, double-click the NE again.

Step 6 Click Next to enter the Select link window. Set the parameters such as Physical Link
Information in the window.

Step 7 Click Finish to deliver the configuration data. Then, the Operation Result dialog box is
displayed. Click Close.

----End

2.6.3 Creating an MS Ring Protection Subnet
Generally, the MS ring protection is configured on the public ring network whose protection
paths are used to transmit extra services. By running the APS protocol, it achieves the MS level
protection.

Prerequisite
l You must be an NM user with "network maintainer" authority or higher.

l The NE data must be configured and fibers must be created properly.

Context
l The number of nodes in an MSP ring should not exceed 16.
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l When creating a protection subnet, select SDH NEs only. Do not select REG or WDM NEs.

CAUTION
Starting the protocol controller may interrupt the services.

Procedure

Step 1 Choose Protection Subnet  > Create SDH Protection Subnet > 2f_MS_SPRing  from the
Main Menu. Click OK in the dialog box that is displayed. Click OK. Then, the Create
Protection Subnet window is displayed.

Step 2 Enter the name of the protection subnet.
Generally, the default name is used, for example, 2f_MS_SPRing_1.

Step 3 Select the capacity level of the protection subnet, for example, STM-4.

Step 4 Choose Resource Sharing and Assigned by VC4 according to the requirement.

NOTE

l Resource Sharing indicates that a port is mapped into multiple protection subnets. When multiple
protection subnets occupy the same port of a board, Resource Sharing must be selected. When different
protection subnets occupy different ports of a board, Resource Sharing is not required. If multiple
protection subnets use one port of a board, you need to select the Resource Sharing check box. If
MSP Sharing is enabled, you can select the Resource Sharing check box to map a port of the board
to multiple MSP subnets.

l Assigned by VC4 indicates that different VC-4s belong to different protection subnets, thus achieving
virtual optical path protection. For example, in the case of an STM-4 fiber, the first and second VC-4s
are allocated for the STM-4 MS shared protection, and the third and fourth VC-4s are allocated for the
non-protection.

Step 5 Select the nodes that belong to the protection subnet that needs to be created. Double-click the
selected NE in the Main Topology to add the NE to the NE list on the left. In addition,  is
displayed on the NE icon. If you need to cancel the selection, double-click the NE again.
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NOTE

To facilitate maintenance, it is recommended that you add the nodes anticlockwise to the protection subnet.

Step 6 Set the attribute of each node to MSP Node.

Step 7 Click Next to enter the Select link window. Set the parameters such as Physical Link
Information in the window.

NOTE

l If there are multiple fibers between two NEs, select the required links from the Physical Link
Information drop-down list.

l If Assigned by VC4 is selected, you can Select the working and protection VC-4 timeslots according
to the requirement.

Step 8 Click Finish to deliver the configuration data. Then, the Operation Result dialog box is
displayed. Click Close.

Step 9 Right-click the protection subnet and choose Protection Subnet Attributes  from the shortcut
menu.

Step 10 Click the Protection Subnet Maintenance tab to check whether the protocol controller is
started. If the protocol controller is not started, select all the NEs of the protection subnet. Right-
click and choose  Start/Stop Protocol > Start  from the shortcut menu. Click Yes in the dialog
box that is displayed twice. Ensure that the status of all the values in the Protocol Controller
column is Protocol Started.

Step 11 Click the Protection Subnet Parameters tab. Set WTR time and SD Condition according to
the requirement. Click Apply to deliver the configuration data. The WTR time of all NEs in
the same protection subnet should be the same.

NOTE

The default value is 600s.

----End
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2.6.4 Creating a Linear MS Protection Subnet
In a chain network, an NE can protect the services in different fiber sections after a linear MS
protection subnet is created.

Prerequisite
l You must be an NM user with "network maintainer" authority or higher.

l The NE data must be configured and fibers must be created properly.

Context
Fibers that are used for the linear MSP cannot be used by other protection subnets. That is, a
linear MS protection subnet and other subnets cannot be used together to form virtual fibers.

CAUTION
Starting the protocol controller may interrupt the services.

Procedure

Step 1 Choose Protection Subnet  > Create SDH Protection Subnet > 1+1 linear MSP from the
Main Menu. Then, the Create Protection Subnet window is displayed.

NOTE

To create the M:N linear MS protection, choose  Protection Subnet > Create SDH Protection Subnet >
M:N Linear MSP from the Main Menu. Then, the corresponding window is displayed.

Step 2 Enter the name of the protection subnet.
Generally, the default name is used, for example, 1+1_MSP_1.

Step 3 Select the capacity level of the protection subnet, for example, STM-4.
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Step 4 Set Revertive Mode and Switching Mode according to the protection type and related
requirements.

NOTE

When setting the parameters, note the following points:

l In the case of the M:N linear MS protection scheme, set the number of working links to N. M indicates
the number of protection links and cannot be set manually. Currently, the value of M can be 1 only.

l Revertive Mode indicates the handling strategy that is used after the faulty line is recovered. Non-
Revertive: The service is not automatically reverted to the working channel after the faulty line is
recovered. Revertive: The service is automatically reverted to the working channel after the faulty line
is recovered.

l Switching Mode indicates the switching strategy that is used after a fault occurs in the line. Single-
ended switching: To protect services, a switching occurs at the receive end when the receive end is
faulty and a switching occurs at the transmit end when the transmit end is faulty. Dual-ended
switching: To protect services, a switching occurs at the receive and transmit ends when the receive
end or transmit end is faulty.

l Resource Sharing indicates that a port is mapped into multiple protection subnets. When multiple
protection subnets occupy the same port of a board, Resource Sharing must be selected. When different
protection subnets occupy different ports of a board, Resource Sharing is not required.

l Assigned by VC4 indicates that different VC-4s belong to different protection subnets to achieve
virtual optical path protection.

Step 5 Select the nodes that belong to the protection subnet that needs to be created. Double-click the
selected NE in the Main Topology to add the NE to the NE list on the left. In addition,  is
displayed on the NE icon. If you need to cancel the selection, double-click the NE again.

Step 6 Click Next to display the Select Link dialog box. Set Physical Link Information of Working
Link and Protection Link.

Step 7 Click Finish to deliver the configuration data. Then, the Operation Result dialog box is
displayed. Click Close.

Step 8 Right-click the protection subnet and choose  Protection Subnet Attributes from the shortcut
menu.

Step 9 Click the Protection Subnet Maintenance tab to check whether the protocol controller is
started.

NOTE

If the protocol controller is not started, select all the NEs of the protection subnet. Right-click and
choose  Start/Stop Protocol > Start  from the shortcut menu. Click Yes in the dialog box that is displayed
twice. Ensure that the status of all the values in the Protocol Controller column is Protocol Started.

Step 10 Click the Protection Subnet Parameters tab. Set WTR time and SD Condition according to
the requirement. Click Apply to deliver the configuration data.
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NOTE

The WTR time of all NEs in the same protection subnet should be the same.

----End

2.7 Configuring Clocks
A clock is the basis for the normal running of NEs. You must configure clocks for all NEs prior
to configuring services. In addition, you need to configure clock protection for complex
networks.

2.7.1 Configuring the NE Clock Source
Before configuring services, you must configure the NE clock source and specify the priority
level to ensure that correct clock trace relations are created for all the NEs in the network.

2.7.2 Configuring the Clock Source Protection
In a complicated clock network, you need to configure the clock protection for all NEs. After
you set the clock source and specify the clock priority level for the NEs, you can enable the
standard SSM or extended SSM protocol to prevent the NEs from tracing an incorrect clock
source. This is how the clocks are protected.

2.7.1 Configuring the NE Clock Source
Before configuring services, you must configure the NE clock source and specify the priority
level to ensure that correct clock trace relations are created for all the NEs in the network.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Context

To implement clock protection, you must configure at least two traceable clock sources for the
equipment. Usually, the tributary clock is not used as the clock source for the equipment.

After you set the clock sources for all the NEs, query the networkwide clock trace status
again. For details, see 7.18 Viewing the Clock Trace Search.

Procedure

Step 1 In the NE Explorer, select an NE and choose  Configuration > Clock  > Clock Source
Priority from the Function Tree.
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Step 2 Click Query to query the existing clock source.

Step 3 Click Create. In the Add Clock Source dialog box, select a new clock source and click OK.

Step 4 Set Lowest Traceable Clock Quality of the clock source.

Step 5 Optional: If an external clock source is selected, select External Clock Source Mode according
to the type of external clock signals. For 2 Mbit/s clocks, specify the Synchronous Status
Byte to deliver SSM message.

Step 6 Select a clock source, and click  or  to adjust its priority level. The clock
sources are arranged in the descending order. The clock source on top is the preferred one for
the NE.

NOTE

Internal clock sources have the lowest priority because of their low precision.

Step 7 Click Apply. In the Operation Result dialog box, click Close.

NOTE

If the clock trace relation changes because of the clock source change, the Prompt dialog box is displayed,
asking you whether to refresh the clock trace relation. Usually you can click OK. If you select Disable
Prompting Next Time, the Prompt dialog box is not displayed even when the clock trace relation changes.

----End

2.7.2 Configuring the Clock Source Protection
In a complicated clock network, you need to configure the clock protection for all NEs. After
you set the clock source and specify the clock priority level for the NEs, you can enable the
standard SSM or extended SSM protocol to prevent the NEs from tracing an incorrect clock
source. This is how the clocks are protected.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select an NE and choose  Configuration > Clock  > Clock Subnet
Configuration from the Function Tree.

Step 2 Click the Clock Subnet tab. Click Query to query the existing parameter settings.
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Step 3 Select Start Standard SSM Protocol or Start Extended SSM Protocol.

NOTE

The same SSM protection protocol must be used within the same clock protection subnet.

Step 4 Set the subnet number of the clock subnet to which the NE is associated.

NOTE

Allocate the same subnet number to NEs tracing the same clock source.

Step 5 Optional: If the extended SSM protocol starts, set the clock ID of the clock source.

Step 6 Click Apply. In the Operation Result dialog box, click Close.

Step 7 Optional: If the clock ID is specified for the line clock of an NE, click the Clock ID Status tab,
and set the Enabled Status to Enabled. Click Apply. In the Operation Result dialog box, click
Close.

----End

2.8 Configuring Orderwire
You can configure orderwire for NEs by using the T2000.

2.8.1 Configuring the Orderwire
The orderwire provides a dedicated communication channel that the network maintenance
personnel can use in the case of emergencies. You can configure the orderwire after configuring
the NEs and boards on the T2000.

2.8.2 Configuring the Conference Calls
The conference calls ensure one or more dedicated communication channels that the network
maintenance personnel can use in the case of emergencies.

2.8.1 Configuring the Orderwire
The orderwire provides a dedicated communication channel that the network maintenance
personnel can use in the case of emergencies. You can configure the orderwire after configuring
the NEs and boards on the T2000.

Prerequisite

You must be an NM user with "network operator" authority or higher.
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Procedure

Step 1 In the NE Explorer, click the NE, and then choose  Configuration > Orderwire from the
Function Tree. Click the General tab.

Step 2 Click Query to query the related NE-side information.

Step 3 Set Call Waiting Time(s), Telephone No. and the orderwire ports.

NOTE

l Call Waiting Time should be set to the same value for all NEs that are involved in the orderwire
communication. When the number of NEs is less than 30, set Call Waiting Time to 5s. Otherwise, set
Call Waiting Time to 9s.

l The orderwire phone numbers must be unique to each other in the same orderwire subnet.

l Set the length of the telephone number according to the actual requirements. The maximum length is
eight digits and the minimum length is three digits. In the same orderwire subnet, the number lengths
of the orderwire phone numbers must be the same.

l The length of the telephone number must be the same as the length of the conference call number.

l If the length of the subnet number is 1, the first digits of the two orderwire numbers must be the same.
If the length of the subnet number is 2, the first two digits of the two orderwire numbers must be the
same.

Step 4 Click Apply. A dialog box is displayed, indicating that the operation is successful.

Step 5 Click Close.

----End

2.8.2 Configuring the Conference Calls
The conference calls ensure one or more dedicated communication channels that the network
maintenance personnel can use in the case of emergencies.

Prerequisite
You must be an NM user with "network operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select the NE, and then choose  Configuration > Orderwire  from the
Function Tree. Click the Conference Call tab.

Step 2 Click Query to query the conference call configuration of the NE.

Step 3 In the Available Conference Call Port pane, select the port where you need to configure a
conference call, and click .

NOTE

If the optical interfaces that support conference calls form a loop, howler tone is generated. Hence,
"releasing loop" is required, that is, only one optical port can be set for the conference calls on a certain
node.

Step 4 Click Apply. A dialog box is displayed, indicating that the operation is successful.

Step 5 Click Close.

Step 6 Click the General tab. Set the Conference Call number.
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NOTE

The conference call numbers for all the NEs must be the same, and must have the same length as the
corresponding orderwire phone numbers. If the orderwire phone number has four digits, it is recommended
that you set the conference call number to 9999.

Step 7 Click Apply.

----End

Example
You can follow the sample configuration to prevent a conference call loop.

Two-fiber bidirectional
MSP ring

8-SL4D-1

8-SL4D-2

Two-fiber
bidirectional

8-SL4D-1

8-SL4D-1

8-SL4D-2

8-SL4D-2 8-SL4D-1

8-SL4D-2

3-SL1D-13-SL1D-1

NM ID
NM name
IP address

T2000
NM

9-5
NE5

1005/9999

9-1
NE1

1001/9999

9-2
NE2

1002/9999

9-3
NE3

1003/9999

9-4
NE4

1004/9999

NE ID

 Telephone No./
Conference Call No.

NE name

192.9.0.54

As shown in the preceding figure, if conference calls are configured for all optical interfaces,
howler tone is generated. You can configure a conference call for the optical interface NE3-8-
SL4D-2 only, instead of the optical interface NE3-8-SL4D-1.
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3 Configuring SDH Services

About This Chapter

This topic uses an example to describe how to configure SDH services on the T2000.

3.1 Basic Concepts
The following basic concepts help you understand and configure the relevant SDH services
correctly.

3.2 Configuring Services on the Non-Protection Chain
Configure the protection subnet and the services on the non-protection chain separately. It is
recommended that you configure the protection subnet before configuring the services on the
non-protection chain.

3.3 Configuring Services on the Non-Protection Ring
Configure the protection subnet and the services on the non-protection ring separately. It is
recommended that you configure the protection subnet before configuring services on the non-
protection ring.

3.4 Configuring 1+1 Linear MSP Services
In the case of the 1+1 linear multiplex section protection (MSP), services are transmitted on the
working path and protection path at the same time. The sink NE selects the services from the
working path in normal cases, and selects services from the protection path when the working
path becomes faulty.

3.5 Configuring 1:1 Linear MSP Services
In the case of the 1:1 linear MSP, services are transmitted on the working path and the sink NE
receives the services from the working path in normal cases. When the working path becomes
faulty, the services are switched to the protection path for transmission and the sink NE receives
the services from the protection path.

3.6 Configuring Two-Fiber Unidirectional MSP Services
The two-fiber unidirectional MSP services can provide network level protection for the services
on NEs on the MSP ring. On the T2000, you can add all the NEs on the MSP ring into the
protection subnet to create a two-fiber unidirectional MSP ring.

3.7 Configuring the Two-Fiber Bidirectional MSP Services
To configure the two-fiber bidirectional MSP services, you need to create the MSP subnet
protection and MSP services separately. There is no requirement for the configuration sequence.
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3.8 Configuring Services on the SNCP Ring
Compared with the services on an MSP ring, the services on an SNCP ring have dedicated
physical paths as the protection paths. In addition, the services on an SNCP ring are dually fed
and selectively received. When you configure services on an SNCP ring, you need not configure
the protection subnet and the services separately. When you configure services on an SNCP ring,
however, you need to configure the working services and protection services separately.

3.9 Configuring Services on the SNCP Ring with a Non-Protection Chain
To configure the services on the SNCP ring, you can directly configure the working service and
protection service, without first configuring the protection subnet. To configure the services on
the non-protection chain, you can configure the services only after the protection subnet is
created.

3.10 Configuring Service on the MSP Ring with a Non-Protection Chain
Configure the protection subnet for the MSP, Protection Subnet for the non-protection chain,
and services on the MSP ring with a non-protection chain separately. It is recommended that
you configure the protection subnets before configuring the services on the MSP ring with a
non-protection ring chain.
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3.1 Basic Concepts
The following basic concepts help you understand and configure the relevant SDH services
correctly.

Unidirectional Service
The unidirectional service indicates the service that is received and transmitted on different
paths. A unidirectional service created between NE A and NE B can only be transmitted from
NE A (source) to NE B (sink) or only be transmitted from NE B (sink) to NE A (source).

Bidirectional Service
The bidirectional service indicates the service that is received and transmitted on the same path.
A bidirectional service created between NE A and NE B can be transmitted and received from
NE A to NE B or from NE B to NE A.

MSP
The multiplex section protection (MSP) provides a function that switches the signals from the
working section to the protection section.

Shared MSP Ring
As an SDH ring structure, the shared MSP protection ring provides the working and protection
paths for each node in the ring network. When the service in the working path is abnormal or
interrupted, the service is automatically switched to the protection path for further transmission.
In this case, the service loss can be avoided.

Two-Fiber Shared MSP Ring
To form a two-fiber shared MSP ring, you need to use two fibers. In each fiber, one half of
channels are used as working timeslots, and the other half of channels are used as protection
timeslots. For example, in the case of an STM-4 service, VC-4s numbered 1 to 2 are used as
working timeslots and VC-4s numbered 3 to 4 are used as protection timeslots. When VC-4s
numbered 1 to 2 is abnormal or faulty, the service is switched to the corresponding protection
timeslots 3 to 4 for further transmission.

SNCP Principle
The sub-network connection protection (SNCP) is defined by the ITU-T Recommendations.
With 1+1 single-ended switching function, the SNCP is used for protecting services that travel
across different subnets. The SNCP is characterized by the dual-fed and selective-receiving
mode.

Principles for Generating SNCP Services
The SNCP is characterized by the dual-fed and selective receiving mode. Thus, to configure the
SNCP service, you should configure the dual-fed service and the selective receiving service. On
the T2000, the service can be automatically created. When the selective receiving service is
configured on the T2000, the dual-fed service of the NE can be automatically created. Thus, you
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only need to configure the selective receiving service in actual service configuration. That is, if
the SNCP service pair is configured, the service configuration of the SNCP is complete.

3.2 Configuring Services on the Non-Protection Chain
Configure the protection subnet and the services on the non-protection chain separately. It is
recommended that you configure the protection subnet before configuring the services on the
non-protection chain.

3.2.1 Networking Diagram
You can configure a non-protection chain if the services on the chain need not be protected. In
this case, all the timeslots on the chain can carry services.

3.2.2 Signal Flow and Timeslot Allocation
To configure services on the non-protection chain, you need to plan the traffic direction and
timeslot allocation for the services on the non-protection chain.

3.2.3 Configuration Process
The configuration of services on the non-protection chain is not related to the configuration of
the protection subnet. To configure the services on the non-protection chain, configure the SDH
services from the tributary board to the line board on the source and sink NEs if the protection
subnet is already created.

3.2.1 Networking Diagram
You can configure a non-protection chain if the services on the chain need not be protected. In
this case, all the timeslots on the chain can carry services.

Figure 3-1 shows a point-to-point non-protection chain. In this example, the SP3D boards are
configured on the source NE (NE1) and the sink NE (NE2) as tributary boards to add and drop
services, and the SL1D boards are used as line boards to transmit SDH services.

Figure 3-1 Networking diagram of the non-protection chain

NE 1 NE 2

3-SL1D-1 3-SL1D-1

 

3.2.2 Signal Flow and Timeslot Allocation
To configure services on the non-protection chain, you need to plan the traffic direction and
timeslot allocation for the services on the non-protection chain.

Figure 3-2 shows the signal flow and timeslot allocation. In this example, five E1 services are
added to or dropped from NE1 and NE2.
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Figure 3-2 Signal flow and timeslot allocation of the services on the non-protection chain

VC4-1:1-5(VC12)

5×E1

NE1 NE2

线路板

Line Board

Tributary Board

Traffic direction of the non-protection chain

4-SP3D 3-SL1D-1 4-SP3D

5×E1

3-SL1D-1

 

3.2.3 Configuration Process
The configuration of services on the non-protection chain is not related to the configuration of
the protection subnet. To configure the services on the non-protection chain, configure the SDH
services from the tributary board to the line board on the source and sink NEs if the protection
subnet is already created.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

l The created protection subnet must be consistent with the actual network topology. For
details about how to create the protection subnet, see 2.6.1 Configuring a Non-Protection
Chain.

l You must be familiar with the information about 3.2.2 Signal Flow and Timeslot
Allocation.

Procedure

Step 1 Configure SDH services on the source NE (NE1).
1. Select NE1 in the NE Explorer, and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .
2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set

the parameters that are required, and then click OK,

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, the services are transmitted and
received over the same path. That is, the services are
Bidirectional services.
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Parameter Value in
This
Example

Description

Source Slot 4-SP3D In this example, the SP3D board in slot 4 of NE1 is
configured as the source tributary board. See Figure
3-2.

Source
Timeslot Range
(e.g.1,3-6)

1-5 In this example, five E1 services are configured
between NE1 and NE2. Hence, the service source
occupies VC-12s 1–5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 of NE1 is
configured as the sink line board. See Figure 3-2.

Sink VC4 VC4-1 The service sink uses the timeslots of VC4-1.

Sink Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE 1 and NE2. Hence, the service sink
occupies VC-12s 1–5.

Activate
Immediately

Yes -

Step 2 Refer to Step 1 and configure SDH services on the sink NE (NE2). Set the parameters as follows.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectional In this example, the services are transmitted and received
over the same path. That is, the services are
Bidirectional services.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 of NE1 is
configured as the source tributary board. See Figure
3-2.

Source Timeslot
Range(e.g.1,3-6)

1-5 In this example, five E1 services are configured between
NE1 and NE2. Hence, the service source occupies
VC-12s 1–5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 of NE1 is
configured as the sink line board. See Figure 3-2.

Sink VC4 VC4-1 The service sink uses the timeslots of VC4-1.

Sink Timeslot
Range(e.g.1,3-6)

1-5 In this example, five E1 services are configured between
NE1 and NE2. Hence, the service sink occupies VC-12s
1–5.

Activate
Immediately

Yes -
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Step 3 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 4 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 5 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and need to be deleted, see Deleting SDH Services.

3.3 Configuring Services on the Non-Protection Ring
Configure the protection subnet and the services on the non-protection ring separately. It is
recommended that you configure the protection subnet before configuring services on the non-
protection ring.

3.3.1 Networking Diagram
You can configure a non-protection ring if the services on the ring need not be protected. In this
case, all the timeslots on the ring can carry services.

3.3.2 Signal Flow and Timeslot Allocation
To configure services on the non-protection ring, you need to plan the traffic direction and
timeslot allocation for the services on the non-protection ring.

3.3.3 Configuration Process
The configuration of the services on the non-protection ring is not related to the configuration
of the protection subnet. To configure the services on the non-protection ring, configure the SDH
services from the tributary board to the line board on the source and sink NEs and the pass-
through services on the intermediate NEs if the protection subnet is already created.

3.3.1 Networking Diagram
You can configure a non-protection ring if the services on the ring need not be protected. In this
case, all the timeslots on the ring can carry services.

Figure 3-3 shows a non-protection ring consisting of four pieces of equipment. In this example,
the SP3D boards are used on the source NE (NE1) and the sink NE (NE3) as tributary boards
to add and drop services, and the SL1D boards are used as line boards to transmit SDH services.
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Figure 3-3 Networking diagram of the non-protection ring

NE1

NE2 NE4

NE3
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3-SL1D-2

3-SL1D-2

3-SL1D-1

3-SL1D-2

3-SL1D-1

 

3.3.2 Signal Flow and Timeslot Allocation
To configure services on the non-protection ring, you need to plan the traffic direction and
timeslot allocation for the services on the non-protection ring.

Figure 3-4 shows the signal flow and timeslot allocation. In this example, five E1 services are
added to or dropped from NE1 and NE3, and they pass through NE2.
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Figure 3-4 Signal flow and timeslot allocation of the services on the non-protection ring
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3.3.3 Configuration Process
The configuration of the services on the non-protection ring is not related to the configuration
of the protection subnet. To configure the services on the non-protection ring, configure the SDH
services from the tributary board to the line board on the source and sink NEs and the pass-
through services on the intermediate NEs if the protection subnet is already created.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

l The created protection subnet must be consistent with the actual network topology. For
details about how to create the protection subnet, see Configuring a Non-Protection Ring.

l You must be familiar with the information about 3.3.2 Signal Flow and Timeslot
Allocation.

Procedure

Step 1 Configure SDH services of the source NE (NE1).
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1. Select NE1 in the NE Explorer, and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .
2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, the services are transmitted and received
over the same path. That is, the services are
Bidirectional services.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 of NE1 is
configured as the source tributary board. See Figure
3-4.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE1 and NE3. Hence, the service source occupies
VC-12s 1–5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 of NE1 is
configured as the sink line board. See Figure 3-4.

Sink VC4 VC4-1 The timeslots where the service sink is located belong
to the first VC-4 (VC4-1).

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE1 and NE2. Hence, the service sink occupies VC-12s
1–5.

Activate
Immediately

Yes -

Step 2 Configure SDH services on the sink NE (NE3). Refer to Step 1. Set the parameters as follows.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence, Level
of the E1 services is set to VC12.

Direction Bidirectional In this example, the services are transmitted and received
over the same path. That is, the services are Bidirectional
services.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 of NE3 is
configured as the source tributary board. See Figure 3-4.
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Parameter Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE1 and NE3. Hence, the service source occupies VC-12s
1–5.

Sink Slot 3-SL1D-2
(SDH-2)

In this example, the SL1D board in slot 3 of NE2 is
configured as the sink line board. See Figure 3-4.

Sink VC4 VC4-1 The service sink uses the timeslots of VC4-1.

Sink Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE1 and NE3. Hence, the service sink occupies VC-12s 1–
5.

Activate
Immediately

Yes -

Step 3 Configure pass-through services on NE2.
1. Select NE2 in the NE Explorer, and then choose  Configuration > SDH Service

Configuration  from the Function Tree. Click .
2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, the services are transmitted and received
over the same path. That is, the services are
Bidirectional services.

Source Slot 3-SL1D-2
(SDH-2)

In this example, the SL1D board in slot 3 of NE2 is
configured as the source line board. See Figure 3-4.

Source VC4 VC4-1 The timeslots where the service source is located belong
to the first VC-4 (VC4-1).

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE1 and NE3. Hence, the service source occupies
VC-12s 1–5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 of NE2 is
configured as the sink line board. See Figure 3-4.

Sink VC4 VC4-1 The service sink uses the timeslots of VC4-1.
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Parameter Value in
This
Example

Description

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE1 and NE3. Hence, the service source occupies
VC-12s 1–5.

Activate
Immediately

Yes -

Step 4 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 5 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 6 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task

If the services are configured incorrectly and need to be deleted, see Deleting SDH Services.

3.4 Configuring 1+1 Linear MSP Services
In the case of the 1+1 linear multiplex section protection (MSP), services are transmitted on the
working path and protection path at the same time. The sink NE selects the services from the
working path in normal cases, and selects services from the protection path when the working
path becomes faulty.

3.4.1 Networking Diagram
The networking diagram of the point-to-point 1+1 linear MSP services is simple. Two NEs are
connected with two pairs of optical fibers.

3.4.2 Signal Flow and Timeslot Allocation
To configure the 1+1 linear MSP services, you can configure the services that need to be added
to the source NE and dropped from the sink NE if the 1+1 linear MSP is already created.

3.4.3 Configuration Process
This topic describes how to configure the 1+1 linear MSP services.

3.4.1 Networking Diagram
The networking diagram of the point-to-point 1+1 linear MSP services is simple. Two NEs are
connected with two pairs of optical fibers.

As shown in Figure 3-5, the SP3D boards are used on NE1 and NE2 as tributary boards to add
and drop services, and the SL1D boards are used as line boards to transmit SDH services.
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Figure 3-5 Networking diagram of the 1+1 linear MSP services
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3.4.2 Signal Flow and Timeslot Allocation
To configure the 1+1 linear MSP services, you can configure the services that need to be added
to the source NE and dropped from the sink NE if the 1+1 linear MSP is already created.

As shown in Figure 3-6, the signal flow and timeslot allocation are as follows:

l Traffic direction from NE1 to NE2: NE1→NE2

Services are added to the source NE (NE1) and are transmitted from the working path and
protection path at the same time. Then, the services are dropped from the sink NE (NE2),
which selects the services from the working path.

l Traffic direction from NE2 to NE1: NE2→NE1

Services are added to the source NE (NE2) and are transmitted on the working path and
protection path at the same time. Then, the services are dropped from the sink NE (NE1),
which selects the services from the working path.

l The services between NE 1 and NE2 occupy VC-12s 1–5 of VC4-1 (VC4-1:VC-12:1–5)
on the SDH link between NE1 and NE2. The capacity of the services is 5xE1.

When the working path from NE1 to NE2 becomes faulty, in the case of single-ended switching,
the signal flow is as follows:

l Traffic direction from NE1 to NE2: NE1→NE2

Services are added to the source NE (NE1) and are transmitted on the working path and
protection path at the same time. Then, the services are dropped from the sink NE (NE2),
which selects the services from the protection path.

l The services from NE2 to NE1 are not affected, and the traffic direction is NE2→NE1.

Services are added to the source NE (NE2) and are transmitted on the working path and
protection path at the same time. Then, the services are dropped from the sink NE (NE1),
which selects the services from the working path.

When the working path from NE1 to NE2 becomes faulty, in the case of dual-ended switching,
the traffic flow is as follows:

l Traffic direction from NE1 to NE2: NE1→NE2

Services are added to the source NE (NE1) and are transmitted on the working path and
protection path at the same time. Then, the services are dropped from the sink NE (NE2),
which selects the services from the protection path.

l Traffic direction from NE2 to NE1: NE2→NE1

Services are added from the source NE (NE2) and are transmitted on the working path and
protection path at the same time. Then, the services are dropped from the sink NE (NE1),
which selects the services from the protection path.
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Figure 3-6 Signal flow and timeslot allocation of the 1+1 linear MSP services
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3.4.3 Configuration Process
This topic describes how to configure the 1+1 linear MSP services.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

l The created protection subnet must be consistent with the actual network topology. For
details about how to create the protection subnet, see Creating a Linear MS Protection
Subnet.

l You must be familiar with the information about 3.4.2 Signal Flow and Timeslot
Allocation.

Procedure

Step 1 Configure SDH services on the source NE (NE1).

1. In the NE Explorer, select NE1 and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .

2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set
the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, services are transmitted and received
over the same path. That is, the services are bidirectional
services. Hence, Direction of the services is set to
Bidirectional.
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Parameter Value in
This
Example

Description

Source Slot 4-SP3D In this example, the SP3D board in slot 4 is configured
as the source tributary board for the bidirectional
services from NE1 to NE2. See Figure 3-6.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the service is 5xE1 according to the
plan. Hence, Source Timeslot Range(e.g.1,3-6) is set
to 1-5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured
as the sink line board. See Figure 3-6.

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63
VC-12s.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Sink Timeslot Range(e.g.1,3-6) is set
to 1-5.

Activate
Immediately

Yes -

Step 2 Configure SDH services on the sink NE (NE2).

Click , and select NE2 from the displayed NE Navigator. Click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence, Level
of the E1 services is set to VC12.

Direction Bidirectional In this example, the services are transmitted and received
over the same path. That is, the services are bidirectional
services. Hence, Direction of the services is set to
Bidirectional.

Source Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured as
the source line board. See Figure 3-6.

Source VC4 VC4-1 In this example, the service requires five VC-12s. Source
VC4 is set to VC4-1, because a VC-4 contains 63 VC-12s.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to the
plan. Hence, Source Timeslot Range(e.g.1,3-6) is set to
1-5.
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Parameter Value in
This
Example

Description

Sink Slot 4-SP3D In this example, the SP3D board in slot 4 is configured as
the sink tributary board for the bidirectional services from
NE1 to NE2. See Figure 3-6.

Sink Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to the
plan. Hence, Sink Timeslot Range(e.g.1,3-6) is set to 1-5.

Activate
Immediately

Yes -

Step 3 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 4 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 5 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

3.5 Configuring 1:1 Linear MSP Services
In the case of the 1:1 linear MSP, services are transmitted on the working path and the sink NE
receives the services from the working path in normal cases. When the working path becomes
faulty, the services are switched to the protection path for transmission and the sink NE receives
the services from the protection path.

3.5.1 Networking Diagram
The networking diagram of the point-to-point 1:1 linear MSP services is simple. Two NEs are
connected with two pairs of optical fibers.

3.5.2 Signal Flow and Timeslot Allocation
To configure the 1:1 linear MSP service, you can configure the services that need to be added
to the source NE and dropped from the sink NE if the 1:1 linear MSP is already created.

3.5.3 Configuration Process
This topic describes how to configure the 1+1 linear MSP services.

3.5.1 Networking Diagram
The networking diagram of the point-to-point 1:1 linear MSP services is simple. Two NEs are
connected with two pairs of optical fibers.

As shown in Figure 3-7, the SP3D boards are used on NE1 and NE2 as tributary boards to add
and drop services, and the SL1D boards are used on NE1 and NE2 as line boards to transmit
SDH services.
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Figure 3-7 Networking diagram of the 1:1 linear MSP services
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3.5.2 Signal Flow and Timeslot Allocation
To configure the 1:1 linear MSP service, you can configure the services that need to be added
to the source NE and dropped from the sink NE if the 1:1 linear MSP is already created.

As shown in Figure 3-8, the signal flow and timeslot allocation are as follows:
l Traffic direction from NE1 to NE2: NE1→NE2

Services are added to the source NE (NE1) and then are dropped from the sink NE (NE2).
The services are transmitted on the working path.

l Traffic direction from NE2 to NE1: NE2→NE1
Services are added to the source NE (NE2) and then are dropped from the sink NE (NE1).
The services are transmitted on the working path.

l The services between NE1 and NE2 occupy VC-12s 1–5 of VC4-1 (VC4-1:VC-12:1–5)
on the SDH link between NE1 and NE2. The capacity of the services is 5xE1.

When the working path between NE1 and NE2 becomes faulty, the signal flow is as follows:
l Traffic direction from NE1 to NE2: NE1→NE2

Services are added to the source NE (NE1) and then are dropped from the sink NE (NE2).
The services are transmitted on the protection path.

l Traffic direction from NE2 to NE1: NE2→NE1
Services are added to the source NE (NE2) and then are dropped from the sink NE (NE1).
The services are transmitted on the protection path.

The difference between the 1:1 linear MSP service and the 1+1 linear MSP service is as follows:
l In the case of the 1+1 linear MSP service, services are transmitted on the working path and

protection path at the same time. The sink NE selects the services from the working path.
l In the case of the 1:1 linear MSP service, services are transmitted only on the working path.

Services are switched to the protection path for transmission only when the working path
becomes faulty.

Figure 3-8 Signal flow and timeslot allocation of the 1:1 linear MSP services
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3.5.3 Configuration Process
This topic describes how to configure the 1+1 linear MSP services.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

l The created protection subnet must be consistent with the actual network topology. For
details about how to create the protection subnet, see Creating a Linear MS Protection
Subnet.

l You must be familiar with the information about 3.5.2 Signal Flow and Timeslot
Allocation.

Procedure

Step 1 Configure SDH services on the source NE (NE1).

1. Select NE1 in the NE Explorer, and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .

2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set
the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, services are transmitted and received on
the same path. That is, the services are bidirectional
services. Hence, Direction of the services is set to
Bidirectional.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 is configured
as the source tributary board for the bidirectional
services from NE1 to NE2. See Figure 3-8.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the service is 5xE1 according to the
plan. Hence, Source Timeslot Range(e.g.1,3-6) is set
to 1-5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured
as the sink line board. See Figure 3-8.

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63
VC-12s.
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Parameter Value in
This
Example

Description

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Sink Timeslot Range(e.g.1,3-6) is set
to 1-5.

Activate
Immediately

Yes -

Step 2 Configure SDH services on the sink NE (NE2).

Click , and select NE2 from the displayed NE Navigator. Click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence, Level
of the E1 services is set to VC12.

Direction Bidirectional In this example, the services are transmitted and received
on the same path. That is, the services are bidirectional
services. Hence, Direction of the services is set to
Bidirectional.

Source Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured as
the source line board. See Figure 3-8.

Source VC4 VC4-1 In this example, the service requires five VC-12s. Source
VC4 is set to VC4-1, because a VC-4 contains 63 VC-12s.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to the
plan. Hence, Source Timeslot Range(e.g.1,3-6) is set to
1-5.

Sink Slot 4-SP3D In this example, the SP3D board in slot 4 is configured as
the sink tributary board for the bidirectional services from
NE1 to NE2. See Figure 3-8.

Sink Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to the
plan. Hence, Sink Timeslot Range(e.g.1,3-6) is set to 1-5.

Activate
Immediately

Yes -

Step 3 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 4 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.
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Step 5 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

3.6 Configuring Two-Fiber Unidirectional MSP Services
The two-fiber unidirectional MSP services can provide network level protection for the services
on NEs on the MSP ring. On the T2000, you can add all the NEs on the MSP ring into the
protection subnet to create a two-fiber unidirectional MSP ring.

3.6.1 Networking Diagram
The networking diagram of a single two-fiber unidirectional MSP ring is simple. When you
construct the network, follow a certain order to create and name these NEs and ensure that the
traffic flows in a proper direction. This helps when you plan the traffic direction planning and
service configuration in future.

3.6.2 Signal Flow and Timeslot Allocation
To configure the two-fiber unidirectional MSP service, you can configure the services that need
to be added to the ring network on the source NE, to pass through the intermediate nodes, and
to be dropped from the sink NE if the MSP protection subnet is already created.

3.6.3 Configuration Process
This topic describes how to configure the two-fiber unidirectional MSP service.

3.6.1 Networking Diagram
The networking diagram of a single two-fiber unidirectional MSP ring is simple. When you
construct the network, follow a certain order to create and name these NEs and ensure that the
traffic flows in a proper direction. This helps when you plan the traffic direction planning and
service configuration in future.

As shown in Figure 3-9, the SP3D boards are used on NE1 and NE3 as tributary boards to add
and drop services, and the SL1D boards are used as line boards to transmit SDH services.

Figure 3-9 Networking diagram of the services on the two-fiber unidirectional MSP ring
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3.6.2 Signal Flow and Timeslot Allocation
To configure the two-fiber unidirectional MSP service, you can configure the services that need
to be added to the ring network on the source NE, to pass through the intermediate nodes, and
to be dropped from the sink NE if the MSP protection subnet is already created.

As shown in Figure 3-10, the signal flow and timeslot allocation are as follows:
l Traffic direction from NE1 to NE3: NE1→NE2→NE3

Services are added to the ring on the source NE (NE1), pass through NE2, and finally are
dropped from the sink NE (NE3). The capacity of the services is 5xE1.

l Traffic direction from NE3 to NE1: NE3→NE4→NE1
Services are added to the ring on the source NE (NE3), pass through NE4, and finally are
dropped from the sink NE (NE1). The capacity of the services is 5xE1.

l VC-12s 1–5 of VC4-1 carry the five E1 services for transmission.

When the transmission path between NE1 and NE2 becomes faulty, the signal flow and timeslot
allocation are as follows:
l Traffic direction from NE1 to NE3: NE1→NE4→NE3→NE2→NE3

Services are added to the ring on the source NE (NE1) and switched from the original
working path to the protection path. Then, the services pass through NE4 and NE3. After
that, the services are switched from the protection path to the working path on NE2. Finally,
the services are dropped from NE3.

l The services from NE3 to NE1 are not affected, and the traffic direction is
NE3→NE4→NE1.

The difference between the two-fiber unidirectional MSP service and the two-fiber bidirectional
MSP service is as follows:
l The two-fiber unidirectional MSP service uses the diverse routes, whereas the two-fiber

bidirectional MSP service uses the uniform route.
l In the case of the two-fiber unidirectional MSP service, different optical fibers are used for

the working timeslot and protection timeslot. That is, one optical fiber is used for carrying
the working service, and the other optical fiber is used for protection. In the case of the
two-fiber bidirectional MSP service, the same optical fiber is used for the working timeslot
and protection timeslot. That is, a certain capacity of the optical fiber is used for carrying
the working service, and a certain capacity of the optical fiber is used for protection.
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Figure 3-10 Signal flow and timeslot allocation of the two-fiber unidirectional MSP services
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3.6.3 Configuration Process
This topic describes how to configure the two-fiber unidirectional MSP service.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

l The created protection subnet must be consistent with the actual network topology. For
details about how to create the protection subnet, see Creating an MS Ring Protection
Subnet.

l You must be familiar with the information about 3.6.2 Signal Flow and Timeslot
Allocation.

Procedure

Step 1 Configure unidirectional services from NE1 to NE3.
1. Configure SDH services on the source NE (NE1).

l In the NE Explorer, select NE1 and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .
l Click Create on the lower-right pane to display the Create SDH Service dialog box.

Set the parameters that are required, and then click OK.
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Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Unidirectio
nal

In this example, the services are transmitted and
received on different paths. That is, the services are
unidirectional services. Hence, Direction of the
services is set to Unidirectional.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 is configured
as the source tributary board for the unidirectional
services from NE1 to NE2. See Figure 3-10.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Source Timeslot Range(e.g.1,3-6)
is set to 1-5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured
as the sink line board. See Figure 3-10.

Sink VC4 VC4-1 In this example, the services require five VC-12s.
Sink VC4 is set to VC4-1, because a VC-4 contains
63 VC-12s.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Sink Timeslot Range(e.g.1,3-6) is
set to 1-5.

Activate
Immediately

Yes -

2. Configure unidirectional pass-through services on NE2.

Click , and select NE2 from the displayed NE Navigator. Click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Unidirection
al

In this example, the services are transmitted and received
on different paths. That is, the services are unidirectional
services. Hence, Direction of the services is set to
Unidirectional.
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Parameter Value in
This
Example

Description

Source Slot 3-SL1D-2
(SDH-2)

In this example, the SL1D board in slot 3 is configured
as the source line board. See Figure 3-10. You can select
different source boards depending on the actual
situation.

Source VC4 VC4-1 In this example, the services require five VC-12s.
Source VC4 is set to VC4-1, because a VC-4 contains
63 VC-12s.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Source Timeslot Range(e.g.1,3-6) is
set to 1-5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured
as the sink line board. See Figure 3-10.

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63
VC-12s.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Sink Timeslot Range(e.g.1,3-6) is set
to 1-5.

Activate
Immediately

Yes -

3. Configure SDH services on the sink NE (NE3).

Click , and select NE2 from the displayed NE Navigator. Click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Unidirection
al

In this example, the services are transmitted and received
on different paths. That is, the services are unidirectional
services. Hence, Direction of the services is set to
Unidirectional.

Source Slot 3-SL1D-2
(SDH-2)

In this example, the SL1D board in slot 3 is configured
as the source line board. See Figure 3-10.

Source VC4 VC4-1 In this example, the services require five VC-12s.
Source VC4 is set to VC4-1, because a VC-4 contains
63 VC-12s.
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Parameter Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Source Timeslot Range(e.g.1,3-6) is
set to 1-5.

Sink Slot 4-SP3D In this example, the SP3D board in slot 4 is configured
as the sink tributary board for the unidirectional services
from NE1 to NE3. See Figure 3-10.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the planning. Hence, Sink Timeslot Range(e.g.1,3-6) is
set to 1-5.

Activate
Immediately

Yes -

Step 2 Configure unidirectional services from NE3 to NE1.

To configure unidirectional services from NE3 to NE1, refer to Step 1.

1. Configure SDH services on the source NE (NE3).

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Unidirection
al

In this example, the services are transmitted and received
on different paths. That is, the services are unidirectional
services. Hence, Direction of the services is set to
Unidirectional.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 is configured
as the source tributary board for the unidirectional
services from NE3 to NE1. See Figure 3-10.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Source Timeslot Range(e.g.1,3-6) is
set to 1-5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured
as the sink line board. See Figure 3-10.

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63
VC-12s.
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Parameter Value in
This
Example

Description

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Sink Timeslot Range(e.g.1,3-6) is set
to 1-5.

Activate
Immediately

Yes -

2. Configure unidirectional pass-through services on NE4.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Unidirection
al

In this example, the services are transmitted and received
on different paths. That is, the services are unidirectional
services. Hence, Direction of the services is set to
Unidirectional.

Source Slot 3-SL1D-2
(SDH-2)

In this example, the SL1D board in slot 3 is configured
as the source line board. See Figure 3-10.

Source VC4 VC4-1 In this example, the services require five VC-12s.
Source VC4 is set to VC4-1, because a VC-4 contains
63 VC-12s.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Source Timeslot Range(e.g.1,3-6) is
set to1-5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured
as the sink line board. See Figure 3-10.

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63
VC-12s.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Sink Timeslot Range(e.g.1,3-6) is set
to 1-5.

Activate
Immediately

Yes -

3. Configure SDH services on the sink NE (NE1).
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Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Unidirection
al

In this example, the services are transmitted and received
on the same path. That is, the services are bidirectional
services. Hence, Direction of the services is set to
Bidirectional.

Source Slot 3-SL1D-2
(SDH-2)

In this example, the SL1D board in slot 3 is configured
as the source line board. See Figure 3-10.

Source VC4 VC4-1 In this example, the service requires five VC-12s.
Source VC4 is set to VC4-1, because a VC-4 contains
63 VC-12s.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Source Timeslot Range(e.g.1,3-6) is
set to 1-5.

Sink VC4 4-SP3D In this example, the SP3D board in slot 4 is configured
as the sink tributary board for the unidirectional services
from NE3 to NE1. See Figure 3-10.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The total capacity of the services is 5xE1 according to
the plan. Hence, Sink Timeslot Range(e.g.1,3-6) is set
to 1-5.

Activate
Immediately

Yes -

Step 3 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 4 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 5 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

3.7 Configuring the Two-Fiber Bidirectional MSP Services
To configure the two-fiber bidirectional MSP services, you need to create the MSP subnet
protection and MSP services separately. There is no requirement for the configuration sequence.

3.7.1 Networking Diagram
The networking diagram of a single two-fiber bidirectional MSP ring is simple. When you
construct the network, follow a certain order to create and name the NEs and ensure that the

OptiX OSN 500 STM-1/STM-4 Multi-Service CPE Optical
Transmission System
Configuration Guide 3 Configuring SDH Services

Issue 01 (2009-01-20) Huawei Proprietary and Confidential
Copyright © Huawei Technologies Co., Ltd.

3-27



traffic flows in a proper direction. This helps when you plan the traffic directions and configure
services in future.

3.7.2 Signal Flow and Timeslot Allocation
To configure the two-fiber bidirectional MSP service on a ring network, configure the services
that need to be added to the ring network on the source NE, to pass through the intermediate
nodes, and to be dropped from the sink NE, if the MSP protection subnet is already created. In
the case of the ring network, more than one route is available from the source NE to the sink
NE. In actual application scenarios, not all the routes need to be configured. Hence, you need
to properly plan and configure the service directions and timeslots before the configuration.

3.7.3 Configuration Process
The configuration of the two-fiber bidirectional MSP services is independent of the configuration
of the protection subnet. To configure the two-fiber bidirectional MSP service, if the protection
subnet is configured, configure the SDH services from the tributary board to the line board on
the source and sink NEs and configure the pass-through services on the intermediate NEs.

3.7.1 Networking Diagram
The networking diagram of a single two-fiber bidirectional MSP ring is simple. When you
construct the network, follow a certain order to create and name the NEs and ensure that the
traffic flows in a proper direction. This helps when you plan the traffic directions and configure
services in future.

Figure 3-11 shows the networking of the two-fiber bidirectional MSP ring that comprises four
pieces of OptiX OSN 500 equipment. In this example, the SP3D boards are configured on the
source NE (NE1) and the sink NE (NE3) as tributary boards to add and drop services, and the
SL4D boards are used as line boards to transmit SDH services.

Figure 3-11 Networking diagram of the services on the two-fiber bidirectional MSP ring

NE1

NE2 NE4

NE3

8-SL4D-1 8-SL4D-2

8-SL4D-2 8-SL4D-1

8-SL4D-2

8-SL4D-1 8-SL4D-2

8-SL4D-1

Two-fiber bidirectional
 MSP ring

 

3.7.2 Signal Flow and Timeslot Allocation
To configure the two-fiber bidirectional MSP service on a ring network, configure the services
that need to be added to the ring network on the source NE, to pass through the intermediate
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nodes, and to be dropped from the sink NE, if the MSP protection subnet is already created. In
the case of the ring network, more than one route is available from the source NE to the sink
NE. In actual application scenarios, not all the routes need to be configured. Hence, you need
to properly plan and configure the service directions and timeslots before the configuration.

Figure 3-12 shows the service signal flow and timeslot allocation. In this example, five E1
services are configured so that the services enter the ring network from NE1, pass through NE2,
and then are dropped on the sink NE (NE3).

Figure 3-12 Signal flow and timeslot allocation

VC4-1:1-5(VC12)

NE1

NE2

NE3
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4-SP3DVC4-1:1-5(VC12)

5xE1 services are
added/dropped

MSP ring

 

3.7.3 Configuration Process
The configuration of the two-fiber bidirectional MSP services is independent of the configuration
of the protection subnet. To configure the two-fiber bidirectional MSP service, if the protection
subnet is configured, configure the SDH services from the tributary board to the line board on
the source and sink NEs and configure the pass-through services on the intermediate NEs.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

OptiX OSN 500 STM-1/STM-4 Multi-Service CPE Optical
Transmission System
Configuration Guide 3 Configuring SDH Services

Issue 01 (2009-01-20) Huawei Proprietary and Confidential
Copyright © Huawei Technologies Co., Ltd.

3-29



l The created protection subnet must be consistent with the actual network topology. For
details about how to create the protection subnet, see Creating an MS Ring Protection
Subnet.

l You must be familiar with 3.7.2 Signal Flow and Timeslot Allocation.

Procedure

Step 1 Configure the SDH services of the source NE (NE1).

1. In the NE Explorer, select NE1, and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .

2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set
the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, the services are transmitted and received
on the same path. That is, the services are bidirectional
services. Hence, Direction of the services is set to
Bidirectional.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 is configured
as the source tributary board. See Figure 3-12. You can
select different source boards depending on the actual
situation.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Source Timeslot Range(e.g.1,3-6) is set to 1-5. See
Figure 3-12.

Sink Slot 8-SL4D-1
(SDH-1)

In this example, the SL4D board in slot 8 is configured
as the sink line board. See Figure 3-12. You can select
different sink boards depending on the actual situation.

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63
VC-12s.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Sink Timeslot Range(e.g.1,3-6) is set to 1-5. See
Figure 3-12.

Activate
Immediately

Yes -

Step 2 Configure the SDH services of the sink NE (NE3). Refer to Step 1 and configure the SDH
services of NE3. Set the parameters as follows.
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Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence, Level
of the E1 services is set to VC12.

Direction Bidirectional In this example, the services are transmitted and received
on the same path. That is, the services are bidirectional
services. Hence, Direction of the services is set to
Bidirectional.

Source Slot 8-SL4D-2
(SDH-2)

In this example, the SL4D board in slot 8 is configured as
the source line board. See Figure 3-12. You can select
different source boards depending on the actual situation.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Source Timeslot Range(e.g.1,3-6) is set to 1-5. See Figure
3-12.

Sink Slot 4-SP3D In this example, the SP3D board in slot 4 is configured as
the sink tributary board. See Figure 3-12. You can select
different sink boards depending on the actual situation.

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63 VC-12s.

Sink Timeslot
Range(e.g.
1,3-6)

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Sink Timeslot Range(e.g.1,3-6) is set to 1-5. See Figure
3-12.

Activate
Immediately

Yes -

Step 3 Configure the pass-through services of NE2.
1. In the NE Explorer, select NE2 and then choose  Communication > SDH Service

Configuration from the Function Tree. Click .
2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, the services are transmitted and received
on the same path. That is, the services are bidirectional
services. Hence, Direction of the services is set to
Bidirectional.
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Parameter Value in
This
Example

Description

Source Slot 8-SL4D-2
(SDH-2)

In this example, the SL4D board in slot 8 is configured
as the source line board. See Figure 3-12. You can select
different source boards depending on the actual
situation.

Source VC4 VC4-1 In this example, the services require five VC-12s.
Source VC4 is set to VC4-1, because a VC-4 contains
63 VC-12s.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Source Timeslot Range(e.g.1,3-6) is set to 1-5. See
Figure 3-12.

Sink Slot 8-SL4D-1
(SDH-1)

In this example, the SL4D board in slot 8 is configured
as the sink line board. See Figure 3-12. You can select
different sink boards depending on the actual situation.

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63
VC-12s.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Sink Timeslot Range(e.g.1,3-6) is set to 1-5. See
Figure 3-12.

Activate
Immediately

Yes -

Step 4 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 5 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 6 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see Deleting SDH Services.

3.8 Configuring Services on the SNCP Ring
Compared with the services on an MSP ring, the services on an SNCP ring have dedicated
physical paths as the protection paths. In addition, the services on an SNCP ring are dually fed
and selectively received. When you configure services on an SNCP ring, you need not configure
the protection subnet and the services separately. When you configure services on an SNCP ring,
however, you need to configure the working services and protection services separately.
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3.8.1 Networking Diagram
The creation of an SNCP ring network is similar to the creation of an MSP ring network. For
example, the MSP and SNCP rings are constructed based on two fibers and their services must
pass through the intermediate nodes for transmission from the source NE to the sink NE. The
difference is that the SNCP protection and SNCP services can be created on the T2000 at a time.

3.8.2 Signal Flow and Timeslot Allocation
Similar to the service configuration of an MSP ring, you need to plan proper traffic directions
before configuring the services on an SNCP ring, if multiple service routes are available from
the source end to the sink end. In the case of the services on the SNCP ring, allocate timeslots
for the source slot of the working service and timeslots for the source slot of the protection
service, when allocating timeslots for source slots.

3.8.3 Configuration Process
The SNCP protection and the services on the SNCP ring are configured on the T2000 at a time.
To configure the SNCP services on the source and sink NEs, you need to determine the source
boards and timeslots for the working service and protection service. In addition, you need to
configure the pass-through service on the intermediate nodes.

3.8.1 Networking Diagram
The creation of an SNCP ring network is similar to the creation of an MSP ring network. For
example, the MSP and SNCP rings are constructed based on two fibers and their services must
pass through the intermediate nodes for transmission from the source NE to the sink NE. The
difference is that the SNCP protection and SNCP services can be created on the T2000 at a time.

Figure 3-13 shows an SNCP ring that comprises four pieces of MSTP equipment. In this
example, the SP3D boards are configured on the source NE (NE1) and the sink NE (NE3) as
tributary boards to add and drop services, and the SL1D boards are used as line boards to transmit
SDH services.

Figure 3-13 Networking diagram of the services on the SNCP ring
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3.8.2 Signal Flow and Timeslot Allocation
Similar to the service configuration of an MSP ring, you need to plan proper traffic directions
before configuring the services on an SNCP ring, if multiple service routes are available from
the source end to the sink end. In the case of the services on the SNCP ring, allocate timeslots
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for the source slot of the working service and timeslots for the source slot of the protection
service, when allocating timeslots for source slots.

Figure 3-14 shows the signal flow of the services on the SNCP ring and the timeslot allocation
to the services on the SNCP ring. In the actual configuration, you can plan other proper working
paths and protection paths according to the requirement. In this example, the working service
route is NE1-NE2-NE3 and the protection service route is NE1-NE4-NE3. There are five E1
services.

Figure 3-14 Signal flow and timeslot allocation
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3.8.3 Configuration Process
The SNCP protection and the services on the SNCP ring are configured on the T2000 at a time.
To configure the SNCP services on the source and sink NEs, you need to determine the source
boards and timeslots for the working service and protection service. In addition, you need to
configure the pass-through service on the intermediate nodes.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

l You must be familiar with 3.8.2 Signal Flow and Timeslot Allocation.

Procedure

Step 1 Configure the SDH services of the source NE (NE1).
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1. In the NE Explorer, select NE1, and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .
2. Click Create on the lower-right pane to display the Create SNCP Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Service Type SNCP In this example, Service Type adopts the default value,
namely, SNCP.

Level VC12 In this example, E1 services are configured on the ring.
Hence, Level of the E1 services is set to VC12.

Direction Bidirectional In this example, the services are transmitted and
received on the same path. That is, the services are
bidirectional services. Hence, Direction of the services
is set to Bidirectional.

Revertive
Mode

Revertive This parameter indicates whether the services are
switched back after the faulty line is recovered, that is,
whether the switching is revertive or non-revertive. In
this example, Revertive Mode is set to Revertive.

Hold-off
Time
(100ms)

0 It is recommended that this parameter adopts the default
value.

WTR Time
(s)

600 After the working path is recovered to normal and the
normal state lasts for 600s, the switching restoration
occurs. This parameter is valid only when the Revertive
Mode parameter is set to Revertive.

Source Slot
of the
Working
Service

3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured
as the source line board of the working service. See
Figure 3-14. You can select different source boards
depending on the actual situation.

Source
Timeslot
Range of the
Working
Service

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Source Timeslot Range of the Working Service is set
to 1-5. See Figure 3-14.

Source Slot
of the
Protection
Service

3-SL1D-2
(SDH-2)

In this example, the SL1D board in slot 3 is configured
as the source board of the protection service. See Figure
3-14. You can select different source boards depending
on the actual situation.

Source
Timeslot
Range of the
Protection
Service

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Source Timeslot Range of the Protection Service is
set to 1-5. See Figure 3-14.
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Parameter Value in
This
Example

Description

Sink Slot 4-SP3D In this example, the SP3D board in slot 4 is configured
as the sink tributary board. See Figure 3-14. You can
select different sink boards depending on the actual
situation.

Sink
Timeslot
Range of the
Working
Service

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Source Timeslot Range of the Working Service is set
to 1-5. See Figure 3-14.

Step 2 Configure the SDH services of the sink NE (NE3). Refer to Step 1 and configure the SDH
services of NE3. The method and parameters for configuring the SDH services of NE3 are the
same as the method and parameters for configuring the SDH services of NE1.

Step 3 Configure the pass-through services of NE2.

1. In the NE Explorer, select NE2 and then choose  Communication > SDH Service

Configuration from the Function Tree. Click .
2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured on the ring.
Hence, Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, the services are transmitted and received
on the same path. That is, the services are bidirectional
services. Hence, Direction of the E1 services is set to
Bidirectional.

Source Slot 3-SL1D-2
(SDH-2)

In this example, the SL1D board in slot 3 is configured
as the source line board. See Figure 3-14. You can select
different source boards depending on the actual
situation.

Source VC4 VC4-1 In this example, the services require five VC-12s.
Source VC4 is set to VC4-1, because a VC-4 contains
63 VC-12s.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Source Timeslot Range(e.g.1,3-6) is set to 1-5. See
Figure 3-14.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 is configured
as the sink line board. See Figure 3-14. You can select
different sink boards depending on the actual situation.
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Parameter Value in
This
Example

Description

Sink VC4 VC4-1 In this example, the services require five VC-12s. Sink
VC4 is set to VC4-1, because a VC-4 contains 63
VC-12s.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, the total capacity of the services is 5xE1
according to the plan. The service level is VC12. Hence,
Sink Timeslot Range(e.g.1,3-6) is set to 1-5. See
Figure 3-14.

Activate
Immediately

Yes -

Step 4 Configure the pass-through services of NE4. Refer to Step 3 and configure the pass-through
services of NE4. The method and parameters for configuring the pass-through services of NE4
are the same as the method and parameters for configuring the pass-through services of NE2.

Step 5 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 6 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 7 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task

If the services are configured incorrectly and thus need to be deleted, see Deleting SDH Services.

3.9 Configuring Services on the SNCP Ring with a Non-
Protection Chain

To configure the services on the SNCP ring, you can directly configure the working service and
protection service, without first configuring the protection subnet. To configure the services on
the non-protection chain, you can configure the services only after the protection subnet is
created.

3.9.1 Networking Diagram
The networking of the SNCP ring in the case of configuring the services on the SNCP ring with
a non-protection chain is similar to the networking in the case of configuring the services on the
SNCP ring. The services from the SNCP ring to the non-protection chain pass through the
intersecting node and are added to or dropped from the NE on the non-protection chain.

3.9.2 Signal Flow and Timeslot Allocation
To configure services on the SNCP ring with a non-protection chain, you need to plan proper
traffic directions for the services on the SNCP ring and the services on the non-protection chain.
In the case of the services on the SNCP ring, allocate timeslots for the source slot of the working
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service and timeslots for the source slot of the protection service, when allocating timeslots for
source slots.

3.9.3 Configuration Process
Before you configure the services on the SNCP ring with a non-protection chain, familiarize
yourself with the information about the source slot, sink slot, and their corresponding timeslots
of the working service and protection service on the source and sink NEs on the SNCP ring. You
need to configure the pass-through services on the intersecting NE.

3.9.1 Networking Diagram
The networking of the SNCP ring in the case of configuring the services on the SNCP ring with
a non-protection chain is similar to the networking in the case of configuring the services on the
SNCP ring. The services from the SNCP ring to the non-protection chain pass through the
intersecting node and are added to or dropped from the NE on the non-protection chain.

Figure 3-15 shows the networking diagram of the SNCP ring with a non-protection chain. The
SNCP ring comprises five pieces of equipment.

In this example, 5xE1 services are configured between NE3 and NE5. The SP3D boards are
configured on the source NE (NE3) and the sink NE (NE5) as tributary boards to add and drop
services. The SL4D and SL1D boards are used as the line boards for transmitting SDH services.

Figure 3-15 Networking diagram of the services on the SNCP ring with a non-protection chain
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3.9.2 Signal Flow and Timeslot Allocation
To configure services on the SNCP ring with a non-protection chain, you need to plan proper
traffic directions for the services on the SNCP ring and the services on the non-protection chain.
In the case of the services on the SNCP ring, allocate timeslots for the source slot of the working
service and timeslots for the source slot of the protection service, when allocating timeslots for
source slots.

Figure 3-16 shows the signal flow of the services on the SNCP ring with a non-protection chain
and the timeslot allocation to the services on the SNCP ring with a non-protection chain . In this
example, five E1 services are configured between NE3 and NE5.

In this example, the traffic direction of the services on the SNCP ring, is configured as follows:
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l Traffic direction of the working service between NE3 and NE4: NE3-NE4

l Traffic direction of the protection service between NE3 and NE4: NE3-NE2-NE1-NE4

In the actual configuration, you can plan other proper working paths and protection paths
according to the requirement.

Figure 3-16 Signal flow and timeslot allocation
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3.9.3 Configuration Process
Before you configure the services on the SNCP ring with a non-protection chain, familiarize
yourself with the information about the source slot, sink slot, and their corresponding timeslots
of the working service and protection service on the source and sink NEs on the SNCP ring. You
need to configure the pass-through services on the intersecting NE.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

l The created protection subnet must be consistent with the actual network topology. For
details about how to create the protection subnet, see 2.6.1 Configuring a Non-Protection
Chain.

l You must be familiar with 3.9.2 Signal Flow and Timeslot Allocation.

Procedure

Step 1 Configure the SDH services of the source NE (NE3).
1. In the NE Explorer, select NE3, and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .
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2. Click Create on the lower-right pane to display the Create SNCP Service dialog box. Set
the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Service Type SNCP In this example, Service Type is set to SNCP.

Level VC12 In this example, E1 services are configured.
Hence, Level of the E1 services is set to VC12.

Revertive Mode Revertive When an NE is in the switching state, the NE is
restored from the switching state to the normal
state some time after the working path is recovered
to normal.

Direction Bidirection
al

In this example, the cross-connections are
configured in the SNCP receive direction and in
the SNCP transmit direction.

Hold-off Time
(100ms)

0 It is recommended that this parameter adopts the
default value.

WTR Time(s) 600 After the working path is recovered to normal and
the normal state lasts for 600s, the switching
restoration occurs. This parameter is valid only
when the Revertive Mode parameter is set to
Revertive.

Wor
king
Ser
vice

Source Slot 8-SL4D-1
(SDH-1)

In this example, the SL4D board in slot 8 of NE3
is configured as the source line board of the
working service. See Figure 3-16.

Source VC4 VC4-1 In this example, the working service source uses
the timeslots of VC4-1.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the working
service source occupies VC-12s 1–5.

Sink Slot 4-SP3D In this example, the SP3D board in slot 4 of NE3
is configured as the sink line board of the working
service. See Figure 3-16.

Sink VC4 - -

Sink Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the working
service source occupies VC-12s 1–5.

Prot
ecti
on
Ser
vice

Source Slot 8-SL4D-2
(SDH-2)

In this example, the SL4D board in slot 8 of NE3
is configured as the source line board of the
protection service. See Figure 3-16.
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Parameter Value in
This
Example

Description

Source VC4 VC4-1 In this example, the protection service source uses
the timeslots of VC4-1.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the protection
service source occupies VC-12s 1–5.

Step 2 Configure the SDH services of the sink NE (NE4).

1. In the NE Explorer, click , and then select NE4. Click OK.
2. Choose Configuration  > SDH Service Configuration from the Function Tree and click

.
3. Click Create on the lower-right pane to display the Create SNCP Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Service Type SNCP In this example, Service Type is set to SNCP.

Level VC12 In this example, E1 services are configured.
Hence, Level of the E1 services is set to VC12.

Revertive Mode Revertive When an NE is in the switching state, the NE is
restored from the switching state to the normal
state some time after the working path is recovered
to normal.

Direction Bidirection
al

In this example, the cross-connections are
configured in the SNCP receive direction and in
the SNCP transmit direction.

Hold-off Time
(100ms)

0 It is recommended that this parameter adopts the
default value.

WTR Time(s) 600 After the working path is recovered to normal and
the normal state lasts for 600s, the switching
restoration occurs. This parameter is valid only
when the Revertive Mode parameter is set to
Revertive.

Wor
king
Ser
vice

Source Slot 8-SL4D-2
(SDH-2)

In this example, the SL4D board in slot 8 of NE4
is configured as the source line board of the
working service. See Figure 3-16.

Source VC4 VC4-1 In this example, the working service source uses
the timeslots of VC4-1.
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Parameter Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the working
service source occupies VC-12s 1–5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 of NE4
is configured as the sink line board of the working
service. See Figure 3-16.

Sink VC4 VC4-1 In this example, the working service sink uses the
timeslots of VC4-1.

Sink Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the working
service sink occupies VC-12s 1–5.

Prot
ecti
on
Ser
vice

Source Slot 8-SL4D-1
(SDH-1)

In this example, the SL4D board in slot 8 of NE3
is configured as the source line board of the
protection service. See Figure 3-16.

Source VC4 VC4-1 In this example, the protection service source uses
the timeslots of VC4-1.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the protection
service source occupies VC-12s 1–5.

Step 3 Configure the pass-through services of NE2.

1. In the NE Explorer, click , and then select NE2. Click OK.
2. Choose Configuration  > SDH Service Configuration from the Function Tree and click

.
3. Click Create on the lower-right pane to display the Create SNCP Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, Direction of the service is set to
Bidirectional.

Source Slot 8-SL4D-2
(SDH-2)

In this example, the SL4D board in slot 8 of NE2 is
configured as the source line board. See Figure 3-16.
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Parameter Value in
This
Example

Description

Source VC4 VC4-1 In this example, the working service source uses the
timeslots of VC4-1.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE3 and NE5. Hence, the working service source
occupies VC-12s 1–5.

Sink Slot 8-SL4D-1
(SDH-1)

In this example, the SL4D board in slot 8 of NE2 is
configured as the sink line board. See Figure 3-16.

Sink VC4 VC4-1 In this example, the service sink uses the timeslots of
VC4-1.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE3 and NE5. Hence, the service sink occupies VC-12s
1–5.

Activate
Immediately

Yes -

Step 4 Configure the pass-through services of NE1. Refer to Step 3 and configure the SDH services of
NE1. The method and parameters for configuring the pass-through services of NE1 are the same
as the method and parameters for configuring the pass-through services of NE2.

Step 5 Configure the services on the non-protection chain at NE5.

1. In the NE Explorer, click , and then select NE5. Click OK.
2. Choose Configuration  > SDH Service Configuration from the Function Tree and click

.
3. Click Create on the lower-right pane to display the Create SNCP Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, Direction of the E1 services is set to
Bidirectional.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 of NE5 is
configured as the source tributary board. See Figure
3-16.
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Parameter Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE3 and NE5. Hence, the working service source
occupies VC-12s 1–5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 of NE5 is
configured as the sink line board. See Figure 3-16.

Sink VC4 VC4-1 In this example, the service sink uses the timeslots of
VC4-1.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured between
NE3 and NE5. Hence, the service sink occupies VC-12s
1–5.

Activate
Immediately

Yes -

Step 6 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 7 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 8 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see Deleting SDH Services.

3.10 Configuring Service on the MSP Ring with a Non-
Protection Chain

Configure the protection subnet for the MSP, Protection Subnet for the non-protection chain,
and services on the MSP ring with a non-protection chain separately. It is recommended that
you configure the protection subnets before configuring the services on the MSP ring with a
non-protection ring chain.

3.10.1 Networking Diagram
In the case of the MSP ring with a non-protection chain, the networking diagram of the MSP
ring is similar to the networking diagram of the single two-fiber bidirectional MSP ring. The
only difference is that one line board needs to be configured on the intersecting NE when the
non-protection chain is added. This can realize the pass-through of the services when the services
are required to be transmitted out of the MSP ring.

3.10.2 Signal Flow and Timeslot Allocation
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To configure the service on the MSP ring with a non-protection chain, you should plan a proper
traffic direction and a timeslot allocation scheme for the services on the SNCP ring and the
services on the non-protection chain.

3.10.3 Configuration Process
The configuration of the services on the two-fiber bidirectional MSP ring with a non-protection
chain is independent of the creation of the protection subnets for the MSP and for the non-
protection chain. To configure the services on the two-fiber bidirectional MSP ring with a non-
protection chain, configure the SDH services from the tributary board to the line board on the
source and sink NEs and configure pass-through services on the intermediate NEs, if the
protection subnet is already created.

3.10.1 Networking Diagram
In the case of the MSP ring with a non-protection chain, the networking diagram of the MSP
ring is similar to the networking diagram of the single two-fiber bidirectional MSP ring. The
only difference is that one line board needs to be configured on the intersecting NE when the
non-protection chain is added. This can realize the pass-through of the services when the services
are required to be transmitted out of the MSP ring.

Figure 3-17 shows the networking diagram of the MSP ring with a non-protection chain. The
MSP ring comprises five pieces of equipment. In this example, the SP3D boards are configured
on the source NE (NE3) and sink NE (NE5) as tributary boards to add and drop services, and
the SL4D and SL1D boards are used as line boards to transmit SDH services.

Figure 3-17 Networking diagram of the services on the two-fiber bidirectional MSP ring with
a non-protection chain
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3.10.2 Signal Flow and Timeslot Allocation
To configure the service on the MSP ring with a non-protection chain, you should plan a proper
traffic direction and a timeslot allocation scheme for the services on the SNCP ring and the
services on the non-protection chain.

Figure 3-18 shows the signal flow of the services on the MSP ring with a non-protection chain
and the timeslot allocation to the services on the MSP ring with a non-protection chain. In this
example, five E1 services are added to or dropped from NE3 and NE5, and these services pass
through NE4.
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On the MSP ring, the services from NE3 to NE4 in this example are transmitted on the short
path. In the actual configuration, you can plan other service paths according to the requirement.

NOTE

On a ring network, the long path and short path do not actually refer to the geographical distance. They are
determined by the number of intermediate NEs. As shown in Figure 3-18, when the service is transmitted
from NE3 to NE4, NE3→NE4 is the short path, and NE3→NE2→NE1→NE4 is the long path.

Figure 3-18 Signal flow and timeslot allocation
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3.10.3 Configuration Process
The configuration of the services on the two-fiber bidirectional MSP ring with a non-protection
chain is independent of the creation of the protection subnets for the MSP and for the non-
protection chain. To configure the services on the two-fiber bidirectional MSP ring with a non-
protection chain, configure the SDH services from the tributary board to the line board on the
source and sink NEs and configure pass-through services on the intermediate NEs, if the
protection subnet is already created.

Prerequisite
l The physical topology of the network must be created.

l The NEs, boards, and fibers must be created on the T2000.

l The created protection subnet must be consistent with the actual network topology. For
details about how to create the protection subnet, see 2.6.1 Configuring a Non-Protection
Chain and Creating an MS Ring Protection Subnet.

l You must be familiar with 3.10.2 Signal Flow and Timeslot Allocation.
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Procedure

Step 1 Configure the SDH services of the source NE (NE3).
1. In the NE Explorer, select NE3, and then choose  Configuration > SDH Service

Configuration from the Function Tree. Click .
2. Click Create on the lower-right pane to display the Create SNCP Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, the services are transmitted and
received on the same path. That is, the services are
Bidirectional services.

Source Slot 4-SP3D In this example, the SP3D board in slot 4 of NE3 is
configured as the source tributary board. See Figure
3-18.

Source
Timeslot Range
(e.g.1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the service source
occupies VC-12s 1–5.

Sink Slot 8-SL4D-1
(SDH-1)

In this example, the SL4D board in slot 8 of NE3 is
configured as the sink line board. See Figure 3-18.

Sink VC4 VC4-1 In this example, the service sink uses the timeslots of
VC4-1.

Sink Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the service sink
occupies VC-12s 1–5.

Activate
Immediately

Yes -

Step 2 Refer to Step 1 and configure the SDH services of NE5. Set the parameters as follows.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectional In this example, the services are transmitted and received
on the same path. That is, the services are Bidirectional
services.
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Parameter Value in
This
Example

Description

Source Slot 4-SP3D In this example, the SP3D board in slot 4 of NE5 is
configured as the source tributary board. See Figure
3-18.

Source Timeslot
Range(e.g.1,3-6)

1-5 In this example, five E1 services are configured between
NE3 and NE5. Hence, the service source occupies
VC-12s 1–5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 3 of NE5 is
configured as the sink line board. See Figure 3-18.

Sink VC4 VC4-1 In this example, the service sink uses the timeslots of
VC4-1.

Sink Timeslot
Range(e.g.1,3-6)

1-5 In this example, five E1 services are configured between
NE3 and NE5. Hence, the service sink occupies VC-12s
1–5.

Activate
Immediately

Yes -

Step 3 Configure the pass-through services of NE4.
1. In the NE Explorer, select NE4 and then choose  Communication > SDH Service

Configuration  from the Function Tree. Click .
2. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set

the parameters that are required, and then click OK.

Parameter Value in
This
Example

Description

Level VC12 In this example, E1 services are configured. Hence,
Level of the E1 services is set to VC12.

Direction Bidirectiona
l

In this example, the services are transmitted and
received on the same path. That is, the services are
Bidirectional services.

Source Slot 8-SL4D-2
(SDH-2)

In this example, the SL4D board in slot 8 of NE4 is
configured as the source line board. See Figure 3-18.

Source VC4 VC4-1 In this example, the service source uses the timeslots
of VC4-1.

Source
Timeslot Range
(e.g.1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the service sink
occupies VC-12s 1–5.

Sink Slot 3-SL1D-1
(SDH-1)

In this example, the SL1D board in slot 12 of NE5 is
configured as the sink line board. See Figure 3-18.
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Parameter Value in
This
Example

Description

Sink VC4 VC4-1 In this example, the service sink uses the timeslots of
VC4-1.

Sink Timeslot
Range(e.g.
1,3-6)

1-5 In this example, five E1 services are configured
between NE3 and NE5. Hence, the service sink
occupies VC-12s 1–5.

Activate
Immediately

Yes -

Step 4 Check whether the services are configured correctly. For details, see 7.6 Verifying the
Correctness of the SDH Service Configuration.

Step 5 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 6 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see Deleting SDH Services.
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4 Configuring Ethernet Services

About This Chapter

In compliance with ITU-T G.8011x/Y.1307x, Huawei MSTP equipment supports Ethernet
private line (EPL), Ethernet virtual private line (EVPL), Ethernet private local area network
(EPLAN), and Ethernet virtual private local area network (EVPLAN) services.

4.1 Service Types
In compliance with ITU-T G.8011x/Y.1307x, Huawei MSTP equipment supports Ethernet
private line (EPL), Ethernet virtual private line (EVPL), Ethernet private local area network
(EPLAN), and Ethernet virtual private local area network (EVPLAN) services.

4.2 Basic Concepts
Before you configure Ethernet boards with services, you need to learn the basic concepts
including external port, internal port, logical port, and bridge so that you can understand the
service configuration process and the signal flow when the boards process the services.

4.3 Flow of Configuring Ethernet Services
This topic describes the configuration processes related to Ethernet services. Before you
configure Ethernet services according to the flow, you need to complete the basic configurations
of the NEs according to the flow of creating a network.

4.4 Configuring EPL Services on an Ethernet Transparent Transmission Board
EPL services provide the point-to-point Ethernet transparent transmission solution with the
bandwidth exclusively occupied. EPL services are applicable when the communication
equipment that is used to access the client-side data in the transmission network does not support
VLANs or when the VLAN planning must be kept secret to the network operator.

4.5 Configuring EPL Services on an Ethernet Switching Board
EPL services provide the point-to-point Ethernet transparent transmission solution with the
bandwidth exclusively occupied. EPL services are applicable when the communication
equipment that is used to access the client-side data in the transmission network does not support
VLANs or when the VLAN planning must be kept secret to the network operator.

4.6 Configuring PORT-Shared EVPL (VLAN) Services
The PORT-shared EVPL (VLAN) service is applicable when the services of multiple users
received from the same external port on the Ethernet board at a station are transmitted on different
VCTRUNKs to another station or to another external port of the station.
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4.7 Configuring VCTRUNK-Shared EVPL (VLAN) Services
When the data of multiple users without VLAN tags sent to a transmission network is transmitted
on the same VCTRUNK, the VCTRUNK-shared EVPL (VLAN) service is used to isolate the
data by adding VLAN tags. In this way, the bandwidth is shared on the SDH side.

4.8 Configuring EPLAN Services (IEEE 802.1d Bridge)
The EPLAN service (IEEE 802.1d bridge) provides a LAN solution for multipoint-to-multipoint
convergence. This service applies where the user-side data communication equipment connected
to the transmission network does not support VLANs or where the VLAN planning is kept secret
from the network operator.

4.9 Configuring EVPLAN Services (IEEE 802.1q Bridge)
The EVPLAN service (IEEE 802.1q bridge) provides an LAN solution for multipoint-to-
multipoint convergence. This service applies in cases where user-side data communication
equipment connected to the transmission network does not support VLANs or where the VLAN
planning is open to the network operator.

4.10 Configuring EVPLAN Services (IEEE 802.1ad Bridge)
The QinQ technology provides a cheap and easy solution for Layer 2 virtual private networks
(VPNs). The IEEE 802.1ad bridge uses the QinQ technology to provide the VPN solution, thus
facilitating the identifying, differentiating and grooming EVPLAN services.
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4.1 Service Types
In compliance with ITU-T G.8011x/Y.1307x, Huawei MSTP equipment supports Ethernet
private line (EPL), Ethernet virtual private line (EVPL), Ethernet private local area network
(EPLAN), and Ethernet virtual private local area network (EVPLAN) services.

EPL Services

Two nodes are used to access EPL services and implement transparent transmission of the
Ethernet services of the users. The service of one user occupies one VCTRUNK and need not
share the bandwidth with the services of the other users. Hence, in the case of EPL services, a
bandwidth is exclusively occupied by the service of a user and the services of different users are
isolated. In addition, the extra QoS scheme and security scheme are not required.

Figure 4-1 EPL services

NE 1 NE2

User A1 User A2

User B1 User B2

Port1

Port2

VCTRUNK1

VCTRUNK2

Port1

Port2

 

The corresponding relations between the PORTs (namely, external ports) and the VCTRUNKs
are listed in Table 4-1.

Table 4-1 Corresponding relations between the external ports and the VCTRUNKs (EPL
services)

NE1 NE2

User A1 PORT1←→VCTRUNK1 VCTRUNK1←→PORT1 User A2

User B1 PORT2←→VCTRUNK2 VCTRUNK2←→PORT2 User B2

EVPL Services

In the case of EVPL services, services of different users share the bandwidth. Hence, the VLAN/
QinQ scheme needs to be used for differentiating the services of different users. If the services
of different users need to be configured with different quality levels, you need to adopt the
corresponding QoS scheme. EVPL services are classified into two types, depending on whether
the PORT or VCTRUNK is shared.
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l PORT-shared EVPL services

As shown in Figure 4-2, the services of different users are accessed through a PORT at a station,
and are then isolated from each other by using the VLAN IDs. Services are transmitted to other
PORTs at this station through different VCTRUNKs.

Figure 4-2 PORT-shared EVPL services

NE 1 NE2User C1

User  C2

User C3

Port1
VCTRUNK1

Port2
Port1

VCTRUNK2

VLAN 100

VLAN 200

 

The corresponding relations between the PORTs and the VCTRUNKs are provided in Table
4-2.

Table 4-2 Corresponding relations between the PORTs and the VCTRUNKs (PORT-shared
EVPL services)

NE1 NE2

User C1 PORT1←→VCTRUNK1 VCTRUNK1←→PORT1 User C2

PORT1←→VCTRUNK2 VCTRUNK2←→PORT2 User C3

l VCTRUNK-shared EVPL services Ethernet boards support the convergence and
distribution of EVPL services by using the following modes:
– VLAN tag-based convergence and distribution of EVPL services
– QinQ technology-based convergence and distribution of EVPL services

As shown in Figure 4-3, the services of different users are isolated by using the VLAN/QinQ
scheme. Hence, the services of different users can be transmitted in the same VCTRUNK.

Figure 4-3 VCTRUNK-shared EVPL services

NE 1 NE2

User D1 User D2

User E1 User E2

Port1

Port2

Port1

Port2
VCTRUNK1
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The corresponding relations between the PORTs and the VCTRUNKs are provided in Table
4-3.

Table 4-3 Corresponding relations between the PORTs and the VCTRUNKs (VCTRUNK-
shared EVPL services)

NE1 NE2

User D1 PORT1←→VCTRUNK1 VCTRUNK1←→PORT1 User D2

User E1 PORT2←→VCTRUNK1 VCTRUNK1←→PORT2 User E2

EPLAN Services
The EPLAN services can be accessed from a minimum of two nodes. Hence, the services of
different users need not share the bandwidth. That is, in the case of EPLAN services, a bandwidth
is exclusively occupied by the service of a user and the services of different users are isolated.
In addition, the extra QoS scheme and security scheme are not required. re is more than one
node. Hence, the nodes need to learn the MAC addresses and forward data according to MAC
addresses. Therefore, Layer 2 switching is realized.

As shown in Figure 4-4, three branches of user F need to communicate with each other. On
NE1, the IEEE 802.1d bridge is established to achieve EPLAN services. The IEEE 802.1d bridge
can create the MAC address-based forwarding table, which is periodically updated by using the
self-learning function of the system. The accessed data can be forwarded or broadcast within
the domain of the IEEE 802.1d bridge according to the destination MAC addresses.

Figure 4-4 EPLAN services (IEEE 802.1d bridge)

F1

PORT5

T2000
NE3

NE2

NE1

NE4

VCTRUNK

F3

PORT1

F2
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EVPLAN Services
EVPLAN services of different users need to share the bandwidth. Hence, the VLAN/QinQ
scheme needs to be used for differentiating the data of different users. If the services of different
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users need to be configured with different quality levels, you need to adopt the corresponding
QoS scheme.

As shown in Figure 4-5, three branches of user G need to communicate with each other. Services
of user G need to be isolated from the services of user H. Hence, the IEEE 802.1q bridge needs
to be established on NE1 to achieve EVPLAN services.

IEEE 802.1q bridge: IEEE 802.1q bridge supports isolation by using one layer of VLAN tags.
This bridge checks the contents of the VLAN tags that are in the data frames and performs Layer
2 switching according to the destination MAC addresses and VLAN IDs.

Figure 4-5 EVPLAN services (IEEE 802.1q bridge)
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As shown in Figure 4-6, the VoIP services from user M and the HSI services from user N need
to respectively access the VoiP server and the HSI server. In this case, the operator needs to
separately groom the VoIP services and HSI services, and isolate the data on the transmission
network side. On NE1, the IEEE 802.1ad bridge must be established to support the EVPLAN
services.

IEEE 802.1ad bridge: The IEEE 802.1ad bridge supports data frames with two layers of VLAN
tags. This bridge adopts the outer S-VLAN tags to isolate different VLANs and supports only
the mounted ports whose attributes are C-Aware or S-Aware. This bridge supports the following
switching modes:

l This bridge does not check the contents of the VLAN tags that are in the packets and
performs Layer 2 switching according to the destination MAC addresses of the packets.

l This bridge checks the contents of the VLAN tags that are in the packets and performs
Layer 2 switching according to the destination MAC addresses and the S-VLAN IDs of the
packets.
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Figure 4-6 EVPLAN services (IEEE 802.1ad bridge)
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4.2 Basic Concepts
Before you configure Ethernet boards with services, you need to learn the basic concepts
including external port, internal port, logical port, and bridge so that you can understand the
service configuration process and the signal flow when the boards process the services.

4.2.1 Formats of Ethernet Frames
To implement the VLAN and QinQ functions, the IEEE 802.1q and IEEE 802.1ad protocols
define different formats of the Ethernet frames, which contain different VLAN information.

4.2.2 Internal Ports and External Ports
External ports on Ethernet boards are used to access the services on the user side. Internal ports
on Ethernet boards are used to encapsulate and map the services to the transmission network for
transparent transmission.

4.2.3 Auto-Negotiation
The auto-negotiation function allows the network equipment to send information of its supported
working mode to the opposite end on the network and to receive the corresponding information
that the opposite end may transfer.

4.2.4 Flow Control
When the data processing/transferring capability of the equipment fails to handle the flow
received at the port, congestion occurs on the line. To reduce the number of discarded packets
due to buffer overflowing, proper flow control measures must be taken.

4.2.5 Encapsulation and Mapping Protocol
To ensure that Ethernet frames can be transparently transmitted over the optical transmission
network, the Ethernet frames need to be encapsulated and mapped into VC containers at the
access point. The encapsulation and mapping protocols used by the Ethernet service board
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include the high-level data link control (HDLC), link access procedure - SDH (LAPS), and
generic framing procedure (GFP).

4.2.6 Virtual Concatenation
The rate of the Ethernet service does not adapt to the rate of the standard VC container. Hence,
if you directly map the Ethernet service data into a standard VC container, there is a great waste
of the transmission bandwidth. To solve the problem, use the virtual concatenation technology
to concatenate many standard VC containers to a large VC container that adapts to the rate of
the Ethernet service.

4.2.1 Formats of Ethernet Frames
To implement the VLAN and QinQ functions, the IEEE 802.1q and IEEE 802.1ad protocols
define different formats of the Ethernet frames, which contain different VLAN information.

To implement the VLAN function, the IEEE 802.1q protocol defines the Ethernet frame format
that contains the VLAN information. Compared with the ordinary Ethernet frame, the frame
with the format defined by the IEEE 802.1q protocol is added with a four-byte header.

To implement VLAN mesting (QinQ), the IEEE 802.1ad protocol defines two VLAN tag types.
See Figure 4-7. The VLAN tag types are defined to differentiate the services on the client side
and the services on the supplier service side.

l The VLAN tag used on the client side is represented as C-VLAN, of which the frame format
is the same as the frame format defined by the IEEE 802.1q protocol.

l The VLAN tag used on the supplier service side is represented as S-VLAN.

Figure 4-7 Formats of Ethernet frames
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The length of the data field is variable. maximum length of the data field depends on the
maximum frame length that the ports of the equipment support.
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The four-byte S-VLAN or C-VLAN field is divided into two sub-fields: the tag protocol ID
(TPID) and the tag control Information (TCI).

Both the TPID and TCI consist of two bytes. See Figure 4-8.

Figure 4-8 Positions of the TPID and TCI in the frame structure
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l TPID structure

The TPID consists of two bytes and indicates the VLAN tag type. TPID of the C-VLAN is
always 0x8100 whereas the TPID of the S-VLAN can be customized. Refer to Table 4-4.

Table 4-4 Tag types defined by using the TPID

Tag Type Name Value

C-VLAN Tag 802.1q Tag Protocol Type 0x8100

S-VLAN Tag 802.1q Service Tag Type Customizable

NOTE

The IEEE 802.1ad specifies the TPID of the S-VLAN to 0x88a8. In actual application, the setting of TPID
for the S-VLAN tag varies according to the equipment manufacturer. To ensure compatibility between
interconnected equipment, it is recommended that you set the TPIDs of the S-VLAN tags of the
interconnected equipment to the same value within 0X600–FFFF.

l TCI structure

The TCI structure of the S-TAG is basically the same as the TCI structure of the C-TAG. VLAN
ID (VID) field consists of 12 bits and ranges from 0 to 4095. The difference is that the TCI of
the S-TAG contains the drop eligible (DE) indication and works with the priority code point
(PCP) to indicate the priority of the S-TAG frame.

The TCI structures of the C-TAG and S-TAG are shown in Figure 4-9 and Figure 4-10.

Figure 4-9 TCI structure of the C-TAG
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The TCI field of the C-TAG consists of the following bytes:
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l PCP: three bits

l CFI: one bit

Figure 4-10 TCI structure of the S-TAG

VID

Octets:

Bits:

PCP DE VID

1 2

8 6 5 4 1 8 1

 

The TCI field of the S-TAG consists of the following bytes:

l PCP: three bits

l DE: one bit

l VID: 12 bits

4.2.2 Internal Ports and External Ports
External ports on Ethernet boards are used to access the services on the user side. Internal ports
on Ethernet boards are used to encapsulate and map the services to the transmission network for
transparent transmission.

External ports on Ethernet boards (that is, external physical ports) are also referred to as client-
side ports or user-side ports, which are used to access the Ethernet services on the user side.

Internal ports on Ethernet boards (that is, internal VCTRUNKs) are also referred to as system-
side ports or backplane-side ports in certain cases, which are used to encapsulate and map the
services to the SDH side.

VCTRUNKs are VC-based transmission paths, which can be implemented by using the adjacent
concatenation or virtual concatenation technology. On the T2000 window, paths are bound to
specify the bandwidth of different granularities for a VCTRUNK port.

Figure 4-11 External ports and internal ports on Ethernet boards
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4.2.3 Auto-Negotiation
The auto-negotiation function allows the network equipment to send information of its supported
working mode to the opposite end on the network and to receive the corresponding information
that the opposite end may transfer.

The working modes of the interconnected ports on the equipment at both ends must be the same.
Otherwise, the services are affected.

If the working mode of the port on the opposite equipment is full duplex and if the working
mode of the port on the local equipment is auto-negotiation, the local equipment works in the
half-duplex mode. That is, the working modes of the interconnected ports at both ends are
different, and thus packets may be lost. Hence, when the working mode of the port on the opposite
equipment is full duplex, you need to set working mode of the port on the local equipment to
full duplex.

NOTE

When the interconnected ports at both sides work in the auto-negotiation mode, the equipment at both sides
can negotiate the flow control through the auto-negotiation function.

The auto-negotiation function uses fast link pulses (FLPs) and normal link pulses (NLPs) to
transfer information of the working mode so that no packet or upper layer protocol overhead
needs to be added.

NOTE

This topic considers FE electrical interfaces as an example to describe how to implement the auto-negotiation
function.

The FLP is called the 100BASE-T link integrity test pulse sequence. Each set of equipment on
the network must be capable of issuing FLP bursts in the case of power-on, issuing of
management commands, or user interaction. The FLP burst consists of a series of link integrity
test pulses that form an alternating clock/data sequence. Extraction of the data bits from the FLP
burst yields a link code word that identifies the working modes supported by the remote
equipment and certain information used for the negotiation and handshake mechanism.

To maintain interoperability with the existing 100BASE-T equipment, the auto-negotiation
function also supports the reception of 100BASE-T compliant link integrity test pulses. The
10BASE-T link pulse activity is referred to as the NLP sequence. equipment that fails to respond
to the FLP burst sequence by returning only the NLP sequence is treated as the 100BASE-T
compatible equipment.

The first pulse in an FLP burst is defined as a clock pulse. Clock pulses within an FLP burst
occur at intervals of 125 us. Data pulses occur in the middle of two adjacent clock pulses. The
positive pulse represents logic "1" and the absence of a pulse represents logic "0". An FLP burst
consists of 17 clock pulses and 16 data pulses (if all data bits are 1). The NLP waveform is
simpler than the FLP waveform. NLP sends a positive pulse every 16 ms when no data frame
needs to be transmitted.
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Figure 4-12 Waveform of a single FLP
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Figure 4-13 Consecutive FLP and NLP bursts
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4.2.4 Flow Control
When the data processing/transferring capability of the equipment fails to handle the flow
received at the port, congestion occurs on the line. To reduce the number of discarded packets
due to buffer overflowing, proper flow control measures must be taken.

The half-duplex Ethernet port applies the back-pressure mechanism to control the flow. The full-
duplex Ethernet port applies PAUSE frames to control the flow. Currently, the half-duplex
Ethernet function is not widely applied. Hence, the flow control function realized by Ethernet
service boards is used for the full-duplex Ethernet ports.

The flow control function realized by Ethernet service boards is classified into two types: auto-
negotiation flow control and non-auto-negotiation flow control.

Auto-Negotiation Flow Control
When the Ethernet port works in the auto-negotiation mode, you can adopt the auto-negotiation
flow control function. The auto-negotiation flow control modes include the following:
l Enable dissymmetric flow control
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The port can transmit PAUSE frames in the case of congestion but cannot process the
received PAUSE frames.

l Enable symmetric flow control
The port can transmit PAUSE frames and process the received PAUSE frames.

l Enable symmetric/dissymmetric flow control
The port has the following abilities:
– Transmits and processes PAUSE frames.

– Transmits PAUSE frames but cannot process the received PAUSE frames.

– Processes the received PAUSE frames but cannot transmit PAUSE frames.

l Disable
Disables the auto-negotiation flow control function.

Non-Auto-Negotiation Flow Control
When the Ethernet port works in a fixed working mode, you can adopt the non-auto-negotiation
flow control function. The non-auto-negotiation flow control modes include the following:
l Send only

The port can transmit PAUSE frames in the case of congestion but cannot process the
received PAUSE frames.

l Receive only
The port can process the received PAUSE frames but cannot transmit PAUSE frames in
the case of congestion.

l Send and receive
The port can transmit PAUSE frames and process the received PAUSE frames.

l Disable
The port does not support the auto-negotiation flow control function.

Realization Principle
The realization principle of the flow control function is described as follows:

1. When congestion occurs in the receive queue of an Ethernet port (the data in the receive
buffer exceeding a certain threshold) and the port is capable of sending PAUSE frames,
the port sends a PAUSE frame to the opposite end. pause-time value in the frame is N
(0<N≤65535).

2. If the Ethernet port at the opposite end is capable of processing PAUSE frames, this Ethernet
port stops sending data within a specified period of time N (the unit is the time needed for
sending 521 bits) after receiving the PAUSE frame.

3. If the congestion at the receive port is cleared (the data in the receive buffer is below a
certain threshold) but the pause-time does not end, the port sends a PAUSE frame whose
pause-time is 0 to notify the opposite end to send data.

IEEE 802.3 defines the format of the PAUSE frame as follows:

l Destination address: 01-80-C2-00-00-01 (multicast address)

l Source address: MAC address of the source port

l Type/Length: 88-08 (MAC control frame)
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l MAC control code: 00-01 (PAUSE frame)

l MAC control parameter: pause-time (two bytes)

Figure 4-14 Structure of the PAUSE frame
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4.2.5 Encapsulation and Mapping Protocol
To ensure that Ethernet frames can be transparently transmitted over the optical transmission
network, the Ethernet frames need to be encapsulated and mapped into VC containers at the
access point. The encapsulation and mapping protocols used by the Ethernet service board
include the high-level data link control (HDLC), link access procedure - SDH (LAPS), and
generic framing procedure (GFP).

HDLC
The HDLC is a general data link control procedure. When using the HDLC protocol, the system
encapsulates data services into HDLC-like frames as information bits and maps the frames into
SDH VC containers.

LAPS
The LAPS is also a data link control procedure. It is optimized based on the HDLC. The LAPS
complies with ITU-T X.86.

GFP
The GFP is the most widely applied general encapsulation and mapping protocol. It provides a
general mechanism to adapt higher-layer client signal flows into the transport network and can
map the variable-length payload into the byte-synchronized transport path. The client signals
can be protocol data units (PDU-oriented, such as IP/PPP and Ethernet), block code data (block-
code oriented, such as Fiber Channel and ESCON), or common bit data streams. The GFP
protocol complies with ITU-T G.7041.

The GFP defines the following modes to adapt client signals:

l Frame-mapped GFP (GFP-F)
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The GFP-F is a PDU-oriented processing mode. It encapsulates the entire PDU into the
GFP payload area and makes no modification on the encapsulated data. It determines
whether to add a detection area for the payload area, depending on requirements.

l Transparent GFP (GFG-T)
The GFP-T is a block-code (8B/10B code block) oriented processing mode. It extracts a
single character from the received data block and maps the character into the fixed-length
GFP frame.

4.2.6 Virtual Concatenation
The rate of the Ethernet service does not adapt to the rate of the standard VC container. Hence,
if you directly map the Ethernet service data into a standard VC container, there is a great waste
of the transmission bandwidth. To solve the problem, use the virtual concatenation technology
to concatenate many standard VC containers to a large VC container that adapts to the rate of
the Ethernet service.

The concatenation is defined in ITU-T G.707 and contains contiguous concatenation and virtual
concatenation. Both concatenation methods provide concatenated bandwidth of X times
Container-N at the path termination.

Contiguous concatenation concatenates the contiguous VC-4s in the same STM-N into an entire
structure to transport. It maintains the contiguous bandwidth throughout the whole transport.
Virtual concatenation concatenates many individual VC containers (VC-12 containers, VC-3
containers, or VC-4 containers) into a bit virtual structure to transport. The virtual concatenation
breaks the contiguous bandwidth into individual VCs, transports the individual VCs, and
recombines these VCs to a contiguous bandwidth at the transmission termination point.

In the case of virtual concatenation, transport of each VC container may occupy different paths
and there may be a transport delay difference between VC containers. Hence, there are
difficulties to restore the client signal. Virtual concatenation requires concatenation functionality
only at the path termination equipment and it can flexibly allocate bandwidth. Hence, the virtual
concatenation technology is widely used.

Virtual concatenation is available in two types: virtual concatenation in a higher order path and
virtual concatenation in a lower order path. A higher order virtual concatenation VC4-Xv
provides a payload of X Container-4s (VC-4s). The payload is mapped individually into X
independent VC-4s. Each VC-4 has its own POH. A lower order virtual concatenation VC-12-
Xv provides a payload of X Container-12s (VC-12s). The payload is mapped individually into
X independent VC-12s. Each VC-12 has its own POH. It is the same case with the virtual
concatenation of VC-3s.

VC4-Xv and VC-3-Xv
The virtual container that is formed by a VC4-Xv/VC-3-Xv can be mapped into X individual
VC-4/VC-3s that form the VC4-Xv/VC-3-Xv. Each VC-4/VC-3 has its own POH. POH has the
same specifications as the ordinary VC-4 POH. The H4 byte in the POH is used for the virtual
concatenation-specific multiframe indicator (MFI) and sequence indicator (SQ).

MFI indicates the position of a frame in the multiframe. Each frame sent by the source carries
the MFI information. The sink end combines the frames with the same MFI into the C-n-Xv.
MFI includes MFI-1 and MFI-2. MFI-1 is transmitted by bits 5–8 of the H4 byte and ranges
from 0 to 15. MFI-2 is transmitted by the two frames of which the MFI-1 is "0" and "1" in the
multiframe. Bits 1–4 of the H4 bytes of the two frames indicate the higher four bits and lower
four bits of the MFI-2 respectively. Hence, the MFI-2 ranges from 0 to 255. That is, a multiframe
consists of 4096 frames and the period is 512 ms.
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SQ indicates the position of a frame in the C-n-Xv. The source end inserts the SQ information
into the frame according to the payload allocation sequence. The sink end determines the
sequence to extract the payload from the frames that form C-n-Xv according to the SQ. SQ is
transmitted by the two frames of which the MFI-1 is "14" and "15" in the multiframe. Bits 1–4
of the H4 bytes of the two frames indicate the higher four bits and lower four bits of the SQ
respectively.

Figure 4-15 VC-3-Xv/VC4-Xv multiframe and sequence indicator
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With the MFI and SQ, the sink end can correctly restore the position of each frame in the C-n-
Xv to prevent the frame alignment problem due to the different propagation delays of the frames.

 

VC-12-Xv

The virtual container that is formed by a VC-12-Xv can be mapped into X individual VC-12s
which form the VC-12-Xv. Each VC-12 has its own POH. POH has the same specifications as
the ordinary VC-12 POH. Bit 2 of the K4 byte in the POH is used for the virtual concatenation-
specific frame count and sequence indicator.

Bit2s of the K4 bytes in every 32 multiframes (one multiframe comprising four VC-12s) are
extracted to form a 32-bit character string to express the frame count and sequence indicator.
Bits 1–5 of the string express the frame count, whose value range is between 0 and 31. structure
formed by 32 multiframes has 128 frames. Hence, the resulting overall multiframe is 4096 frames
with the period of 512 ms. Bits 6–11 of the string express the sequence indicator. The frame
count/sequence indicator in the VC-12-Xv has the same usage as the multiframe indicator/
sequence indicator in the VC4-Xv/VC-3-Xv.

4 Configuring Ethernet Services

OptiX OSN 500 STM-1/STM-4 Multi-Service CPE Optical
Transmission System
Configuration Guide

4-16 Huawei Proprietary and Confidential
Copyright © Huawei Technologies Co., Ltd.

Issue 01 (2009-01-20)



4.3 Flow of Configuring Ethernet Services
This topic describes the configuration processes related to Ethernet services. Before you
configure Ethernet services according to the flow, you need to complete the basic configurations
of the NEs according to the flow of creating a network.

4.3.1 Flow of Configuring EPL Services
The EPL services feature simplicity, transparent transmission, and dedicated bandwidth. The
configuration flow differs depending on whether Ethernet transparent transmission boards or
Ethernet switching boards are configured.

4.3.2 Flow of Configuring EVPL Services
In the case of EVPL services, services of different users share the bandwidth. Hence, the VLAN
ID or other schemes need to be used for differentiating the services of different users. If the
services of different users need to be configured with different quality levels, you need to adopt
the corresponding QoS scheme.

4.3.3 Flow of Configuring EPLAN Services
EPLAN services provide the customers with Layer 2 switching-based multipoint-connected
LAN services.

4.3.4 Flow of Configuring EVPLAN Services
EVPLAN services of different users need to share the bandwidth. Hence, the VLAN ID or other
schemes need to be used for differentiating the services of different users. If the services of
different users need to be configured with different quality levels, you need to adopt the
corresponding QoS scheme.

4.3.1 Flow of Configuring EPL Services
The EPL services feature simplicity, transparent transmission, and dedicated bandwidth. The
configuration flow differs depending on whether Ethernet transparent transmission boards or
Ethernet switching boards are configured.

Ethernet transparent transmission boards or Ethernet switching boards can be used to configure
EPL services. The Ethernet transparent transmission boards and Ethernet switching boards are
provided in Table 8-1.
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Figure 4-16 Flow of configuring EPL services
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Table 4-5 Flow of configuring EPL services

Step Operation Remarks

1 7.7 Configuring External Ports on Ethernet
Boards

Required
When an NE accesses Ethernet services through the
external ports on the Ethernet board, you need to
configure the attributes of the external ports so that
the external ports can work with the data
communication equipment on the client side, thus
ensuring the normal accessing of the Ethernet
services.

2 7.8 Configuring Internal Ports on Ethernet
Boards

Required
When an NE transmits Ethernet services through
the internal ports (that is, VCTRUNK ports) on the
Ethernet board to the SDH side, you need to
configure the attributes of the VCTRUNK ports so
that the VCTRUNK ports can work with the
Ethernet board on the opposite equipment. This
ensures that the transmission of the Ethernet
services in the SDH network is normal.

3 7.10 Creating EPL Services l If Ethernet transparent transmission boards are
used, skip to Step 4. On Ethernet transparent
transmission boards, the EPL service
connections from the PORTs to the VCTRUNKs
are considered to be created by default.

l If Ethernet switching boards are used, the EPL
service connections between the PORTs and the
VCTRUNKs must be created.

4 7.1 Creating SDH Services Required
This topic describes how to create the timeslot
connections between the bound paths and the line
board, thus ensuring that the Ethernet services are
transmitted in specified timeslots over the
transmission line.

5 7.15 Testing Ethernet Service Channels Required
After the Ethernet services are created, test the
service continuity.

6 7.5 Setting Performance Monitoring
Parameters of an NE

Required
Enable the performance monitoring function for a
specific NE. Then, you can obtain detailed
performance records during the operation process
of this NE. These records can be used for
monitoring and analyzing the running status of this
NE.
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Step Operation Remarks

7 7.16 Backing Up the NE Database to the SCC
Board

Required
Back up the NE database to ensure that the NE can
be automatically recovered to normal operation
after the SCC data is lost or after the equipment is
powered off.

4.3.2 Flow of Configuring EVPL Services
In the case of EVPL services, services of different users share the bandwidth. Hence, the VLAN
ID or other schemes need to be used for differentiating the services of different users. If the
services of different users need to be configured with different quality levels, you need to adopt
the corresponding QoS scheme.

The Ethernet switching boards are required for configuring EVPL services. The Ethernet
switching boards that support EVPL services are provided in Table 8-1.

Figure 4-17 Flow of configuring EVPL services
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Table 4-6 Flow of configuring EVPL services

Step Operation Remarks

1 7.7 Configuring External Ports on Ethernet Boards Required
When an NE accesses Ethernet services
through the external ports on the Ethernet
board, you need to configure the attributes of
the external ports so that the external ports
can work with the data communication
equipment on the client side, thus ensuring
the normal accessing of the Ethernet
services.

2 7.8 Configuring Internal Ports on Ethernet Boards Required
When an NE transmits Ethernet services
through the internal ports (that is,
VCTRUNK ports) on the Ethernet board to
the SDH side, you need to configure the
attributes of the VCTRUNK ports so that the
VCTRUNK ports can work with the Ethernet
board on the opposite equipment. This
ensures that the transmission of the Ethernet
services in the SDH network is normal.

3 7.10 Creating EPL Services Required
When an Ethernet switching board carries
private line services, the relevant information
of the private line services, such as the
service source and service sink, must be
specified.

4 7.1 Creating SDH Services Required
This topic describes how to create the
timeslot connections between the bound
paths and the line board, thus ensuring that
the Ethernet services are transmitted in
specified timeslots over the transmission
line.

5 Configuring QoS Optional
The services of different users need to share
the bandwidth. If the services of different
users need to be configured with different
quality levels, you need to adopt the
corresponding QoS scheme.

6 7.15 Testing Ethernet Service Channels Required
After the Ethernet services are created, test
the service continuity.
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Step Operation Remarks

7 7.5 Setting Performance Monitoring Parameters of
an NE

Required
Enable the performance monitoring function
for a specific NE. Then, you can obtain
detailed performance records during the
operation process of this NE. These records
can be used for monitoring and analyzing the
running status of this NE.

8 7.16 Backing Up the NE Database to the SCC Board Required
Back up the NE database to ensure that the
NE can be automatically recovered to normal
operation after the SCC data is lost or after
the equipment is powered off.

4.3.3 Flow of Configuring EPLAN Services
EPLAN services provide the customers with Layer 2 switching-based multipoint-connected
LAN services.

The Ethernet switching boards are required for configuring EPLAN services. The Ethernet
switching boards that support EPLAN services are provided in Table 8-1.
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Figure 4-18 Flow of configuring EPLAN services
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Table 4-7 Flow of configuring EPLAN services

Step Operation Remarks

1 7.7 Configuring External Ports on Ethernet Boards Required
When an NE accesses Ethernet services
through the external ports on the Ethernet
board, you need to configure the attributes of
the external ports so that the external ports can
work with the data communication
equipment on the client side, thus ensuring
the normal accessing of the Ethernet services.
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Step Operation Remarks

2 7.8 Configuring Internal Ports on Ethernet Boards Required
When an NE transmits Ethernet services
through the internal ports (that is, VCTRUNK
ports) on the Ethernet board to the SDH side,
you need to configure the attributes of the
VCTRUNK ports so that the VCTRUNK
ports can work with the Ethernet board on the
opposite equipment. This ensures that the
transmission of the Ethernet services in the
SDH network is normal.

3 7.11 Creating Ethernet LAN Services Required
When an Ethernet switching board carries
LAN services, you need to create the bridge
and set the attributes of the bridge and the port
mounted to the bridge.

4 Modifying Ports Mounted to the Bridge Optional
In the case of Ethernet LAN services, you can
modify the Hub/Spoke attribute between
access nodes from the default value of Hub to
Spoke, thus disabling the communication
between the access nodes; however, the
communication between the access nodes and
the convergence node is not disabled.

5 7.1 Creating SDH Services Required
This topic describes how to create the
timeslot connections between the bound
paths and the line board, thus ensuring that
the Ethernet services are transmitted in
specified timeslots over the transmission line.
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Step Operation Remarks

6 Configuring the Layer 2 switching feature
l Creating MAC Address Entries

l Modifying Aging Time of MAC Addresses

l Configuring the Spanning Tree

Optional
l You can manually specify the port for

forwarding the MAC frames to create the
VLAN unicast entries and you can
suppress the forwarding of certain MAC
frames to create the MAC address disabled
entries. The manually created MAC entries
are not affected by the aging time.

l The aging time of the dynamic MAC
address entries of an Ethernet switching
board is five minutes by default. You can
modify the aging time according to the
actual requirements.

l There may be loops in the network
topology of Ethernet services. Hence, the
STP/RSTP protocol is enabled to prevent
packets from being proliferated and
endlessly cycled in the loop network.

7 7.15 Testing Ethernet Service Channels Required
After the Ethernet services are created, test
the service continuity.

8 7.5 Setting Performance Monitoring Parameters of
an NE

Required
Enable the performance monitoring function
for a specific NE. Then, you can obtain
detailed performance records during the
operation process of this NE. These records
can be used for monitoring and analyzing the
running status of this NE.

9 7.16 Backing Up the NE Database to the SCC Board Required
Back up the NE database to ensure that the
NE can be automatically recovered to normal
operation after the SCC data is lost or after
the equipment is powered off.

4.3.4 Flow of Configuring EVPLAN Services
EVPLAN services of different users need to share the bandwidth. Hence, the VLAN ID or other
schemes need to be used for differentiating the services of different users. If the services of
different users need to be configured with different quality levels, you need to adopt the
corresponding QoS scheme.

The Ethernet switching boards are required for configuring EVPLAN services. The Ethernet
switching boards that support EVPLAN services are provided in Table 8-1.
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Figure 4-19 Flow of configuring EVPLAN services
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Table 4-8 Flow of configuring EVPLAN services

Step Operation Remarks

1 7.7 Configuring External Ports on Ethernet
Boards

Required
When an NE accesses Ethernet services through
the external ports on the Ethernet board, you need
to configure the attributes of the external ports so
that the external ports can work with the data
communication equipment on the client side, thus
ensuring the normal accessing of the Ethernet
services.

2 7.8 Configuring Internal Ports on Ethernet
Boards

Required
When an NE transmits Ethernet services through
the internal ports (that is, VCTRUNK ports) on the
Ethernet board to the SDH side, you need to
configure the attributes of the VCTRUNK ports so
that the VCTRUNK ports can work with the
Ethernet board on the opposite equipment. This
ensures that the transmission of the Ethernet
services in the SDH network is normal.

3 7.11 Creating Ethernet LAN Services Required
When an Ethernet switching board carries LAN
services, you need to create the bridge and set the
attributes of the bridge and the port mounted to the
bridge.

4 Creating VLAN Filtering Table Required
In the case of Ethernet LAN services, when the
type of the bridge is IEEE 802.1q or IEEE 802.1ad,
the VLAN filtering table needs to be created for
the bridge if VLANs are used to isolate the data of
different users.

5 Modifying Ports Mounted to the Bridge Optional
In the case of Ethernet LAN services, you can
modify the Hub/Spoke attribute between access
nodes from the default value of Hub to Spoke, thus
disabling the communication between the access
nodes; however, the communication between the
access nodes and the convergence node is not
disabled.

6 7.1 Creating SDH Services Required
This topic describes how to create the timeslot
connections between the bound paths and the line
board, thus ensuring that the Ethernet services are
transmitted in specified timeslots over the
transmission line.
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Step Operation Remarks

7 Configuring the Layer 2 switching feature
l Creating MAC Address Entries

l Modifying Aging Time of MAC Addresses

l Configuring the Spanning Tree

l Enabling the IGMP Snooping Protocol

l You can manually specify the port for
forwarding the MAC frames to create the
VLAN unicast entries and you can suppress the
forwarding of certain MAC frames to create the
MAC address disabled entries. The manually
created MAC entries are not affected by the
aging time.

l The aging time of the dynamic MAC address
entries of an Ethernet switching board is five
minutes by default. You can modify the aging
time according to the actual requirements.

l There may be loops in the network topology of
Ethernet services. Hence, the STP/RSTP
protocol is enabled to prevent packets from
being proliferated and endlessly cycled in the
loop network.

l When a multicast router is located on the
network, the IEEE 802.1q or IEEE 802.1ad
bridge can enable the IGMP Snooping protocol
to work with the router, thus implementing the
multicast function.

8 Configuring QoS Optional
The services of different users need to share the
bandwidth. If the services of different users need
to be configured with different quality levels, you
need to adopt the corresponding QoS scheme.

9 7.15 Testing Ethernet Service Channels Required
After the Ethernet services are created, test the
service continuity.

10 7.5 Setting Performance Monitoring
Parameters of an NE

Required
Enable the performance monitoring function for a
specific NE. Then, you can obtain detailed
performance records during the operation process
of this NE. These records can be used for
monitoring and analyzing the running status of this
NE.

11 7.16 Backing Up the NE Database to the SCC
Board

Required
Back up the NE database to ensure that the NE can
be automatically recovered to normal operation
after the SCC data is lost or after the equipment is
powered off.
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4.4 Configuring EPL Services on an Ethernet Transparent
Transmission Board

EPL services provide the point-to-point Ethernet transparent transmission solution with the
bandwidth exclusively occupied. EPL services are applicable when the communication
equipment that is used to access the client-side data in the transmission network does not support
VLANs or when the VLAN planning must be kept secret to the network operator.

4.4.1 Networking Diagram
The completely isolated data services of two users at a station must be transported to another
station.

4.4.2 Signal Flow and Timeslot Allocation
Ethernet services are received from an external port, encapsulated through an internal port, and
mapped to the SDH network for transparent transmission. In this way, the node communicates
with a remote node.

4.4.3 Configuration Process
The Ethernet transparent transmission boards support only EPL services. The EPL are already
created by default and hence you need not configure the Ethernet transparent transmission boards
on the T2000.

4.4.1 Networking Diagram
The completely isolated data services of two users at a station must be transported to another
station.

Service Requirement
In the network as shown in Figure 4-20, the service requirements are as follows:

l The two branches of user A that are located at NE1 and NE3 need to communicate with
each other over Ethernet. A 10 Mbit/s bandwidth is required.

l The two branches of user B that are located at NE1 and NE3 need to communicate with
each other over Ethernet. A 20 Mbit/s bandwidth is required.

l The services of user A must be isolated from the services of user B.

l The Ethernet equipment of user A and user B provides 100 Mbit/s Ethernet ports of which
the working mode is auto-negotiation, and does not support VLANs.
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Figure 4-20 Networking diagram of the EPL services
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Board Configuration Information

Ethernet transparent transmission boards or Ethernet switching boards can be used for
configuring EPL services. In this example, NE1 and NE3 are configured with one ISU board
respectively. The ISU board integrates the SCC unit, cross-connect unit, clock unit, tributary
unit, line unit, and data transparent transmission unit. The Ethernet unit of the ISU board is
displayed as the EFT8 on the T2000, which occupies logical slot 7. The STM-4 optical module
of the ISU board is displayed as the SL4D board on the T2000, which occupies logical slot 8.

In this example, NE1 and NE3 are each configured with one EFT8 board, which is an Ethernet
transparent transmission board.

NOTE
As provided in Table 8-1, the Ethernet boards are classified into the Ethernet transparent transmission
boards and Ethernet switching boards, based on the type of the accessed service. The transparent
transmission boards support only EPL services whereas the Ethernet switching boards support EPL
services, EVPL services, and Layer 2 switching.

4.4.2 Signal Flow and Timeslot Allocation
Ethernet services are received from an external port, encapsulated through an internal port, and
mapped to the SDH network for transparent transmission. In this way, the node communicates
with a remote node.

Figure 4-21 shows the signal flow and timeslot allocation of the EPL services.
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For the method of calculating the bandwidth of the Ethernet services carried by a VCTRUNK,
see 8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of Ethernet Boards.

Figure 4-21 Signal flow and timeslot allocation (Ethernet transparent transmission board)

NOTE

The ISU board integrates the SCC unit, cross-connect unit, clock unit, tributary unit, line unit, and data
transparent transmission unit. The Ethernet unit of the ISU board is displayed as the EFT8 board on the
T2000.
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l The EPL services of user A:

– Occupy the first to fifth VC-12 timeslots of the first VC-4 (VC4-1:VC12:1-5) on the
SDH link between NE1 and NE3 and pass through NE2.

– Are added and dropped by using the first to fifth VC-12 timeslots of the fourth VC-4
(VC4-4:VC12:1-5) on the EFT8 board of NE1 and the first to fifth VC-12 timeslots of
the fourth VC-4 (VC4-4:VC12:1-5) on the EFT8 board of NE3.

l The EPL services of user B:
– Occupy the sixth to fifteenth VC-12 timeslots of the first VC-4 (VC4-1:VC12:6-15) on

the SDH link between NE1 and NE3 and pass through NE2.
– Are added and dropped by using the sixth to fifteenth VC-12 timeslots of the fourth

VC-4 (VC4-4:VC12:6-15) on the EFT8 board of NE1 and the sixth to fifteenth VC-12
timeslots of the fourth VC-4 (VC4-4:VC12:6-15) on the EFT8 board of NE3.

Table 4-9 Parameters of external ports on the Ethernet boards

Parameter NE1 NE3

Board EFT8 EFT8

Port PORT1 PORT2 PORT1 PORT2

Enabled/
Disabled

Enabled Enabled Enabled Enabled

Working Mode Auto-
Negotiation

Auto-
Negotiation

Auto-
Negotiation

Auto-
Negotiation

Maximum
Frame Length

1522 1522 1522 1522
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Table 4-10 Parameters of internal ports on the Ethernet boards

Parameter NE1 NE3

Board EFT8 EFT8

Internal Port VCTRUNK1 VCTRUNK2 VCTRUNK1 VCTRUNK2

Mapping
Protocol

GFP GFP GFP GFP

Bound Path VC4-4:VC12-1
–VC12-5

VC4-4:VC12-6
–VC12-15

VC4-4:VC12-1
–VC12-5

VC4-4:VC12-6
–VC12-15

4.4.3 Configuration Process
The Ethernet transparent transmission boards support only EPL services. The EPL are already
created by default and hence you need not configure the Ethernet transparent transmission boards
on the T2000.

Prerequisite
You must be familiar with 4.3.1 Flow of Configuring EPL Services.

Background Information
By default, EPL service connections from external ports to internal ports are already created for
Ethernet transparent transmission boards. The EPL service connections can be queried on the
T2000, but cannot be created, modified, or deleted on the T2000.

If the Ethernet transparent transmission boards in the actual application scenarios are different
from the boards in this example, you need to learn about the requirements for configuring specific
boards.

l For the EPL services supported by Ethernet transparent transmission boards, see 8.1
Service Support Capability of Ethernet Boards.

l For the VCTRUNK binding requirements of Ethernet transparent transmission boards, see
8.2 Requirements for Binding Paths with VCTRUNKs on Ethernet Boards.

Procedure

Step 1 Configure the EPL services of user A1 and user B1 on NE1.
1. Set the attributes of the external ports (PORT1 and PORT2 of the EFT8 board) used by the

services of user A1 and user B1.
l In the NE Explorer, select the EFT8 and then choose  Configuration > Ethernet

Interface Management > Ethernet Interface from the Function Tree.
l Select External Port.

l Click the Basic Attributes tab. After setting the parameters, click Apply.
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Parame
ter

Value in This Example Description

Enabled
/
Disable
d

PORT1: Enabled
PORT2: Enabled

PORT1 is used by the service of user A1.
PORT2 is used by the service of user B1. In
this example, Enabled/Disabled is set to
Enabled for PORT1 and PORT2.

Workin
g Mode

PORT1: Auto-
Negotiation
PORT2: Auto-
Negotiation

In this example, the Ethernet service access
equipment of user A1 and user B1 supports
the auto-negotiation mode. Hence, Working
Mode is set to Auto-Negotiation for PORT1
and PORT2.

Maximu
m
Frame
Length

PORT1: 1522
PORT2: 1522

Generally, this parameter adopts the default
value 1522.

MAC
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The MAC loopback setting is used for fault
diagnosis. In this example, MAC
Loopback is set to Non-Loopback.

PHY
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The PHY loopback setting is used for fault
diagnosis. In this example, PHY Loopback
is set to Non-Loopback.

2. Set the attributes of the internal ports (VCTRUNK1 and VCTRUNK2 of the EFT8 board)
used by the services of user A1 and user B1.
l Select Internal Port.

l Click the Encapsulation/Mapping tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Mappin
g
Protocol

VCTRUNK1: GFP
VCTRUNK2: GFP

In this example, the EFS8 board is used. This
parameter adopts the default value GFP.
Mapping Protocol of the VCTRUNKs on
the Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Scrambl
e

VCTRUNK1:
Scrambling mode [X43
+1]
VCTRUNK2:
Scrambling mode [X43
+1]

In this example, this parameter adopts the
default value Scrambling mode [X43+1].
Scramble of the VCTRUNKs on the
Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Check
Field
Length

VCTRUNK1: FCS32
VCTRUNK2: FCS32

In this example, this parameter adopts the
default value FCS32. Check Field Length
of the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.
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Parame
ter

Value in This Example Description

FCS
Calculat
ed Bit
Sequenc
e

VCTRUNK1: Big endian
VCTRUNK2: Big endian

When Mapping Protocol is set to GFP, FCS
Calculated Bit Sequence is set to Big
endian. FCS Calculated Bit Sequence of
the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

Extensi
on
Header
Option

VCTRUNK1: No
VCTRUNK2: No

When Mapping Protocol is set to GFP, this
parameter is valid and adopts the default
value No. Extension Header Option of the
VCTRUNKs on the Ethernet boards of the
interconnected equipment at both ends must
be set to the same value.

l Click the Bound Path tab. Click the Configuration button. Set the following
parameters in the Bound Path Configuration dialog box that is displayed. Then, click
Apply.

User Parameter Value in
This
Example

Description

User
A1←
→user
A2

Configurab
le Ports

VCTRUN
K1

As shown in Figure 4-21, VCTRUNK1 is
used by the service between user A1 and user
A2.

Avai
lable
Bou
nd
Path
s

Lev
el

VC12-xv The service between user A1 and user A2 uses
a 10 Mbit/s bandwidth. Hence, five VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.

Ser
vice
Dir
ecti
on

Bidirection
al

The service between user A1 and user A2 is a
bidirectional service.

Av
aila
ble
Res
our
ces

VC4-4 For the resources used by the specific boards,
see 8.2 Requirements for Binding Paths
with VCTRUNKs on Ethernet Boards.
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User Parameter Value in
This
Example

Description

Av
aila
ble
Ti
mes
lots

VC12-1 to
VC12-5

Five VC-12s need to be bound for the service
from user A1 to user A2. In this example, the
first to the fifth VC-12 need to be selected in
sequence.

User
B1←
→user
B2

Configurab
le Ports

VCTRUN
K2

As shown in Figure 4-21, VCTRUNK2 is
used by the service between user B1 and user
B2.

Avai
lable
Bou
nd
Path
s

Lev
el

VC12-xv The service between user B1 and user B2 uses
a 20 Mbit/s bandwidth. Hence, 10 VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.

Ser
vice
Dir
ecti
on

Bidirection
al

The service between user B1 and user B2 is a
bidirectional service.

Av
aila
ble
Res
our
ces

VC4-4 For the resources used by the specific boards,
see 8.2 Requirements for Binding Paths
with VCTRUNKs on Ethernet Boards.

Av
aila
ble
Ti
mes
lots

VC12-6 to
VC12-15

Ten VC-12s need to be bound for the service
from user B1 to user B2. In this example, the
sixth to the fifteenth VC-12 need to be selected
in sequence.

3. Configure the cross-connections from the Ethernet services to the SDH links for user A1
and user B1.
l In the NE Explorer, select NE1 and then choose  Configuration > SDH Service

Configuration from the Function Tree.
l Click Create on the lower-right pane to display the Create SDH Service dialog box.

Set the parameters as follows.
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User Paramete
r

Value in
This
Example

Description

User A1 Level VC12 The timeslot bound with the service of user
A1 is at the VC-12 level. The service level
must be consistent with the level of the path
bound with the VCTRUNK.

Service
Direction

Bidirectiona
l

The service of user A1 is a bidirectional
service.

Source Slot 7-EFT8 When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the source timeslot is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK1. In this
example, the value range of Available
Timeslots is from VC12-1 to VC12-5.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the sink timeslot can be
the same as or different from the value
range of the source timeslot. The number of
source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are five
VC-12s, the sink timeslots must be five
VC-12s.

Activate
Immediatel
y

Yes -

User B1 Level VC12 The timeslot bound with the service of user
B1 is at the VC-12 level. The service level
must be consistent with the level of the path
bound with the VCTRUNK.

Service
Direction

Bidirectiona
l

The service of user B1 is a bidirectional
service.
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User Paramete
r

Value in
This
Example

Description

Source Slot 7-EFT8 When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
Timeslot
Range(e.g.
1,3-6)

6-15 The value range of the source timeslot is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK2. In this
example, the value range of Available
Timeslots is from VC12-6 to VC12-15.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

6-15 The value range of the sink timeslot can be
the same as or different from the value
range of the source timeslot. The number of
source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are 10
VC-12s, the sink timeslots must be 10
VC-12s.

Activate
Immediatel
y

Yes -

Step 2 Configure the pass-through services of user A1 and user B1 on NE2.

1. Click . Select NE2 in the Navigation Tree that is displayed. Then, click OK.
2. In the NE Explorer, select NE2 and then choose  Configuration > SDH Service

Configuration from the Function Tree.
3. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set

the parameters as follows.

Parameter Value in
This
Example

Description

Level VC12 The SDH service of NE1, which passes through NE2, is
at the VC-12 level.
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Parameter Value in
This
Example

Description

Service
Direction

Bidirectional As shown in Figure 4-21, the SDH service from NE1 to
NE2 is a bidirectional service.

Source Slot 8-SL4D-1
(SDH-1)

As shown in Figure 4-21, the service signals are
transmitted from 8-SL4D-1(SDH-1) to 8-SL4D-2
(SDH-2). In this example, Source Slot is set to 8-SL4D-1
(SDH-1).

Source
VC4

VC4-1 VC4-1 is allocated to the service from NE1 to NE2.

Source
Timeslot
Range(e.g.
1,3-6)

1-15 The service between user A1 and user B1 uses timeslots
1–15.

Sink Slot 8-SL4D-2
(SDH-2)

As shown in Figure 4-21, the service signals are
transmitted from 8-SL4D-2(SDH-2) to 8-SL4D-1
(SDH-1). In this example, Sink Slot is set to 8-SL4D-2
(SDH-2).

Sink VC4 VC4-1 It is recommended that you set Sink Slot to be the same
as Source Slot.

Sink
Timeslot
Range(e.g.
1,3-6)

1-15 The service between user A1 and user B1 uses timeslots
1–15.

Activate
Immediatel
y

Yes -

Step 3 Configure the EPL services of user A2 and user B2 on NE3.

Refer to Step 1 and configure the EPL services for users A2 and B2.

Step 4 Check whether the service between user A1 and user A2 and the service between user B1 and
user B2 are correct. For the operation procedure, see 7.15 Testing Ethernet Service
Channels.

Step 5 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 6 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see 6.4.3 Deleting Ethernet
Private Line Services.
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4.5 Configuring EPL Services on an Ethernet Switching
Board

EPL services provide the point-to-point Ethernet transparent transmission solution with the
bandwidth exclusively occupied. EPL services are applicable when the communication
equipment that is used to access the client-side data in the transmission network does not support
VLANs or when the VLAN planning must be kept secret to the network operator.

4.5.1 Networking Diagram
The completely isolated data services of two users at a station must be transported to another
station.

4.5.2 Signal Flow and Timeslot Allocation
Ethernet services are received from an external port, encapsulated through an internal port, and
mapped to the SDH network for transparent transmission. In this way, the node communicates
with a remote node.

4.5.3 Configuration Process
This topic describes the process of configuring Ethernet private line services for Ethernet
switching boards.

4.5.1 Networking Diagram
The completely isolated data services of two users at a station must be transported to another
station.

Service Requirement
In the network as shown in Figure 4-22, the service requirements are as follows:

l The two branches of user A that are located at NE1 and NE3 need to communicate with
each other over Ethernet. A 10 Mbit/s bandwidth is required.

l The two branches of user B that are located at NE1 and NE3 need to communicate with
each other over Ethernet. A 20 Mbit/s bandwidth is required.

l The services of user A must be isolated from the services of user B.

l The Ethernet equipment of user A and user B provides 100 Mbit/s Ethernet ports of which
the working mode is auto-negotiation, and does not support VLANs.
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Figure 4-22 Networking diagram of the EPL services
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Board Configuration Information

Ethernet transparent transmission boards or Ethernet switching boards can be used to configure
EPL services. The ISU board integrates the SCC unit, cross-connect unit, clock unit, tributary
unit, line unit, and data transparent transmission unit. The Ethernet unit of the ISU board is
displayed as the EFT8 on the T2000, which occupies logical slot 7. The STM-4 optical module
is displayed as the SL4D board on the T2000, which occupies logical slot 8.

In this example, NE1 and NE3 each are configured with one EFS8 board, which is an Ethernet
switching board.

NOTE
As provided in Table 8-1, the Ethernet boards are classified into the Ethernet transparent transmission
boards and Ethernet switching boards, based on the type of the accessed service. The transparent
transmission boards support only EPL services whereas the Ethernet switching boards support EPL
services, EVPL services, and Layer 2 switching.

4.5.2 Signal Flow and Timeslot Allocation
Ethernet services are received from an external port, encapsulated through an internal port, and
mapped to the SDH network for transparent transmission. In this way, the node communicates
with a remote node.

Figure 4-23 shows the signal flow and timeslot allocation of the EPL services.
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For the method of calculating the bandwidth of the Ethernet services carried by a VCTRUNK,
see 8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of Ethernet Boards.

Figure 4-23 Signal flow and timeslot allocation (Ethernet switching board)
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l The EPL services of user A:

– Occupy the first to fifth VC-12 timeslots of the first VC-4 (VC4-1:VC12:1-5) on the
SDH link between NE1 and NE3 and pass through NE2.

– Are added and dropped by using the first to fifth VC-12 timeslots of the fourth VC-4
(VC4-4:VC12:1-5) on the EFS8 board of NE1 and the first to fifth VC-12 timeslots of
the fourth VC-4 (VC4-4:VC12:1-5) on the EFS8 board of NE3.

l The EPL services of user B:
– Occupy the sixth to fifteenth VC-12 timeslots of the first VC-4 (VC4-1:VC12:6-15) on

the SDH link between NE1 and NE3 and pass through NE2.
– Are added and dropped by using the sixth to fifteenth VC-12 timeslots of the fourth

VC-4 (VC4-4:VC12:6-15) on the EFS8 board of NE1 and the sixth to fifteenth VC-12
timeslots of the fourth VC-4 (VC4-4:VC12:6-15) on the EFS8 board of NE3.

Table 4-11 Parameters of external ports on the Ethernet boards

Parameter NE1 NE3

Board EFS8 EFS8

Port PORT1 PORT2 PORT1 PORT2

Enabled/
Disabled

Enabled Enabled Enabled Enabled

Working Mode Auto-
Negotiation

Auto-
Negotiation

Auto-
Negotiation

Auto-
Negotiation

Maximum
Frame Length

1522 1522 1522 1522

Table 4-12 Parameters of internal ports on the Ethernet boards

Parameter NE1 NE3

Board EFS8 EFS8

Internal Port VCTRUNK1 VCTRUNK2 VCTRUNK1 VCTRUNK2
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Parameter NE1 NE3

Mapping
Protocol

GFP GFP GFP GFP

Bound Path VC4-4:VC12-1
–VC12-5

VC4-4:VC12-6
–VC12-15

VC4-4:VC12-1
–VC12-5

VC4-4:VC12-6
–VC12-15

Entry Detection Disabled Disabled Disabled Disabled

Port Type UNI UNI UNI UNI

Table 4-13 Parameters of the EPL services

Parameter EPL Services of User A EPL Services of User B

Board EFS8

Service Type EPL

Service Direction Bidirectional

Source Port PORT1 PORT2

Source C-VLAN (e.g. 1,3-6) Null Null

Sink Port VCTRUNK1 VCTRUNK2

Sink C-VLAN (e.g. 1,3-6) Null Null

4.5.3 Configuration Process
This topic describes the process of configuring Ethernet private line services for Ethernet
switching boards.

Prerequisite
You must be familiar with 4.3.1 Flow of Configuring EPL Services.

Background Information
If the Ethernet switching boards in the actual application scenarios are different from the boards
in this example, you need to learn about the requirements for configuring specific boards.

l For the EPL services supported by Ethernet switching boards, see 8.1 Service Support
Capability of Ethernet Boards.

l For the VCTRUNK binding requirements of Ethernet switching boards, see 8.2
Requirements for Binding Paths with VCTRUNKs on Ethernet Boards.

Procedure

Step 1 Configure the EPL services for users A1 and B1 on NE1.
1. Set the attributes of the external ports (PORT1 and PORT2 on the EFS8 board) used by the

services of users A1 and B1.
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l In the NE Explorer, select the EFS8 and then choose  Configuration > Ethernet
Interface Management > Ethernet Interface from the Function Tree.

l Select External Port.

l Click the Basic Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Enabled
/
Disable
d

PORT1: Enabled
PORT2: Enabled

PORT1 is used by the service of user A1.
PORT2 is used by the service of user B1. In
this example, Enabled/Disabled is set to
Enabled for PORT1 and PORT2.

Workin
g Mode

PORT1: Auto-
Negotiation
PORT2: Auto-
Negotiation

In this example, the Ethernet service access
equipment of user A1 and user B1 supports
the auto-negotiation mode. Hence, Working
Mode is set to Auto-Negotiation for PORT1
and PORT2.

Maximu
m
Frame
Length

PORT1: 1522
PORT2: 1522

Generally, this parameter adopts the default
value 1522.

MAC
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The MAC loopback setting is used for fault
diagnosis. In this example, MAC
Loopback is set to Non-Loopback.

PHY
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The PHY loopback setting is used for fault
diagnosis. In this example, PHY Loopback
is set to Non-Loopback.

l Click the Flow Control tab. The parameters in the Flow Control tab page adopt the
default values.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

TAG PORT1: Access
PORT2: Access

The access equipment of user A1 and user B1
does not support the VLAN. Hence, the
access equipment transmits only the packet
without the VLAN tag. In this example, it is
recommended that you set the TAG flags at
PORT1 and PORT2 to Access.

Default
VLAN
ID

PORT1: 1
PORT2: 1

The services of user A1 and user B1
exclusively occupy the PORTs and
VCTRUNKs. Hence, the VLAN ID is not
required for isolating the services. In this
example, Default VLAN ID adopts the
default value.
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Parame
ter

Value in This Example Description

VLAN
Priority

PORT1: 0
PORT2: 0

Both the VLAN ID and VLAN priority are
unnecessary for users A1 and B1. In this
example, VLAN Priority adopts the default
value.

Entry
Detectio
n

PORT1: Disabled
PORT2: Disabled

The services of user A1 and user B1 are EPL
transparent transmission services. Hence,
you need not enable the entry detection
function to check the VLAN tags of the
packets. In this example, Entry Detection
need to be set to Disabled. When Entry
Detection is set to Disabled, the parameters
of TAG, Default VLAN ID, and VLAN
Priority are invalid.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

2. Set the attributes of the internal ports (VCTRUNK1 and VCTRUNK2 of the EFS8 board)
used by the services of user A1 and user B1.

l Select Internal Port.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Entry
Detectio
n

VCTRUNK1: Disabled
VCTRUNK2: Disabled

The services of user A1 and user B1 are EPL
transparent transmission services. Hence,
you need not enable the entry detection
function to check the VLAN tags of the
packets. In this example, Entry Detection
need to be set to Disabled. When Entry
Detection is set to Disabled, the parameters
of TAG, Default VLAN ID, and VLAN
Priority are invalid.

l Click the Network Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Port
Type

VCTRUNK1: UNI
VCTRUNK1: UNI

UNI indicates the user-network interface,
namely, the interface of the service provider
located near the user side. The UNI interface
processes the tag attribute of IEEE 802.1Q-
compliant packets. That is, the UNI interface
processes and identifies the VLAN
information of the accessed user packets,
according to the supported tag flag, namely,
Tag Aware, Access, and Hybrid.

l Click the Encapsulation/Mapping tab. After setting the parameters, click Apply.
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Parame
ter

Value in This Example Description

Mappin
g
Protocol

VCTRUNK1: GFP
VCTRUNK2: GFP

In this example, the EFS8 board is used. This
parameter adopts the default value GFP.
Mapping Protocol of the VCTRUNKs on
the Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Scrambl
e

VCTRUNK1:
Scrambling mode [X43
+1]
VCTRUNK2:
Scrambling mode [X43
+1]

In this example, this parameter adopts the
default value Scrambling mode [X43+1].
Scramble of the VCTRUNKs on the
Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Check
Field
Length

VCTRUNK1: FCS32
VCTRUNK2: FCS32

In this example, this parameter adopts the
default value FCS32. Check Field Length
of the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

FCS
Calculat
ed Bit
Sequenc
e

VCTRUNK1: Big endian
VCTRUNK2: Big endian

When Mapping Protocol is set to GFP, FCS
Calculated Bit Sequence is set to Big
endian. FCS Calculated Bit Sequence of
the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

Extensi
on
Header
Option

VCTRUNK1: No
VCTRUNK2: No

When Mapping Protocol is set to GFP, this
parameter is valid and adopts the default
value No. Extension Header Option of the
VCTRUNKs on the Ethernet boards of the
interconnected equipment at both ends must
be set to the same value.

l Click the Bound Path tab. Click the Configuration button. Set the following in the
Bound Path Configuration dialog box that is displayed. Then, click Apply.

User Paramete
r

Value in
This
Example

Description

User
A1←
→user
A2

Configura
ble Ports

VCTRUN
K1

As shown in Figure 4-23, VCTRUNK1 is used
by the service between user A1 and user A2.

Ava
ilab
le
Bou
nd
Pat
hs

Lev
el

VC12-xv The service between user A1 and user A2 uses
a 10 Mbit/s bandwidth. Hence, five VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried by
VCTRUNKs of Ethernet Boards.
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User Paramete
r

Value in
This
Example

Description

Ser
vic
e
Dir
ecti
on

Bidirectio
nal

The service between user A1 and user A2 is a
bidirectional service.

Av
aila
ble
Res
our
ces

VC4-4 The fourth VC-4 of the EFS8 board can be
bound with VC-12s. In this example, Available
Resources is set to VC4-4.
For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Av
aila
ble
Ti
me
slot
s

VC12-1 to
VC12-5

Five VC-12s need to be bound for the service
from user A1 to user A2. In this example, the
first to the fifth VC-12s need to be selected in
sequence.

User
B1←
→user
B2

Configura
ble Ports

VCTRUN
K2

As shown in Figure 4-23, VCTRUNK2 is used
by the service between user B1 and user B2.

Ava
ilab
le
Bou
nd
Pat
hs

Lev
el

VC12-xv The service between user B1 and user B2 uses
a 20 Mbit/s bandwidth. Hence, 10 VC-12s need
to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried by
VCTRUNKs of Ethernet Boards.

Ser
vic
e
Dir
ecti
on

Bidirectio
nal

The service between user B1 and user B2 is a
bidirectional service.

Av
aila
ble
Res
our
ces

VC4-4 The fourth VC-4 of the EFS8 board can be
bound with VC-12s. In this example, Available
Resources is set to VC4-4.
For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.
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User Paramete
r

Value in
This
Example

Description

Av
aila
ble
Ti
me
slot
s

VC12-6 to
VC12-15

Ten VC-12s need to be bound for the service
from user B1 to user B2. In this example, the
sixth to the fifteenth VC-12s need to be selected
in sequence.

3. Configure the Ethernet private line services for user A1 and user B1.
l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet

Service  > Ethernet Line Service from the Function Tree.
l Click New on the lower-right pane to display the Create Ethernet Line Service dialog

box. Set the following parameters, and then click OK. The Operation Result dialog
box is displayed, indicating that the operation is successful. Click Close.

User Parameter Value in
This
Example

Description

User A1 Service
Type

EPL The service of user A1 is an EPL service.

Service
Direction

Bidirection
al

The service of user A1 is a bidirectional
service.

Source Port PORT1 When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific PORT as
the source port. In this example, the service of
user A1 occupies PORT1.

Source C-
VLAN (e.g.
1, 3–6)

Blank In this example, the EPL service does not carry
the VLAN tag.

Sink Port VCTRUN
K1

When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific
VCTRUNK as the sink port. In this example,
the service of user A1 occupies VCTRUNK1.

Sink C-
VLAN (e.g.
1, 3–6)

Blank In this example, the EPL service does not carry
the VLAN tag.

User B1 Service
Type

EPL The service of user B1 is an EPL service.

Service
Direction

Bidirection
al

The service of user B1 is a bidirectional
service.
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User Parameter Value in
This
Example

Description

Source Port PORT2 When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific PORT as
the source port. In this example, the service of
user B1 occupies PORT2.

Source C-
VLAN (e.g.
1, 3–6)

Blank In this example, the EPL service does not carry
the VLAN tag.

Sink Port VCTRUN
K2

When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific
VCTRUNK as the sink port. In this example,
the service of user B1 occupies VCTRUNK2.

Sink C-
VLAN (e.g.
1, 3–6)

Blank In this example, the EPL service does not carry
the VLAN tag.

4. Configure the cross-connections from the Ethernet services to the SDH links for user A1
and user B1.
l In the NE Explorer, select NE1 and then choose  Configuration > SDH Service

Configuration from the Function Tree.
l Click Create on the lower-right pane to display the Create SDH Service dialog box.

Set the parameters as follows.

User Paramete
r

Value in
This
Example

Description

User A1 Level VC12 The timeslot bound with the service of user
A1 is at the VC-12 level. The service level
must be consistent with the level of the path
bound with the VCTRUNK.

Service
Direction

Bidirectiona
l

The service of user A1 is a bidirectional
service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK1. In the case
of VCTRUNK1, the value of Available
Resources is VC4-4.
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User Paramete
r

Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the source timeslots is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK1. In this
example, the value range of Available
Timeslots is from VC12-1 to VC12-5.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are five
VC-12s, the sink timeslots must be five
VC-12s.

Activate
Immediatel
y

Yes -

User B1 Level VC12 The timeslot bound with the service of user
B1 is at the VC-12 level. The service level
must be consistent with the level of the path
bound with the VCTRUNK.

Service
Direction

Bidirectiona
l

The service of user B1 is a bidirectional
service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK2. In the case
of VCTRUNK2, the value of Available
Resources is VC4-4.
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User Paramete
r

Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

6-15 The value range of the source timeslots is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK2. In this
example, the value range of Available
Timeslots is from VC12-6 to VC12-15.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

6-15 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are 10
VC-12s, the sink timeslots must be 10
VC-12s.

Activate
Immediatel
y

Yes -

Step 2 Configure the EPL services for users A1 and B1 on NE2.

1. Click . Select NE2 in the Navigation Tree that is displayed. Then, click OK.
2. In the NE Explorer, select NE2, and then choose  Configuration > SDH Service

Configuration from the Function Tree.
3. Click Create on the lower-right pane to display the Create SDH Service dialog box. Set

the parameters as follows.

Parameter Value in
This
Example

Description

Level VC12 The SDH service of NE1, which passes through NE2, is
at the VC-12 level.

Service
Direction

Bidirectional As shown in Figure 4-23, the SDH service from NE1 to
NE2 is a bidirectional service.
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Parameter Value in
This
Example

Description

Source Slot 8-SL4D-1
(SDH-1)

As shown in Figure 4-23, the service signals are
transmitted from 8-SL4D-1(SDH-1) to 8-SL4D-2
(SDH-2). In this example, Source Slot is set to 8-SL4D-1
(SDH-1).

Source
VC4

VC4-1 VC4-1 is allocated to the service from NE1 to NE2.

Source
Timeslot
Range(e.g.
1,3-6)

1-15 The service between user A1 and user B1 uses timeslots
1–15.

Sink Slot 8-SL4D-2
(SDH-2)

As shown in Figure 4-23, the service signals are
transmitted from 8-SL4D-1(SDH-1) to 8-SL4D-2
(SDH-2). In this example, Sink Slot is set to 8-SL4D-2
(SDH-2).

Sink VC4 VC4-1 It is recommended that you set Sink Slot to be the same
as Source Slot.

Sink
Timeslot
Range(e.g.
1,3-6)

1-15 The service between user A1 and user B1 uses timeslots
1–15.

Activate
Immediatel
y

Yes -

Step 3 Configure the EPL services for users A2 and B3 on NE3.

Refer to Step 1 and configure the EPL services for users A2 and B2. The parameter values of
user A2 and user B2 must be consistent with the parameter values of user A1 and user B1.

Step 4 Check whether the service between user A1 and user A2 and the service between user B1 and
user B2 are correct. For the operation procedure, see 7.15 Testing Ethernet Service
Channels.

Step 5 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 6 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task

If the services are configured incorrectly and thus need to be deleted, see 6.4.3 Deleting Ethernet
Private Line Services.
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4.6 Configuring PORT-Shared EVPL (VLAN) Services
The PORT-shared EVPL (VLAN) service is applicable when the services of multiple users
received from the same external port on the Ethernet board at a station are transmitted on different
VCTRUNKs to another station or to another external port of the station.

4.6.1 Networking Diagram
The services of multiple users received from the same external port on an Ethernet board of a
station are transmitted to different stations on different VCTRUNKs.

4.6.2 Signal Flow and Timeslot Allocation
Ethernet services wherein different VLAN IDs are used to isolate the data of different users are
received from the same external port of NE1, encapsulated through an internal port, and
transparently transmitted on the SDH network. In this way, the node communicates with a remote
node.

4.6.3 Configuration Process
Ethernet switching boards are required for creating EVPL services of different VLAN IDs on
NE1. In this way, the data of different users received from the same external port can be
differentiated. Ethernet transparent transmission boards are required for creating EPL
transparent transmission services on NE2 and NE4.

4.6.1 Networking Diagram
The services of multiple users received from the same external port on an Ethernet board of a
station are transmitted to different stations on different VCTRUNKs.

Service Requirement
In the network as shown in Figure 4-24, the service requirements are as follows:

l The headquarters C1 of user C is located at NE1. Two branches (C2 and C3) of user C are
located at NE2 and NE4. The services between C1 and C2 are transmitted in the VLAN of
which the VLAN ID is 100. The services between C1 and C3 are transmitted in the VLAN
of which the VLAN ID is 200.

l The services of C2 are isolated from the services of C3. The services of C2 and C3 require
a 20 Mbit/s bandwidth respectively.

l The Ethernet equipment of C1, C2, and C3 provides 100 Mbit/s Ethernet electrical
interfaces that work in auto-negotiation mode. The Ethernet equipment of C1 supports
VLANs, but the Ethernet equipment of C2 and C3 does not support VLANs.
– The VLAN ID used by the Ethernet services between C1 and C2 is 100.

– The VLAN ID used by the Ethernet services between C1 and C3 is 200.
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Figure 4-24 Networking diagram for configuring PORT-shared EVPL (VLAN) services
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Board Configuration Information
In this example, NE1 is configured with an EFS8 board. VLAN IDs are used to isolate the data
of different users received from the same port. NE2 and NE4 are each configured with an EFT8
board. The EPL services are configured to implement service transparent transmission from NE2
and NE4 to NE1. The ISU board integrates the SCC unit, cross-connect unit, clock unit, tributary
unit, line unit, and data transparent transmission unit. The Ethernet unit of the ISU board is
displayed as the EFT8 on the T2000, which occupies logical slot 7. The STM-4 optical module
is displayed as the SL4D board on the T2000, which occupies logical slot 8.

In this example, NE1 is configured with an EFS8 board. NE2 and NE4 are each configured with
an EFT8 board.

NOTE
As provided in Table 8-1, the Ethernet boards are classified into the Ethernet transparent transmission
boards and Ethernet switching boards, based on the type of the accessed service. The transparent
transmission boards support only EPL services whereas the Ethernet switching boards support EPL
services, EVPL services, and Layer 2 switching.

4.6.2 Signal Flow and Timeslot Allocation
Ethernet services wherein different VLAN IDs are used to isolate the data of different users are
received from the same external port of NE1, encapsulated through an internal port, and
transparently transmitted on the SDH network. In this way, the node communicates with a remote
node.

Figure 4-25 shows the signal flow of the PORT-shared EVPL (VLAN) services and the timeslot
allocation to the PORT-shared EVPL (VLAN) services .

For the method of calculating the bandwidth of the Ethernet services carried by a VCTRUNK,
see 8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of Ethernet Boards.
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Figure 4-25 Signal flow and timeslot allocation
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l The EVPL service from C1 to C2:

– Occupies the first to tenth VC-12 timeslots of the first VC-4 (VC4-1:VC12:1-10) on
the SDH link from NE1 to NE2.

– Is added and dropped by using the first to tenth VC-12 timeslots of the fourth VC-4
(VC4-4:VC12:1-10) on the EFS8 board of NE1 and the first to tenth VC-12 timeslots
of the fourth VC-4 (VC4-4:VC12:1-10) on the EFT8 board of NE2.

l The EVPL service from C1 to C3:
– Occupies the first to tenth VC-12 timeslots of the first VC-4 (VC4-1:VC12:1-10) on

the SDH link from NE1 to NE4.
– Is added and dropped by the using the eleventh to twentieth VC-12 timeslots of the

fourth VC-4 (VC4-4:VC12:11-20) on the EFS8 board of NE1 and the first to tenth
VC-12 timeslots of the fourth VC-4 (VC4-4:VC12:1-10) on the EFT8 board of NE4.

Table 4-14 Parameters of external ports on the Ethernet boards

Parameter NE1 NE2 NE4

Board EFS8 EFT8 EFT8

Port PORT1 PORT1 PORT1

Enabled/Disabled Enabled Enabled Enabled

Working Mode Auto-Negotiation Auto-Negotiation Auto-Negotiation

Maximum Frame
Length

1522 1522 1522

TAG Tag Aware - -
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Table 4-15 Parameters of internal ports on the Ethernet boards

Parameter NE1 NE2 NE4

Board EFS8 EFT8 EFT8

Port VCTRUNK1 VCTRUNK2 VCTRUNK1 VCTRUNK1

Mapping
Protocol

GFP GFP GFP GFP

TAG Access Access - -

Entry Detection Enabled Enabled - -

Default VLAN
ID

100 200 - -

VLAN Priority 0 0 - -

Bound Path VC4-4:VC12-1
to VC12-10

VC4-4:VC12-1
1 to VC12-20

VC4-4:VC12-1
to VC12-10

VC4-4:VC12-1
to VC12-10

Port Type UNI UNI - -

Table 4-16 Parameters of the PORT-shared EVPL (VLAN) services

Parameter NE1

EVPL1
(PORT1←→VCTRUNK1
)

EVPL2
(PORT1←→VCTRUNK2
)

Board EFS8

Service Type EVPL

Service Direction Bidirectional

Source Port PORT1 PORT1

Source C-VLAN (e.g. 1,3-6) 100 200

Sink Port VCTRUNK1 VCTRUNK2

Sink C-VLAN (e.g. 1,3-6) 100 200

4.6.3 Configuration Process
Ethernet switching boards are required for creating EVPL services of different VLAN IDs on
NE1. In this way, the data of different users received from the same external port can be
differentiated. Ethernet transparent transmission boards are required for creating EPL
transparent transmission services on NE2 and NE4.

Prerequisite
You must be familiar with 4.3.2 Flow of Configuring EVPL Services.
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Background Information
If the Ethernet boards in the actual application scenarios are different from the boards in this
example, you need to learn about the requirements for configuring specific boards.

l For the EVPL services supported by Ethernet switching boards, see 8.1 Service Support
Capability of Ethernet Boards.

l For the VCTRUNK binding requirements of Ethernet switching boards, see 8.2
Requirements for Binding Paths with VCTRUNKs on Ethernet Boards.

Procedure

Step 1 Configure the EVPL services for user C1 on NE1.
1. Set the attributes of the external port (PORT1 of the EFS8 board) used by the service of

user C1.
l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet

Interface Management > Ethernet Interface  from the Function Tree.
l Select External Port.

l Click the Basic Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Enabled
/
Disable
d

PORT1: Enabled The service of user C1 occupies PORT1. In
this example, Enabled/Disabled is set to
Enable.

Workin
g Mode

PORT1: Auto-
Negotiation

The Ethernet service access equipment of
user C1 supports the auto-negotiation mode.
In this example, Working Mode is set to
Auto-Negotiation.

Maximu
m
Frame
Length

PORT1: 1522 Generally, this parameter adopts the default
value 1522.

MAC
Loopba
ck

PORT1: Non-Loopback The MAC loopback setting is used for fault
diagnosis. In this example, MAC
Loopback is set to Non-Loopback.

PHY
Loopba
ck

PORT1: Non-Loopback The PHY loopback setting is used for fault
diagnosis. In this example, PHY Loopback
is set to Non-Loopback.

l Click the Flow Control tab. The parameters in the Flow Control tab page adopt the
default values.

l Click the TAG Attributes tab. After setting the parameters, click Apply.
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Parame
ter

Value in This Example Description

TAG PORT1: Tag Aware When the port is set to Tag Aware, all data
frames transmitted and received at the port
must have VLAN tags. In this example,
TAG is set to Tag Aware.

Default
VLAN
ID

- When TAG is set to Tag Aware, you need
not set Default VLAN ID.

VLAN
Priority

- When TAG is set to Tag Aware, you need
not set VLAN Priority.

Entry
Detectio
n

PORT1: Enabled The equipment of user C1 supports VLANs.
Hence, the entry detection function must be
enabled to check the VLAN tag. In this way,
the user data frames with different VLAN
tags can be distinguished at one port. In this
example, Entry Detection of PORT1 is set
to Enabled.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

2. Set the attributes of the internal ports (VCTRUNK1 and VCTRUNK2 of the EFS8 board)
used by the services between user C1 and user C2 and between user C1 and user C3.
l Select Internal Port.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

TAG VCTRUNK1: Access
VCTRUNK2: Access

This parameter is set to Access if the Ethernet
equipment of users C2 and C3 does not
support VLANs and if the transmitted
packets do not carry VLAN tags.

Default
VLAN
ID

VCTRUNK1: 100
VCTRUNK2: 200

According to the plan, the VLAN ID is set to
100 on the transmission network side for
Ethernet services between user C1 and user
C2.
The VLAN ID is set to 200 on the
transmission network side for Ethernet
services between user C1 and user C3.

VLAN
Priority

VCTRUNK1: 0
VCTRUNK2: 0

In this example, this parameter adopts the
default value.
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Parame
ter

Value in This Example Description

Entry
Detectio
n

VCTRUNK1: Enabled
VCTRUNK2: Enabled

VCTRUNK1 is used by the service between
user C1 and user C2. VCTRUNK2 is used by
the service between user C1 and user C3.
Then, you need to enable the entry detection
function to detect the VLAN tags of the
received packets.

l Click the Network Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Port
Type

VCTRUNK1: UNI
VCTRUNK2: UNI

UNI indicates the user-network interface,
namely, the interface of the service provider
located near the user side. The UNI interface
processes the tag attribute of IEEE 802.1Q-
compliant packets. That is, the UNI interface
processes and identifies the VLAN
information of the accessed user packets,
according to the supported tag flag, namely,
Tag Aware, Access, and Hybrid.

l Click the Encapsulation/Mapping tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Mappin
g
Protocol

VCTRUNK1: GFP
VCTRUNK2: GFP

Mapping Protocol of the VCTRUNKs on
the Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Scrambl
e

VCTRUNK1:
Scrambling mode [X43
+1]
VCTRUNK2:
Scrambling mode [X43
+1]

In this example, this parameter adopts the
default value Scrambling mode [X43+1].

Check
Field
Length

VCTRUNK1: FCS32
VCTRUNK2: FCS32

In this example, this parameter adopts the
default value FCS32. Check Field Length
of the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

FCS
Calculat
ed Bit
Sequenc
e

VCTRUNK1: Big endian
VCTRUNK2: Big endian

When Mapping Protocol is set to GFP, FCS
Calculated Bit Sequence is set to Big
endian. FCS Calculated Bit Sequence of
the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.
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Parame
ter

Value in This Example Description

Extensi
on
Header
Option

VCTRUNK1: No
VCTRUNK2: No

When Mapping Protocol is set to GFP, this
parameter is valid and adopts the default
value No. Extension Header Option of the
VCTRUNKs on the Ethernet boards of the
interconnected equipment at both ends must
be set to the same value.

l Click the Bound Path tab. Click the Configuration button. Set the following
parameters in the Bound Path Configuration dialog box that is displayed. Then, click
Apply.

User
User
C1←→
user C2

Parameter Value in
This
Example

Description

Configurab
le Ports

VCTRUN
K1

As shown in Figure 4-25, VCTRUNK1 is
used by the service between user C1 and user
C2.

Avai
lable
Bou
nd
Path
s

Lev
el

VC12-xv The service between user C1 and user C2
uses a 20 Mbit/s bandwidth. Hence, 10
VC-12s need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.

Ser
vic
e
Dir
ecti
on

Bidirectio
nal

The service between user C1 and user C2 is
a bidirectional service.

Av
aila
ble
Res
our
ces

VC4-4 Select VC4-4.

For the resources used by other boards, see
8.2 Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Av
aila
ble
Ti
me
slot
s

VC12-1 to
VC12-10

Ten VC-12s need to be bound. In this
example, the first to the tenth VC-12s need
to be selected in sequence.

User
C1←→
user C3

Configurab
le Ports

VCTRUN
K2

As shown in Figure 4-25, VCTRUNK2 is
used by the service between user C1 and user
C3.
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Avai
lable
Bou
nd
Path
s

Lev
el

VC12-xv The service between user C1 and user C3
uses a 20 Mbit/s bandwidth. Hence, one
VC-12 needs to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.

Ser
vic
e
Dir
ecti
on

Bidirectio
nal

The service between user C1 and user C3 is
a bidirectional service.

Av
aila
ble
Res
our
ces

VC4-4 Select VC4-4.

For the resources used by other boards, see
8.2 Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Av
aila
ble
Ti
me
slot
s

VC12-11
to
VC12-20

Ten VC-12s need to be bound. In this
example, the eleventh to the twentieth
VC-12s need to be selected in sequence.

3. Configure the Ethernet private line services between user C1 and user C2 and between user
C1 and user C3.
l In the NE Explorer, select the EFS8 board and then choose  Configuration > Ethernet

Service  > Ethernet Line Service from the Function Tree.
l Click New on the lower-right pane to display the Create Ethernet Line Service

window. Set the following parameters and then click OK. The Operation Result dialog
box is displayed, indicating that the operation is successful. Click Close.

User Parameter Value in
This
Example

Description

User
C1←→u
ser C2

Service
Type

EPL The service between user C1 and C2 is a point-
to-point Ethernet private line service.

Service
Direction

Bidirection
al

The service between user C1 and user C2 is a
bidirectional service.

Source Port PORT1 When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific PORT as
the source port. PORT1 is the external port
used by the service between user C1 and user
C2.
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User Parameter Value in
This
Example

Description

Source C-
VLAN (e.g.
1, 3–6)

100 According to the plan, the VLAN ID is set to
100 for the Ethernet service between user C1
and user C2.

Sink Port VCTRUN
K1

When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific
VCTRUNK as the sink port. VCTRUNK1 is
the internal port used by the service between
user C1 and user C2.

Sink C-
VLAN (e.g.
1, 3–6)

100 According to the plan, the VLAN ID is set to
100 for the Ethernet service between user C1
and user C2.

User
C1←→u
ser C3

Service
Type

EPL The service between user C1 and C3 is a point-
to-point Ethernet private line service.

Service
Direction

Bidirection
al

The service between user C1 and user C3 is a
bidirectional service.

Source Port PORT1 When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific PORT as
the source port. PORT1 is the external port used
by the service between user C1 and user C3.

Source C-
VLAN (e.g.
1, 3–6)

200 According to the plan, the VLAN ID is set to
200 for the Ethernet service between user C1
and user C3.

Sink Port VCTRUN
K2

When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific
VCTRUNK as the sink port. VCTRUNK2 is
the internal port used by the service between
user C1 and user C2.

Sink C-
VLAN (e.g.
1, 3–6)

200 According to the plan, the VLAN ID is set to
200 for the Ethernet service between user C1
and user C3.

4. Configure the cross-connections from the Ethernet service between user C1 and user C2
to the SDH link and the Ethernet service between user C1 and user C3 to the SDH link.
l In the NE Explorer, select NE1 and then choose  Configuration > SDH Service

Configuration  from the Function Tree.
l Click Create on the lower-right pane to display the Create SDH Service dialog box.

Set the parameters as follows.
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User Paramete
r

Value in
This
Example

Description

User
C1←→
user C2

Level VC12 The timeslots bound with the service
between user C1 and user C2 is at the VC-12
level. The service level must be consistent
with the level of the paths bound with the
VCTRUNK.

Service
Direction

Bidirectiona
l

The service between user C1 and user C2 is
a bidirectional service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK1. In this
example, Source VC4 is set to VC4-4.

Source
Timeslot
Range(e.g.
1,3-6)

1-10 The value range of the source timeslots is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK1. In this
example, the value range of Available
Timeslots is from VC12-1 to VC12-10.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-10 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are 10
VC-12s, the sink timeslots must be 10
VC-12s.

Activate
Immediatel
y

Yes -
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User Paramete
r

Value in
This
Example

Description

User
C1←→
user C3

Level VC12 The timeslots bound with the service
between user C1 and user C3 is at the VC-12
level. The service level must be consistent
with the level of the paths bound with the
VCTRUNK.

Service
Direction

Bidirectiona
l

The service between user C1 and user C3 is
a bidirectional service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK1. In this
example, Source VC4 is set to VC4-4.

Source
Timeslot
Range(e.g.
1,3-6)

11-20 The value range of the source timeslots is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK2. In this
example, the value range of Available
Timeslots is from VC12-11 to VC12-20.

Sink Slot 8-SL4D-2
(SDH-2)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-10 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are 10
VC-12s, the sink timeslots must be 10
VC-12s.

Activate
Immediatel
y

Yes -

Step 2 Configure the EPL services on NE2 and NE4.
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NOTE
The Ethernet services of NE2 and NE4 are point-to-point transparent transmission services. See 4.4
Configuring EPL Services on an Ethernet Transparent Transmission Board to set the parameters.

Step 3 Check whether the services are configured correctly. For the operation procedures, see 7.15
Testing Ethernet Service Channels.
l Before testing the service connectivity between headquarters C1 and branch C2, set TAG of

PORT1 on the EFS8 board to Access and Default VLAN ID to 100.
l Before testing the service connectivity between headquarters C1 and branch C3, set TAG of

PORT1 on the EFS8 board to Access and Default VLAN ID to 200.

NOTE

After the test, change the modified parameter values to the values specified in the service configuration.

Step 4 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 5 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see 6.4.3 Deleting Ethernet
Private Line Services.

4.7 Configuring VCTRUNK-Shared EVPL (VLAN) Services
When the data of multiple users without VLAN tags sent to a transmission network is transmitted
on the same VCTRUNK, the VCTRUNK-shared EVPL (VLAN) service is used to isolate the
data by adding VLAN tags. In this way, the bandwidth is shared on the SDH side.

4.7.1 Networking Diagram
The data of multiple Ethernet users received from the same station is transmitted on the same
VCTRUNK and isolated by using different VLAN IDs. In this way, the bandwidth is shared on
the SDH side.

4.7.2 Signal Flow and Timeslot Allocation
The services of multiple users that are received from different external ports on an Ethernet
board are tagged with different VLAN IDs and then transmitted on the same VCTRUNK. In
this way, the data of different users is isolated. After the data arrives at the sink node, the VLAN
tags are stripped.

4.7.3 Configuration Process
Ethernet switching boards are required on both the source and sink nodes for creating EVPL
services of different VLAN IDs. In this way, the packets received from different external ports
are added with different VLAN tags. As a result, the packets are isolated when they are
transmitted on the same VCTRUNK.
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4.7.1 Networking Diagram
The data of multiple Ethernet users received from the same station is transmitted on the same
VCTRUNK and isolated by using different VLAN IDs. In this way, the bandwidth is shared on
the SDH side.

Service Requirement
In the network as shown in Figure 4-26, the service requirements are as follows:

l Two branches of user D are located at NE1 and NE2, and need to communicate with each
other.

l Two branches of user E are located at NE1 and NE2, and need to communicate with each
other.

l The services of user D need to be isolated from the services of user E. The traffic of user
D and user E, however, are complementary in terms of time and can share a 20 Mbit/s
bandwidth.

l The Ethernet equipment of user D and user E provides 100 Mbit/s Ethernet ports of which
the working mode is auto-negotiation, and does not support VLAN tags.

Figure 4-26 Networking diagram for configuring VCTRUNK-shared EVPL (VLAN) services
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PORT1
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8-SL4D-1
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Board Configuration Information
The Ethernet switching boards that support EVPL services are provided in Table 8-1.

In this example, NE1 and NE2 each are configured with an EFS8 board. Different VLAN IDs
are used to isolate the data of different users transmitted on the same VCTRUNK. The ISU board
integrates the SCC unit, cross-connect unit, clock unit, tributary unit, line unit, and data
transparent transmission unit. The Ethernet unit of the ISU board is displayed as the EFT8 on
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the T2000, which occupies logical slot 7. The STM-4 optical module is displayed as the SL4D
board on the T2000, which occupies logical slot 8.

In this example, NE1 and NE2 each are configured with one EFS8 board, which is an Ethernet
switching board.

l When the data of user D arrives at the transmission network, the VLAN ID of 100 is added
to the data. When the data leaves the transmission network, the VLAN tag is stripped.

l When the data of user E arrives at the transmission network, the VLAN ID of 200 is added
to the data. When the data leaves the transmission network, the VLAN tag is stripped.

4.7.2 Signal Flow and Timeslot Allocation
The services of multiple users that are received from different external ports on an Ethernet
board are tagged with different VLAN IDs and then transmitted on the same VCTRUNK. In
this way, the data of different users is isolated. After the data arrives at the sink node, the VLAN
tags are stripped.

Figure 4-27 shows the signal flow of the VCTRUNK-shared EVPL (VLAN) services and the
timeslot allocation to the VCTRUNK-shared EVPL (VLAN) services.

For the method of calculating the bandwidth of the Ethernet services carried by a VCTRUNK,
see 8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of Ethernet Boards.

Figure 4-27 Signal flow and timeslot allocation
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l The EVPL services of user D and user E that share VCTRUNK1 occupy the first to tenth
VC-12 timeslots of the first VC-4 (VC4-1:VC12:1-10) on the SDH link from NE1 to NE2.

l The services are added and dropped by using the first to tenth VC-12 timeslots of the eight
VC-4 (VC4-1:VC12:1-10) on the EFS8 board of NE1 and the first to tenth VC-12 timeslots
of the fourth VC-4 (VC4-1:VC12:1-10) on the EFS8 board of NE2.

Table 4-17 Parameters of external ports on the Ethernet boards

Parameter NE1 NE2

Board EFS8 EFS8

Port PORT1 PORT2 PORT1 PORT2

Enabled/
Disabled

Enabled Enabled Enabled Enabled
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Parameter NE1 NE2

Working Mode Auto-
Negotiation

Auto-
Negotiation

Auto-
Negotiation

Auto-
Negotiation

Maximum
Frame Length

1522 1522 1522 1522

TAG Access Access Access Access

Entry Detection Enabled Enabled Enabled Enabled

Default VLAN
ID

100 200 100 200

VLAN Priority 0 0 0 0

Table 4-18 Parameters of internal ports on the Ethernet boards

Parameter NE1 NE2

Board EFS8 EFS8

Port VCTRUNK1 VCTRUNK1

Mapping Protocol GFP GFP

TAG Tag Aware Tag Aware

Entry Detection Enabled Enabled

Bound Path VC4-4:VC12-1–VC12-10 VC4-4:VC12-1–VC12-10

Port Type UNI UNI

Table 4-19 Parameters of the VCTRUNK-shared EVPL (VLAN) services

Parameter NE1 NE2

EVPL1
PORT1←→V
CTRUNK1

EVPL2
PORT2←→V
CTRUNK1

EVPL1
PORT1←→V
CTRUNK1

EVPL2
PORT2←→V
CTRUNK1

Board EFS8 EFS8

Service Type EVPL EVPL

Service
Direction

Bidirectional Bidirectional

Source Port PORT1 PORT2 PORT1 PORT2

Source C-
VLAN (e.g.
1,3-6)

100 200 100 200

Sink Port VCTRUNK1 VCTRUNK1 VCTRUNK1 VCTRUNK1
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Parameter NE1 NE2

EVPL1
PORT1←→V
CTRUNK1

EVPL2
PORT2←→V
CTRUNK1

EVPL1
PORT1←→V
CTRUNK1

EVPL2
PORT2←→V
CTRUNK1

Sink C-VLAN
(e.g. 1,3-6)

100 200 100 200

4.7.3 Configuration Process
Ethernet switching boards are required on both the source and sink nodes for creating EVPL
services of different VLAN IDs. In this way, the packets received from different external ports
are added with different VLAN tags. As a result, the packets are isolated when they are
transmitted on the same VCTRUNK.

Prerequisite

You must be familiar with 4.3.2 Flow of Configuring EVPL Services.

Background Information

If the Ethernet boards in the actual application scenarios are different from the boards in this
example, you need to learn about the requirements for configuring specific boards.

l The Ethernet switching boards that support EVPL services are provided in 8.1 Service
Support Capability of Ethernet Boards.

l For the VCTRUNK binding requirements of Ethernet switching boards, see 8.2
Requirements for Binding Paths with VCTRUNKs on Ethernet Boards.

Procedure

Step 1 Configure the EVPL services for users D1 and E1 on NE1.

1. Set the attributes of the external ports (PORT1 and PORT2 of the EFS8 board) used by the
service of user D1 and user E1.

l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet
Interface Management > Ethernet Interface  from the Function Tree.

l Select External Port.

l Click the Basic Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Enabled
/
Disable
d

PORT1: Enabled
PORT2: Enabled

The service of user D1 occupies PORT1 and
the service of user E1 occupies PORT2. In
this example, Enabled/Disabled is set to
Enabled.
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Parame
ter

Value in This Example Description

Workin
g Mode

PORT1: Auto-
Negotiation
PORT2: Auto-
Negotiation

The Ethernet access equipment of user D1
and user E1 supports the auto-negotiation
mode. Working Mode of PORT1 and
PORT2 is set to Auto-Negotiation.

Maximu
m
Frame
Length

PORT1: 1522
PORT2: 1522

Generally, this parameter adopts the default
value 1522.

MAC
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The MAC loopback setting is used for fault
diagnosis. In this example, MAC
Loopback is set to Non-Loopback.

PHY
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The PHY loopback setting is used for fault
diagnosis. In this example, PHY Loopback
is set to Non-Loopback.

l Click the Flow Control tab. The parameters in the Flow Control tab page adopt the
default values.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

TAG PORT1: Access
PORT2: Access

This parameter is set to Access if the Ethernet
equipment of user D2 and user E1 does not
support VLANs and if the transmitted
packets do not carry VLAN tags.

Default
VLAN
ID

PORT1: 100
PORT2: 200

According to the plan, the VLAN ID is set to
100 on the transmission network side for
Ethernet services between user D1 and user
D2.
The VLAN ID is set to 200 on the
transmission network side for Ethernet
services between user E1 and user E2.

VLAN
Priority

PORT1: 0
PORT2: 0

In this example, this parameter adopts the
default value.

Entry
Detectio
n

PORT1: Enabled
PORT2: Enabled

If the equipment of users D1 and E1 does not
support VLANs, you need to enable the entry
detection function to detect wether the
received packets contain VLAN tags. In this
case, Entry Detection is set to Enabled.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

2. Set the attributes of the internal port (VCTRUNK1 on the EFS8 board) used by the services
between user D1 and user D2 and between E1 and user E2.
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l Select Internal Port.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

TAG VCTRUNK1: Tag Aware When the port is set to Tag Aware, all data
frames transmitted and received at the port
must have VLAN tags. In this example,
TAG is set to Tag Aware.

Default
VLAN
ID

- When TAG is set to Tag Aware, you need
not set Default VLAN ID.

VLAN
Priority

- When TAG is set to Tag Aware, you need
not set VLAN Priority.

Entry
Detectio
n

VCTRUNK1: Enabled VCTRUNK1 is used by the service between
user D1 and user D2 and the service between
user E1 and user E2. Then, you need to enable
the entry detection function to detect the
VLAN tags of the received packets.

l Click the Network Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Port
Type

VCTRUNK1: UNI UNI indicates the user-network interface,
namely, the interface of the service provider
located near the user side. The UNI interface
processes the tag attribute of IEEE 802.1Q-
compliant packets. That is, the UNI interface
processes and identifies the VLAN
information of the accessed user packets,
according to the supported tag flag, namely,
Tag Aware, Access, and Hybrid.

l Click the Encapsulation/Mapping tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Mappin
g
Protocol

VCTRUNK1: GFP Mapping Protocol of the VCTRUNKs on
the Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Scrambl
e

VCTRUNK1:
Scrambling mode [X43
+1]

In this example, this parameter adopts the
default value Scrambling mode [X43+1].
Scramble of the VCTRUNKs on the
Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.
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Parame
ter

Value in This Example Description

Check
Field
Length

VCTRUNK1: FCS32 In this example, this parameter adopts the
default value FCS32. Check Field Length
of the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

FCS
Calculat
ed Bit
Sequenc
e

VCTRUNK1: Big endian When Mapping Protocol is set to GFP, FCS
Calculated Bit Sequence is set to Big
endian. FCS Calculated Bit Sequence of
the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

Extensi
on
Header
Option

VCTRUNK1: No When Mapping Protocol is set to GFP, this
parameter is valid and adopts the default
value No. Extension Header Option of the
VCTRUNKs on the Ethernet boards of the
interconnected equipment at both ends must
be set to the same value.

l Click the Bound Path tab. Click the Configuration button. Set the following
parameters in the Bound Path Configuration dialog box that is displayed. Then, click
Apply.

User Parameter Value
in This
Examp
le

Description

User
D1←→u
ser D2
User
E1←→us
er E2

Configurab
le Ports

VCTR
UNK1

As shown in Figure 4-27, VCTRUNK1 is
used by the service between user D1 and user
D2 and the service between user E1 and user
E2.

Av
aila
ble
Bo
und
Pat
hs

Leve
l

VC12-
xv

The service between user D1 and user D2 and
the service between user E1 and user E2 share
a 20 Mbit/s bandwidth. Ten VC-12s need to be
bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.

Serv
ice
Dire
ction

Bidirect
ional

The service between user D1 and user D2 and
the service between user E1 and user E2 are
bidirectional services.
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User Parameter Value
in This
Examp
le

Description

Avai
lable
Reso
urce
s

VC4-4 Select VC4-4.

For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Avai
lable
Tim
eslot
s

VC12-1
to
VC12-1
0

Ten VC-12s need to be bound. In this example,
the first to the tenth VC-12s need to be selected
in sequence.

3. Configure the Ethernet private line services between user D1 and user D2 and between user
E1 and user E2.
l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet

Service  > Ethernet Line Service from the Function Tree.
l Click New on the lower-right pane to display the Create Ethernet Line Service

window. Set the following parameters and then click OK. The Operation Result dialog
box is displayed, indicating that the operation is successful. Click Close.

User Parameter Value in
This
Example

Description

User
D1←→u
ser D2

Service
Type

EPL The service between user D1 and user D2 is a
point-to-point EVPL service.

Service
Direction

Bidirection
al

The service between user D1 and user D2 is a
bidirectional service.

Source Port PORT1 When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific PORT as
the source port. In this example, PORT1 is the
external port used by the service between user
D1 and user D2.

Source C-
VLAN (e.g.
1, 3–6)

100 According to the plan, the VLAN ID is set to
100 on the transmission network side for
Ethernet service between user D1 and user D2.

Sink Port VCTRUN
K1

When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific
VCTRUNK as the sink port. In this example,
VCTRUNK1 is the internal port used by the
service between user D1 and user D2.
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User Parameter Value in
This
Example

Description

Sink C-
VLAN (e.g.
1, 3–6)

100 According to the plan, the VLAN ID is set to
100 on the transmission network side for
Ethernet services between user D1 and user D2.

User
E1←→u
ser E2

Service
Type

EPL The service between user E1 and E2 is a point-
to-point Ethernet private line service.

Service
Direction

Bidirection
al

The service between user E1 and user E2 is a
bidirectional service.

Source Port PORT2 When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific PORT as
the source port. In this example, PORT2 is the
external port used by the service between user
E1 and user E2.

Source C-
VLAN (e.g.
1, 3–6)

200 According to the plan, the VLAN ID is set to
200 on the transmission network side for
Ethernet service between user E1 and user E2.

Sink Port VCTRUN
K1

When creating the bidirectional Ethernet
service from a PORT to a VCTRUNK, it is
recommended that you use a specific
VCTRUNK as the sink port. In this example,
VCTRUNK1 is the internal port used by the
service between user E1 and user E2.

Sink C-
VLAN (e.g.
1, 3–6)

200 According to the plan, the VLAN ID is set to
200 on the transmission network side for
Ethernet service between user E1 and user E2.

4. Configure the cross-connections from the Ethernet services to the SDH links for user D1
and user E1.
l In the NE Explorer, select NE1 and then choose  Configuration > SDH Service

Configuration  from the Function Tree.
l Click Create on the lower-right pane to display the Create SDH Service dialog box.

Set the parameters as follows.

User Paramete
r

Value in
This
Example

Description

User
D1←→
user D2
user
E1←→
user E2

Level VC12 The timeslots bound with the service
between user D1 and user D2 and the
service between user E1 and user E2 are at
the VC-12 level. The service level must be
consistent with the level of the paths bound
with the VCTRUNK.

OptiX OSN 500 STM-1/STM-4 Multi-Service CPE Optical
Transmission System
Configuration Guide 4 Configuring Ethernet Services

Issue 01 (2009-01-20) Huawei Proprietary and Confidential
Copyright © Huawei Technologies Co., Ltd.

4-73



User Paramete
r

Value in
This
Example

Description

Service
Direction

Bidirectiona
l

The service between user D1 and user D2
and the service between user E1 and user
E2 are bidirectional services.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK1. In this
example, Source VC4 is set to VC4-4.

Source
Timeslot
Range(e.g.
1,3-6)

1-10 The value range of the source timeslots is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK1. In this
example, the value range of Available
Timeslots is from VC12-1 to VC12-10.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-10 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of sink timeslots must be, however,
consistent with the number of sink
timeslots.

Activate
Immediatel
y

Yes -

Step 2 Configure the EVPL service on NE2.

Refer to Step 1 and configure the EVPL service of NE2.

Step 3 Check whether the services are configured correctly. For the operation procedures, see 7.15
Testing Ethernet Service Channels.
l Test the service connectivity between user D1 and user D2.

l Test the service connectivity between user E1 and user E2.
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Step 4 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 5 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see 6.4.3 Deleting Ethernet
Private Line Services.

4.8 Configuring EPLAN Services (IEEE 802.1d Bridge)
The EPLAN service (IEEE 802.1d bridge) provides a LAN solution for multipoint-to-multipoint
convergence. This service applies where the user-side data communication equipment connected
to the transmission network does not support VLANs or where the VLAN planning is kept secret
from the network operator.

4.8.1 Networking Diagram
The convergence node needs to exchange Ethernet services with two access nodes at Layer 2.
The two access nodes need not communicate with each other.

4.8.2 Signal Flow and Timeslot Allocation
The Ethernet services of the convergence node are received from an external port, forwarded to
an internal port through Layer 2 switching, encapsulated, and transparently transmitted on the
SDH network. In this way, the node communicates with a remote node.

4.8.3 Configuration Process
At the convergence node NE1, you need to create an EPLAN service (IEEE 802.1d bridge). At
the access nodes NE2 and NE4, you need to configure only transparent transmission EPL
services.

4.8.1 Networking Diagram
The convergence node needs to exchange Ethernet services with two access nodes at Layer 2.
The two access nodes need not communicate with each other.

Service Requirement
In the network as shown in Figure 4-28, the service requirements are as follows:

l Three branches (F1, F2, and F3) of user F are located at NE1, NE2, and NE4. F1 needs to
communicate with F2 and F3, and requires a 10 Mbit/s bandwidth for communication with
each branch.

l The Ethernet equipment of user F provides 100 Mbit/s Ethernet electrical interfaces that
work in auto-negotiation mode and support VLANs. The VLAN IDs and the number of
VLANs, however, are unknown and may change.
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NOTE

The application scenarios where one branch needs to communicate with other branches are as follows:

l Branches F2 and F3 need to communicate with each other.

l Branches F2 and F3 need not communicate with each other.

If branches F2 and F3 need to communicate with each other, skip Step 1.4.

Figure 4-28 Networking diagram for configuring EPLAN services (IEEE 802.1d bridge)
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8-SL4D-1

8-SL4D-28-SL4D-1

F1

8-SL4D-2

F2
F3

 

Board Configuration Information

For the EPLAN (IEEE 802.1d bridge) services supported by Ethernet switching boards, refer to
Table 8-1.

In this example, the convergence node NE1 is configured with an EFS8 board that supports the
IEEE 802.1d bridge to implement EPLAN services wherein user VLANs are not limited.

The access nodes NE2 and NE4 each are configured with an EFT8 board. The EPL services are
configured to be transparently transmitted from NE2 and NE4 to NE1.

The ISU board integrates the SCC unit, cross-connect unit, clock unit, tributary unit, line unit,
and data transparent transmission unit. The Ethernet unit of the ISU board is displayed as the
EFT8 on the T2000, which occupies logical slot 7. The STM-4 optical module is displayed as
the SL4D board on the T2000, which occupies logical slot 8.

NOTE
As provided in Table 8-1, the Ethernet boards are classified into the Ethernet transparent transmission
boards and Ethernet switching boards, based on the type of the accessed service. The transparent
transmission boards support only EPL services whereas the Ethernet switching boards support EPL
services, EVPL services, and Layer 2 switching.
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4.8.2 Signal Flow and Timeslot Allocation
The Ethernet services of the convergence node are received from an external port, forwarded to
an internal port through Layer 2 switching, encapsulated, and transparently transmitted on the
SDH network. In this way, the node communicates with a remote node.

Figure 4-29 shows the signal flow of the EPLAN services (IEEE 802.1d bridge) and the timeslot
allocation to the EPLAN services (IEEE 802.1d bridge).

For the method of calculating the bandwidth of the Ethernet services carried by a VCTRUNK,
see 8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of Ethernet Boards.

Figure 4-29 Signal flow of and timeslot allocation
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l The Ethernet LAN service of user F occupies the first to fifth VC-12 timeslots of the first
VC-4 (VC4-1:VC12:1-5) on the SDH link from NE1 to NE2 and the first to fifth VC-12
timeslots of the first VC-4 (VC4-1:VC12:1-5) on the SDH link from NE1 to NE4.

l The Ethernet LAN service from NE1 to NE2 is added and dropped by using the first to fifth
VC-12 timeslots of the fourth VC-4 (VC4-4:VC12:1-5) on the EFS8 board of NE1 and the
first to fifth VC-12 timeslots of the fourth VC-4 (VC4-4:VC12:1-5) on the EFT8 board of
NE2.

l The Ethernet LAN service from NE1 to NE4 is added and dropped by using the sixth to
tenth VC-12 timeslots of the fourth VC-4 (VC4-4:VC12:6-10) on the EFS8 board of NE1
and the first to fifth VC-12 timeslots of the fourth VC-4 (VC4-4:VC12:1-5) on the EFT8
board of NE4.

Table 4-20 Parameters of external ports on the Ethernet boards

Parameter NE1 NE2 NE4

Board EFS8 EFT8 EFT8

Port PORT1 PORT1 PORT1

Enabled/Disabled Enabled Enabled Enabled

Working Mode Auto-Negotiation Auto-Negotiation Auto-Negotiation
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Parameter NE1 NE2 NE4

Maximum Frame
Length

1522 1522 1522

Entry Detection Enabled - -

TAG Tag Aware - -

Table 4-21 Parameters of internal ports on the Ethernet boards

Parameter NE1 NE2 NE4

Board EFS8 EFT8 EFT8

Port VCTRUNK1 VCTRUNK2 VCTRUNK1 VCTRUNK1

Mapping
Protocol

GFP GFP GFP GFP

Entry Detection Enabled Enabled - -

TAG Tag Aware Tag Aware - -

Bound Path VC4-4:VC12-1
–VC12-5

VC4-4:VC12-6
–VC12-10

VC4-4:VC12-1
–VC12-5

VC4-4:VC12-1
–VC12-5

Port Type UNI UNI - -

Table 4-22 Parameters of Ethernet LAN services (IEEE 802.1d bridge)

Parameter Ethernet LAN Service of NE1

Board EFS8

VB Name VB1

Bridge Type IEEE 802.1d

Bridge Switch Mode SVL/Ingress Filter Disable

Bridge Learning Mode SVL

Ingress Filter Disabled

VB Mount Port PORT1, VCTRUNK1, VCTRUNK2

Hub/Spoke PORT1 Hub

VCTRUNK1 Spoke

VCTRUNK2 Spoke
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4.8.3 Configuration Process
At the convergence node NE1, you need to create an EPLAN service (IEEE 802.1d bridge). At
the access nodes NE2 and NE4, you need to configure only transparent transmission EPL
services.

Prerequisite

You must be familiar with 4.3.3 Flow of Configuring EPLAN Services.

Background Information

If the Ethernet boards in the actual application scenarios are different from the boards in this
example, you need to learn about the requirements for configuring specific boards.

l For the EPLAN services supported by Ethernet switching boards, see 8.1 Service Support
Capability of Ethernet Boards.

l For the VCTRUNK binding requirements of Ethernet switching boards, see 8.2
Requirements for Binding Paths with VCTRUNKs on Ethernet Boards.

Procedure

Step 1 Configure the EPLAN services for users F1, F2, and F3 on NE1.

1. Set the attributes of the external port (PORT1 of the EFS8 board) used by the service of
user F1.

l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet
Interface Management > Ethernet Interface  from the Function Tree.

l Select External Port.

l Click the Basic Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Enabled
/
Disable
d

PORT1: Enabled In this example, PORT1 carries the services
and is set to Enabled.

Workin
g Mode

PORT1: Auto-
Negotiation

The Ethernet service access equipment of
user F1 supports the auto-negotiation mode.
In this example, Working Mode is set to
Auto-Negotiation.

Maximu
m
Frame
Length

PORT1: 1522 Generally, this parameter adopts the default
value 1522.

MAC
Loopba
ck

PORT1: Non-Loopback The MAC loopback setting is used for fault
diagnosis. In this example, MAC
Loopback is set to Non-Loopback.
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Parame
ter

Value in This Example Description

PHY
Loopba
ck

PORT1: Non-Loopback The PHY loopback setting is used for fault
diagnosis. In this example, PHY Loopback
is set to Non-Loopback.

l Click the Flow Control tab. The parameters in the Flow Control tab page adopt the
default values.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Entry
Detectio
n

PORT1: Enabled If the packets of user F1 carry VLAN tags,
you need to enable the entry detection
function to detect the VLAN tags of packets.
In this example, Entry Detection is set to
Enabled.

TAG PORT1: Tag Aware The service access equipment of user F1
supports VLANs and the transmitted data
frames carry VLAN tags. In this example,
Tag is set to Tag Aware for PORT1.

Default
VLAN
ID

- When TAG is set to Tag Aware, you need
not set Default VLAN ID.

VLAN
Priority

- When TAG is set to Tag Aware, you need
not set VLAN Priority.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

2. Set the attributes of the internal ports (VCTRUNK1 and VCTRUNK2 of the EFS8 board)
used by the services of user F2 and user F3 on NE1.
l Select Internal Port.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Entry
Detectio
n

VCTRUNK1: Enabled
VCTRUNK2: Enabled

If the packets of user F2 and user F3 carry
VLAN tags, you need to enable the entry
detection function to detect the VLAN tags
of the packets. In this example, Entry
Detection is set to Enabled.

TAG VCTRUNK1: Tag Aware
VCTRUNK2: Tag Aware

The service access equipment of user F2 and
user F3 supports VLANs and the transmitted
data frames carry VLAN tags. In this
example, Tag is set to Tag Aware for
VCTRUNK1 and VCTRUNK2.
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Parame
ter

Value in This Example Description

Default
VLAN
ID

- When TAG is set to Tag Aware, you need
not set Default VLAN ID.

VLAN
Priority

- When TAG is set to Tag Aware, you need
not set VLAN Priority.

l Click the Network Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Port
Type

VCTRUNK1: UNI
VCTRUNK2: UNI

UNI indicates the user-network interface,
namely, the interface of the service provider
located near the user side. The UNI interface
processes the tag attribute of IEEE 802.1Q-
compliant packets. That is, the UNI interface
processes and identifies the VLAN
information of the accessed user packets,
according to the supported tag flags, namely
Tag Aware, Access, and Hybrid.

l Click the Encapsulation/Mapping tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Mappin
g
Protocol

VCTRUNK1: GFP
VCTRUNK2: GFP

In this example, the EFS4 board is used. This
parameter adopts the default value GFP.
Mapping Protocol of the VCTRUNKs on
the Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Scrambl
e

VCTRUNK1:
Scrambling mode [X43
+1]
VCTRUNK2:
Scrambling mode [X43
+1]

In this example, this parameter adopts the
default value Scrambling mode [X43+1].
Scramble of the VCTRUNKs on the
Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Check
Field
Length

VCTRUNK1: FCS32
VCTRUNK2: FCS32

In this example, this parameter adopts the
default value FCS32. Check Field Length
of the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.
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Parame
ter

Value in This Example Description

FCS
Calculat
ed Bit
Sequenc
e

VCTRUNK1: Big endian
VCTRUNK2: Big endian

When Mapping Protocol is set to GFP, FCS
Calculated Bit Sequence is set to Big
endian. FCS Calculated Bit Sequence of
the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

Extensi
on
Header
Option

VCTRUNK1: No
VCTRUNK2: No

When Mapping Protocol is set to GFP, this
parameter is valid and adopts the default
value No. Extension Header Option of the
VCTRUNKs on the Ethernet boards of the
interconnected equipment at both ends must
be set to the same value.

l This operation is optional. Click the LCAS tab. After setting the parameters, click
Apply.

Parame
ter

Value in This Example Description

Enablin
g LCAS

VCTRUNK1: Enabled
VCTRUNK2: Enabled

In this example, the LCAS function is
enabled.

LCAS
Mode

VCTRUNK1: Huawei
Mode
VCTRUNK2: Huawei
Mode

In this example, this parameter adopts the
default value Huawei Mode. When Huawei
equipment is used at both ends, LCAS
Mode of the equipment at both ends is set to
Huawei Mode.

Hold off
Time
(ms)

VCTRUNK1: 2000
VCTRUNK2: 2000

In this example, this parameter adopts the
default value 2000. This parameter can also
be set according to the requirement of the
user.

WTR
Time(s)

VCTRUNK1: 300
VCTRUNK2: 300

In this example, this parameter adopts the
default value 300. This parameter can also be
set according to the requirement of the user.

TSD VCTRUNK1: Disabled
VCTRUNK2: Disabled

In this example, the TSD function is disabled.
The LCAS does not check the B3 bit error or
BIP status of the VCTRUNK members.

l Click the Bound Path tab. Click the Configuration button. Set the following
parameters in the Bound Path Configuration dialog box that is displayed. Then, click
Apply.

User Paramete
r

Value in
This
Example

Description

User
F1←

Configura
ble Ports

VCTRUN
K1

As shown in Figure 4-29, VCTRUNK1 of the
EFS8 board is used by the service between user
F1 and user F2.
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User Paramete
r

Value in
This
Example

Description

→user
F2

Ava
ilab
le
Bou
nd
Pat
hs

Lev
el

VC12-xv The service between user F1 and user F2 uses
a 10 Mbit/s bandwidth. Hence, five VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried by
VCTRUNKs of Ethernet Boards.

Ser
vic
e
Dir
ecti
on

Bidirection
al

The service between user F1 and user F2 is a
bidirectional service.

Av
aila
ble
Res
our
ces

VC4-4 For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Av
aila
ble
Ti
me
slot
s

VC12-1 to
VC12-5

Five VC-12s need to be bound for the service
between user F1 and user F2. In this example,
the first to the fifth VC-12s need to be selected
in sequence.

User
F1←
→user
F3

Configura
ble Ports

VCTRUN
K2

As shown in Figure 4-29, VCTRUNK2 of the
EFS8 board is used by the service between user
F1 and user F3.

Ava
ilab
le
Bou
nd
Pat
hs

Lev
el

VC12 The service between user F1 and user F3 uses
a 10 Mbit/s bandwidth. Hence, five VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried by
VCTRUNKs of Ethernet Boards.

Ser
vic
e
Dir
ecti
on

Bidirection
al

The service between user F1 and user F3 is a
bidirectional service.
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User Paramete
r

Value in
This
Example

Description

Av
aila
ble
Res
our
ces

VC4-4 For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Av
aila
ble
Ti
me
slot
s

VC12-6 to
VC12-10

Five VC-12s need to be bound for the service
between user F1 and user F3. In this example,
the sixth to the tenth VC-12s need to be selected
in sequence.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

3. Create a bridge for the EFS8 board on NE1.
l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet

Service  > Ethernet LAN Service from the Function Tree.
l Click New.

l Set the parameters in the Create Ethernet LAN Service dialog box that is displayed.

Parameter Value in
This
Example

Description

VB Name VB1 This parameter is a character string used to describe
the bridge. It is recommended that you set this
parameter to a character string that contains the
information about the detailed application of the
bridge.

VB Type 802.1d The IEEE 802.1d MAC bridge learns and forwards
the packets according to the MAC addresses of the
user packets. The information in the VLAN tags of
the user packets, however, is not considered in the
learning and forwarding process. The IEEE 802.1d
MAC bridge is used when the entire information of
the VLANs used by the client cannot be learned or
when the data between the VLANs of the client need
not be isolated.
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Parameter Value in
This
Example

Description

Bridge
Switch Mode

SVL/Ingress
Filter
Disable

When the bridge adopts the SVL learning mode, all
the VLANs share the same MAC address table. That
is, the bridge learns and forwards the packets
according to the MAC addresses of the user packets
only. The information in the VLAN tags of the user
packets, however, is not considered in the learning
and forwarding process.

Bridge
Learning
Mode

SVL -

Ingress Filter Disabled The IEEE 802.1d MAC bridge does not detect the
VLAN tags of the received packets.

l Click Configure Mount.
l In the Available Mounted Ports window, select PORT1, VCTRUNK1, and

VCTRUNK2. Then, click .
l Click OK.

l In the Create Ethernet LAN Service dialog box, click OK.

4. Change the Hub/Spoke attribute of the port that is mounted to the bridge.
NOTE

If normal communication is required between user F2 and user F3, go to Step 1.5.

l Select the created bridge and click the Service Mount tab.

l Change the Hub/Spoke attribute of the port that is mounted to the bridge. After setting
the parameters, click Apply.

Parameter Value in
This
Example

Description

Hub/Spoke PORT1: Hub
VCTRUNK
1: Spoke
VCTRUNK
2: Spoke

If user F1 needs to communicate with user F2 and
user F3, PORT1 that accesses the services of user F1
is set to Hub. A port of the Hub attribute can
communicate with a port of the Spoke or Hub
attribute.
If user F2 need not communicate with user F3, set
the two VCTRUNKs that receive the services of
users F2 and F3 to Spoke. Ports of the Spoke
attribute cannot communicate with each other.

5. Configure the cross-connections from Ethernet services (between user F1 to user F2 and
between user F1 to user F3) to the SDH links.
l In the NE Explorer, select NE1 and then choose  Configuration > SDH Service

Configuration  from the Function Tree.
l Click Create on the lower-right pane to display the Create SDH Service dialog box.

Set the parameters as follows.
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User Paramete
r

Value in
This
Example

Description

User
F1←→u
ser F2

Level VC12 The timeslot bound with the service
between user F1 and user F2 is at the VC-12
level. The service level must be consistent
with the level of the paths bound with the
VCTRUNK.

Direction Bidirectiona
l

The service between user F1 and user F2 is
a bidirectional service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK1. In the case
of VCTRUNK1, the value of Available
Resources is VC4-4.

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the source timeslots is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK1. In this
example, the value range of Available
Timeslots is from VC12-1 to VC12-5.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are five
VC-12s, the sink timeslots must be five
VC-12s.

Activate
Immediatel
y

Yes -
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User Paramete
r

Value in
This
Example

Description

User
F1←→u
ser F3

Level VC12 The timeslot bound with the service
between user F1 and user F3 is at the VC-12
level. The service level must be consistent
with the level of the paths bound with the
VCTRUNK.

Direction Bidirectiona
l

The service between user F1 and user F3 is
a bidirectional service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK2. In the case
of VCTRUNK2, the value of Available
Resources is VC4-4.

Source
Timeslot
Range(e.g.
1,3-6)

6-10 The value range of the source timeslots is
consistent with the value range of
Available Timeslots, which is set for the
paths bound with VCTRUNK2. In this
example, the value range of Available
Timeslots is from VC12-6 to VC12-10.

Sink Slot 8-SL4D-2
(SDH-2)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are five
VC-12s, the sink timeslots must be five
VC-12s.

Activate
Immediatel
y

Yes -

Step 2 Configure the EPL services on NE2 and NE4.
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NOTE
The Ethernet services of NE2 and NE4 are point-to-point transparent transmission EPL services. See 4.4
Configuring EPL Services on an Ethernet Transparent Transmission Board to set the parameters.

Step 3 Check whether the services are configured correctly. For the operation procedures, see 7.15
Testing Ethernet Service Channels.
l Before testing the service connectivity between F1 and F2, set TAG to Access and set Default

VLAN ID to 1 for PORT1 and VCTRUNK1, which receive the services of F1 and F2
respectively, on the EFS4 board.

l Before testing the service connectivity between F1 and F3, set TAG to Access and Default
VLAN ID to 1 for PORT1 and VCTRUNK2, which receive the services of F1 and F3
respectively, on the EFS4 board.
NOTE

After the test, change the modified parameter values to the values specified in the service configuration.

Step 4 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 5 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see 6.4.4 Deleting EPLAN
Services.

4.9 Configuring EVPLAN Services (IEEE 802.1q Bridge)
The EVPLAN service (IEEE 802.1q bridge) provides an LAN solution for multipoint-to-
multipoint convergence. This service applies in cases where user-side data communication
equipment connected to the transmission network does not support VLANs or where the VLAN
planning is open to the network operator.

4.9.1 Networking Diagram
The convergence node needs to exchange Ethernet services with two access nodes at Layer 2.
LAN services of the two users (H and G) need to be isolated.

4.9.2 Signal Flow and Timeslot Allocation
The Ethernet services of the convergence node are received from an external port and tagged
with the corresponding VLAN IDs. After the services are forwarded to an internal port through
Layer 2 switching, the VLAN IDs are stripped and then the services are transparently transmitted
in the SDH network. In this way, the node communicates with a remote node.

4.9.3 Configuration Process
At the convergence node NE1, you need to create An EVPLAN service (IEEE 802.1q bridge)
and a VLAN filtering table need to be created for the convergence node NE1. The access nodes
NE2 and NE4 need to be configured with EPL transparent transmission services only.

4.9.1 Networking Diagram
The convergence node needs to exchange Ethernet services with two access nodes at Layer 2.
LAN services of the two users (H and G) need to be isolated.
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Service Requirement
In the network shown in Figure 4-30, the service requirements are as follows:

l Three branches (G1, G2, and G3) of user G are located at NE1, NE2, and NE4 respectively.
The branches need to form a LAN and share a 10 Mbit/s bandwidth. G2 and G3 do not
need to communicate with each other.

l Three branches (H1, H2, and H3) of user H are located at NE1, NE2, and NE4 respectively.
The branches need form a LAN and share a 20 Mbit/s bandwidth.

l The service of user G needs to be isolated from the service of user H.

l The Ethernet equipment of user G and user H provides 100 Mbit/s Ethernet electrical
interfaces that work in auto-negotiation mode and do not support VLANs.

Figure 4-30 Networking diagram for configuring EVPLAN services (IEEE 802.1q bridge)
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Board Configuration Information
For the EVPLAN (IEEE 802.1q bridge) services supported by Ethernet switching boards, refer
to Table 8-1.

In this example, the convergence node NE1 is configured with an EFS8 board that supports the
IEEE 802.1q bridge to implement EVPLAN services in which user data is isolated.

The access nodes NE2 and NE4 each are configured with an Ethernet transparent transmission
board respectively. The EPL services are configured to implement transparent transmission from
NE2 and NE4 to NE1.
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The ISU board integrates the SCC unit, cross-connect unit, clock unit, tributary unit, line unit,
and data transparent transmission unit. The data transparent transmission unit of the ISU board
is displayed as EFT8 on the NMS and occupies logical slot 7. The STM-4 optical interface
module of the ISU board is displayed as SL4D on the NMS and occupies logical slot 8.

NOTE
As provided in Table 8-1, the Ethernet boards are classified into the Ethernet transparent transmission
boards and Ethernet switching boards, based on the type of the accessed service. The Ethernet transparent
transmission boards only support EPL services, whereas the Ethernet switching boards support EPL
services, EVPL services, and Layer 2 switching.

4.9.2 Signal Flow and Timeslot Allocation
The Ethernet services of the convergence node are received from an external port and tagged
with the corresponding VLAN IDs. After the services are forwarded to an internal port through
Layer 2 switching, the VLAN IDs are stripped and then the services are transparently transmitted
in the SDH network. In this way, the node communicates with a remote node.

Figure 4-31 shows the signal flow of the EVPLAN services (IEEE 802.1q bridge) and the
timeslot allocation to the EVPLAN services (IEEE 802.1q bridge).

For the method of calculating the bandwidth of the Ethernet services carried by a VCTRUNK,
see 8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of Ethernet Boards.

Figure 4-31 Signal flow of and timeslot allocation to EVPLAN services (IEEE 802.1q bridge)
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l The Ethernet LAN services of user G:

– Occupy the first to fifth VC-12 timeslots of the first VC-4 (VC4-1:VC12:1-5) on the
SDH link from NE1 to NE2 and the first to fifth VC-12 timeslots of the first VC-4
(VC4-1:VC12:1-5) on the SDH link from NE1 to NE4.

– Are added and dropped by using the first to fifth VC-12 timeslots of the fourth VC-4
(VC4-4:VC12:1-5) on the EFS8 board of NE1 and the first to fifth VC-12 timeslots of
the fourth VC-4 (VC4-4:VC12:1-5) on the EFT8 board of NE2.
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– Are added and dropped by using the sixth to tenth VC-12 timeslots of the fourth VC-4
(VC4-4:VC12:6-10) on the EFS8 board of NE1 and the first to fifth VC-12 timeslots
of the fourth VC-4 (VC4-4:VC12:1-5) on the EFT8 board of NE4.

l The Ethernet LAN services of user H:

– Occupy the sixth to fifteenth VC-12 timeslots of the first VC-4 (VC4-1:VC12:6-15) on
the SDH link from NE1 to NE2 and the sixth to fifteenth VC-12 timeslots of the first
VC-4 (VC4-1:VC12:6-15) on the SDH link from NE1 to NE4.

– Are added and dropped by using the eleventh to twentieth VC-12 timeslots of the fourth
VC-4 (VC4-4:VC12:11-20) on the EFS8 board of NE1 and the sixth to fifteenth VC-12
timeslots of the fourth VC-4 (VC4-4:VC12:6-15) on the EFT8 board of NE2.

– Are added and dropped by using the twenty-first to thirtieth VC-12 timeslots of the
fourth VC-4 (VC4-4:VC12:21-20) on the EFS8 board of NE1 and the sixth to fifteenth
VC-12 timeslots of the fourth VC-4 (VC4-4:VC12:6-15) on the EFT8 board of NE3.

Table 4-23 Parameters of external ports on the Ethernet boards

Paramete
r

NE1 NE2 NE4

Board EFS8 EFT8 EFT8

Port PORT1 PORT2 PORT1 PORT2 PORT1 PORT2

Enabled/
Disabled

Enabled Enabled Enabled Enabled Enabled Enabled

Working
Mode

Auto-
Negotiatio
n

Auto-
Negotiatio
n

Auto-
Negotiatio
n

Auto-
Negotiatio
n

Auto-
Negotiatio
n

Auto-
Negotiatio
n

Maximum
Frame
Length

1522 1522 1522 1522 1522 1522

TAG Access Access - - - -

Entry
Detection

Enabled Enabled - - - -

Default
VLAN ID

100 200 - - - -

VLAN
Priority

0 0 - - - -

Table 4-24 Parameters of internal ports on the Ethernet boards

Param
eter

NE1 NE2 NE3

Board EFS8 EFT8 EFT8

Port VCTR
UNK1

VCTR
UNK2

VCTR
UNK3

VCTR
UNK4

VCTR
UNK1

VCTR
UNK2

VCTR
UNK1

VCTR
UNK2
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Param
eter

NE1 NE2 NE3

Mappin
g
Protoco
l

GFP GFP GFP GFP GFP GFP GFP GFP

TAG Access Access Access Access - - - -

Entry
Detecti
on

Enable
d

Enable
d

Enable
d

Enable
d

- - - -

Default
VLAN
ID

100 100 200 200 - - - -

VLAN
Priority

0 0 0 0 - - - -

Bound
Path

VC4-4:
VC12-
1–
VC12-
5

VC4-4:
VC12-
6–
VC12-
10

VC4-4:
VC12-
11–
VC12-
20

VC4-4:
VC12-
21–
VC12-
30

VC4-4:
VC12-
1–
VC12-
5

VC4-4:
VC12-
6–
VC12-
15

VC4-4:
VC12-
1–
VC12-
5

VC4-4:
VC12-
6–
VC12-
15

Port
Type

UNI UNI UNI UNI - - - -

Table 4-25 Parameters of Ethernet LAN services (IEEE 802.1q bridge)

Parameter Ethernet LAN Service of NE1

Board EFS8

VB Name VB1

Bridge Type IEEE 802.1q

Bridge Switch Mode IVL/Ingress Filter Enable

Bridge Learning Mode IVL

Ingress Filter Enabled

VB Mount Port PORT1, PORT2, VCTRUNK1, VCTRUNK2, VCTRUNK3,
VCTRUNK4

VLAN
Filtering

VLAN
Filtering

VLAN filter table 1 VLAN filter table 2

VLAN ID 100 200

Forwarding
Physical Port

PORT1, VCTRUNK1,
VCTRUNK2

PORT2, VCTRUNK3,
VCTRUNK4

4 Configuring Ethernet Services

OptiX OSN 500 STM-1/STM-4 Multi-Service CPE Optical
Transmission System
Configuration Guide

4-92 Huawei Proprietary and Confidential
Copyright © Huawei Technologies Co., Ltd.

Issue 01 (2009-01-20)



Parameter Ethernet LAN Service of NE1

Hub/Spoke PORT1 Hub

PORT2 Hub

VCTRUNK
1

Spoke

VCTRUNK
2

Spoke

VCTRUNK
3

Hub

VCTRUNK
4

Hub

4.9.3 Configuration Process
At the convergence node NE1, you need to create An EVPLAN service (IEEE 802.1q bridge)
and a VLAN filtering table need to be created for the convergence node NE1. The access nodes
NE2 and NE4 need to be configured with EPL transparent transmission services only.

Prerequisite
You must be familiar with 4.3.4 Flow of Configuring EVPLAN Services.

Background Information
If the Ethernet switching boards in the actual application scenarios are different from the boards
in this example, you need to learn about the requirements for configuring specific boards.

l For the EVPLAN services supported by Ethernet switching boards, see 8.1 Service
Support Capability of Ethernet Boards.

l For the VCTRUNK binding requirements of Ethernet switching boards, see 8.2
Requirements for Binding Paths with VCTRUNKs on Ethernet Boards.

Procedure

Step 1 Configure the EVPLAN services for user G1 and user H1 on NE1.
1. Set the attributes of the external ports (PORT1 and PORT2 on the EFS8 board) used by the

services of user G1 and user H1.
l In the NE Explorer, select the EFS8, and then choose  Configuration > Ethernet

Interface Management > Ethernet Interface  from the Function Tree.
l Select External Port.

l Click the Basic Attributes tab. After setting the parameters, click Apply.
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Parame
ter

Value in This Example Description

Enabled
/
Disable
d

PORT1: Enabled
PORT2: Enabled

In this example, PORT1 and PORT2 carry
the services and are set to Enabled.

Workin
g Mode

PORT1: Auto-
Negotiation
PORT2: Auto-
Negotiation

In this example, the Ethernet service access
equipment of user G1 and user H1 supports
the auto-negotiation mode. Hence, Working
Mode is set to Auto-Negotiation for PORT1
and PORT2.

Maximu
m
Frame
Length

PORT1: 1522
PORT2: 1522

Generally, this parameter adopts the default
value 1522.

MAC
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The MAC loopback setting is used for fault
diagnosis. In this example, MAC
Loopback is set to Non-Loopback.

PHY
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The PHY loopback setting is used for fault
diagnosis. In this example, PHY Loopback
is set to Non-Loopback.

l Click the Flow Control tab. The parameters in the Flow Control tab page adopt the
default values.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Entry
Detectio
n

PORT1: Enabled
PORT2: Enabled

The packets of user G1 and user H1 do not
carry VLAN tags. You need to enable the
entry detection function to detect whether the
packets carry VLAN tags. In this example,
Entry Detection is set to Enabled.

TAG PORT1: Access
PORT2: Access

If the service access equipment of user G1
and user H1 does not support VLANs and if
the transmitted packets do not carry VLAN
tags, TAG is set to Access for PORT1 and
PORT2.

Default
VLAN
ID

PORT1: 100
PORT2: 200

According to the plan, the VLAN ID is set to
100 on the transmission network side for
EVPLAN services between user G1, user G2,
and user G3. The VLAN ID is set to 200 on
the transmission network side for EVPLAN
services between user H1, user H2, and user
H3. In this case, the service data is isolated.
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Parame
ter

Value in This Example Description

VLAN
Priority

- This parameter adopts the default value.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

2. Set the attributes of the internal ports (VCTRUNK1, VCTRUNK2, VCTRUNK3, and
VCTRUNK4 on the EFS8 board) used by the service between user G1 and user G2, the
service between user G1 and user G3, the service between user H1 and user H2, and the
service between user H1 and user H3.
l Select Internal Port.

l Click the TAG Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Entry
Detectio
n

VCTRUNK1: Enabled
VCTRUNK2: Enabled
VCTRUNK3: Enabled
VCTRUNK4: Enabled

The packets of user G2, user G3, user H2, and
user H3 do not carry VLAN tags. You need
to enable the entry detection function to
detect the VLAN tags of the packets. In this
example, Entry Detection is set to
Enabled.

TAG VCTRUNK1: Access
VCTRUNK2: Access
VCTRUNK3: Access
VCTRUNK4: Access

If the service access equipment of user G2,
user G3, user H2, and user H3 does not
support VLANs and if the transmitted
packets do not carry VLAN tags, TAG is set
to Access for the four VCTRUNKs.

Default
VLAN
ID

VCTRUNK1: 100
VCTRUNK2: 100
VCTRUNK3: 200
VCTRUNK4: 200

According to the plan, the VLAN ID is set to
100 on the transmission network side for
EVPLAN services between user G1, user G2,
and user G3. The VLAN ID is set to 200 on
the transmission network side for EVPLAN
services between user H1, user H2, and user
H3. In this case, the service data is isolated.

VLAN
Priority

VCTRUNK1: 0
VCTRUNK2: 0
VCTRUNK3: 0
VCTRUNK4: 0

This parameter adopts the default value.

l Click the Network Attributes tab. After setting the parameters, click Apply.
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Parame
ter

Value in This Example Description

Port
Type

VCTRUNK1: UNI
VCTRUNK2: UNI
VCTRUNK3: UNI
VCTRUNK4: UNI

UNI indicates the user-network interface,
namely, the interface of the service provider
located near the user side. The UNI interface
processes the tag attribute of IEEE 802.1Q-
compliant packets. That is, the UNI interface
processes and identifies the VLAN
information of the accessed user packets,
according to the supported tag flag, namely,
Tag Aware, Access, and Hybrid.

l Click the Encapsulation/Mapping tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Mappin
g
Protocol

VCTRUNK1: GFP
VCTRUNK2: GFP
VCTRUNK3: GFP
VCTRUNK4: GFP

In this example, the EFS8 board is used. This
parameter adopts the default value GFP.
Mapping Protocol of the VCTRUNKs on
the Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Scrambl
e

VCTRUNK1:
Scrambling mode [X43
+1]
VCTRUNK2:
Scrambling mode [X43
+1]
VCTRUNK3:
Scrambling mode [X43
+1]
VCTRUNK4:
Scrambling mode [X43
+1]

In this example, this parameter adopts the
default value Scrambling mode [X43+1].
Scramble of the VCTRUNKs on the
Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Check
Field
Length

VCTRUNK1: FCS32
VCTRUNK2: FCS32
VCTRUNK3: FCS32
VCTRUNK4: FCS32

In this example, this parameter adopts the
default value FCS32. Check Field Length
of the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

FCS
Calculat
ed Bit
Sequenc
e

VCTRUNK1: Big endian
VCTRUNK2: Big endian
VCTRUNK3: Big endian
VCTRUNK4: Big endian

When Mapping Protocol is set to GFP, FCS
Calculated Bit Sequence is set to Big
endian. FCS Calculated Bit Sequence of
the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.
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Parame
ter

Value in This Example Description

Extensi
on
Header
Option

VCTRUNK1: No
VCTRUNK2: No
VCTRUNK3: No
VCTRUNK4: No

When Mapping Protocol is set to GFP, this
parameter is valid and adopts the default
value No. Extension Header Option of the
VCTRUNKs on the Ethernet boards of the
interconnected equipment at both ends must
be set to the same value.

l This operation is optional. Click the LCAS tab. After setting the parameters, click
Apply.

Parame
ter

Value in This Example Description

Enablin
g LCAS

VCTRUNK1: Enabled
VCTRUNK2: Enabled

In this example, Enabling LCAS is set to
Enabled.

LCAS
Mode

VCTRUNK1: Huawei
Mode
VCTRUNK2: Huawei
Mode

In this example, this parameter adopts the
default value Huawei Mode. If the
interconnected equipment at both ends is
Huawei equipment, LCAS Mode is set to
Huawei Mode for the interconnected
equipment.

Hold off
Time
(ms)

VCTRUNK1: 2000
VCTRUNK2: 2000

In this example, this parameter adopts the
default value 2000. You can set this
parameter according to the expected hold off
time of LCAS switching.

WTR
Time(s)

VCTRUNK1: 300
VCTRUNK2: 300

In this example, this parameter adopts the
default value 300. You can set this parameter
according to the expected WTR duration of
LCAS recovery.

TSD VCTRUNK1: Disabled
VCTRUNK2: Disabled

In this example, TSD is set to Disabled. In
this case, the LCAS protocol does not
monitor the status of the B3 or BIP bit errors
of a VCTRUNK member.

l Click the Bound Path tab. Click the Configuration button. Set the following in the
Bound Path Configuration dialog box that is displayed. Then, click Apply.

User Paramete
r

Value in
This
Example

Description

User
G1←→
user G2

Configura
ble Ports

VCTRUN
K1

As shown in Figure 4-31, VCTRUNK1 of the
EFS8 board is used by the service between
user G1 and user G2.
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User Paramete
r

Value in
This
Example

Description

Av
aila
ble
Bo
un
d
Pat
hs

Leve
l

VC12-xv The service between user G1 and user G2 uses
a 10 Mbit/s bandwidth. Hence, five VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.

Serv
ice
Dire
ction

Bidirectio
nal

The service between user G1 and user G2 is a
Bidirectional service.

Avai
lable
Reso
urce
s

VC4-4 For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Avai
lable
Tim
eslot
s

VC12-1 to
VC12-5

Five VC-12s need to be bound for user G2. In
this example, the first to the fifth VC-12s need
to be selected in sequence.

user
G1←→
user G3

Configura
ble Ports

VCTRUN
K2

As shown in Figure 4-31, VCTRUNK2 of the
EFS8 board is used by the service between
user G1 and user G3.

Av
aila
ble
Bo
un
d
Pat
hs

Leve
l

VC12-xv The service between user G1 and user G3 uses
a 10 Mbit/s bandwidth. Hence, five VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.

Serv
ice
Dire
ction

Bidirectio
nal

The service between user G1 and user G3 is a
Bidirectional service.

Avai
lable
Reso
urce
s

VC4-4 For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.
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User Paramete
r

Value in
This
Example

Description

Avai
lable
Tim
eslot
s

VC12-6 to
VC12-10

Five VC-12s need to be bound for the service
between user G1 and user G3. In this example,
the sixth to the tenth VC-12s need to be
selected in sequence.

User
H1←→
user H2

Configura
ble Ports

VCTRUN
K3

As shown in Figure 4-31, VCTRUNK3 of the
EFS8 board is used by the service between
user H1 and user H2.

Av
aila
ble
Bo
un
d
Pat
hs

Leve
l

VC12-xv The service between user H1 and user H2 uses
a 20 Mbit/s bandwidth. Hence, 10 VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.

Serv
ice
Dire
ction

Bidirectio
nal

The service between user H1 and user H2 is a
Bidirectional service.

Avai
lable
Reso
urce
s

VC4-4 For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Avai
lable
Tim
eslot
s

VC12-11
to
VC12-20

Ten VC-12s need to be bound for the service
between user H1 and user H2. In this example,
the eleventh to the twentieth VC-12s need to
be selected in sequence.

User
H1←→
user H3

Configura
ble Ports

VCTRUN
K4

As shown in Figure 4-31, VCTRUNK4 of the
EFS8 board is used by the service between
user H1 and user H3.

Av
aila
ble
Bo
un
d
Pat
hs

Leve
l

VC12-xv The service between user H1 and user H3 uses
a 20 Mbit/s bandwidth. Hence, 10 VC-12s
need to be bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried
by VCTRUNKs of Ethernet Boards.
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User Paramete
r

Value in
This
Example

Description

Serv
ice
Dire
ction

Bidirectio
nal

The service between user H1 and user H3 is a
Bidirectional service.

Avai
lable
Reso
urce
s

VC4-4 For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Avai
lable
Tim
eslot
s

VC12-21
to
VC12-30

Ten VC-12s need to be bound for the service
between user H1 and user H3. In this example,
the twenty-first to the thirtieth VC-12s need to
be selected in sequence.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

3. Create a bridge for the EFS8 board on NE1.
l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet

Service  > Ethernet LAN Service from the Function Tree.
l Click New.

l Set the required parameters in the Create Ethernet LAN Service dialog box that is
displayed.

Parameter Value in
This
Example

Description

VB Name VB1 This parameter is a character string used to describe
the bridge. It is recommended that you set this
parameter to a character string that contains the
information about the detailed application of the
bridge.

VB Type 802.1q IEEE 802.1q bridge supports isolation by using one
layer of VLAN tags. This bridge checks the contents
of the VLAN tags that are in the packets and
performs Layer 2 switching according to the
destination MAC addresses and the VLAN IDs of
the packets.
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Parameter Value in
This
Example

Description

Bridge
Switch Mode

IVL/Ingress
Filter Enable

When the bridge adopts the SVL learning mode, all
the VLANs share the same MAC address table. That
is, the bridge learns and forwards the packets
according to the MAC address of the user packets
only. The information in the VLAN tags of the user
packets, however, is not considered in the learning
and forwarding process.

Bridge
Learning
Mode

IVL -

Ingress Filter Enabled -

l Click Configure Mount.

l In Available Mounted Ports, select PORT1, PORT2, VCTRUNK1, VCTRUNK2,

VCTRUNK3, and VCTRUNK4. Then, click .
l OK.

l In the Create Ethernet LAN Service dialog box, click OK.

4. Create a VLAN filtering table.
l Select the created bridge and click the VLAN Filtering tab.

l Click New.

l Create the VLAN filtering table for user G1, user G2, and user G3.

Parameter Value in
This
Example

Description

VLAN ID 100 According to the plan, the VLAN ID is set to 100 on
the transmission network side for EVPLAN services
between user G1, user G2, and user G3.

l In Available Forwarding Ports, select PORT1, VCTRUNK1, and VCTRUNK2. Click

. Then, click Apply.
l Create the VLAN filtering table for user H1, user H2, and user H3.

Parameter Value in
This
Example

Description

VLAN ID 200 According to the plan, the VLAN ID is set to 200 on
the transmission network side for EVPLAN services
between user H1, user H2, and user H3.

l In Available Forwarding Ports, select PORT2, VCTRUNK3, and VCTRUNK4. Click

. Then, click OK.
5. Change the Hub/Spoke attribute of the ports mounted to the bridge.
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l Select the created bridge and click the Service Mount tab.

l Change the Hub/Spoke attribute of the port mounted to the bridge. After setting the
parameters, click Apply.

Parameter Value in This
Example

Description

Hub/Spoke PORT1: Hub
VCTRUNK1:
Spoke
VCTRUNK2:
Spoke
PORT2: Hub
VCTRUNK3:
Hub
VCTRUNK4:
Hub

If user G2 need not communicate with user G3,
set VCTRUNK1 and VCTRUNK2 ports that
receive the services of user G2 and user G3 to
Spoke. Ports of the Spoke attribute cannot
communicate with each other. A port of the Hub
attribute can communicate with a port of the
Spoke or Hub attribute.

6. Configure the cross-connections from the Ethernet service to the SDH link for user G2,
user G3, user H2, and user H3.
l In the NE Explorer, select NE1, and then choose  Configuration > SDH Service

Configuration  from the Function Tree.
l Click Create on the lower-right pane to display the Create SDH Service dialog box.

Set the parameters as follows.

User Paramete
r

Value in
This
Example

Description

User
G1←→
user G2

Level VC12 The timeslot bound with the service
between user G1 and user G2 is at the
VC-12 level. The service level must be
consistent with the level of the path bound
with the VCTRUNK.

Direction Bidirectiona
l

The service between user G1 and user G2
is a Bidirectional service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK1. In the case
of VCTRUNK1, Available Resources is
set to VC4-4.
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User Paramete
r

Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the source timeslots is
consistent with the value range of
Available Timeslot, which is set for the
paths bound with VCTRUNK1. In the case
of VCTRUNK1, the value of Available
Timeslot is from VC12-1 to VC12-5.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are five
VC-12s, the sink timeslots must be five
VC-12s.

Activate
Immediatel
y

Yes -

User
G1←→
user G3

Level VC12 The timeslot bound with the service
between user G1 and user G3 is at the
VC-12 level. The service level must be
consistent with the level of the path bound
with the VCTRUNK.

Direction Bidirectiona
l

The service between user G1 and user G3
is a bidirectional service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK2. In the case
of VCTRUNK2, Available Resources is
set to VC4-4.
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User Paramete
r

Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

6-10 The value range of the source timeslots is
consistent with the value range of
Available Timeslot, which is set for the
paths bound with VCTRUNK2. In the case
of VCTRUNK2, the value of Available
Timeslot is from VC12-6 to VC12-10.

Sink Slot 8-SL4D-2
(SDH-2)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-5 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are five
VC-12s, the sink timeslots must be five
VC-12s.

Activate
Immediatel
y

Yes -

User
H1←→
user H2

Level VC12 The timeslot bound with the service
between user H1 and user H2 is at the
VC-12 level. The service level must be
consistent with the level of the path bound
with the VCTRUNK.

Direction Bidirectiona
l

The service between user H1 and user H2
is a bidirectional service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK3. In the case
of VCTRUNK3, Available Resources is
set to VC4-4.
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User Paramete
r

Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

11-20 The value range of the source timeslots is
consistent with the value range of
Available Timeslot, which is set for the
paths bound with VCTRUNK3. In the case
of VCTRUNK3, the value of Available
Timeslot is from VC12-11 to VC12-20.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

6-15 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are 10
VC-12s, the sink timeslots must be 10
VC-12s.

Activate
Immediatel
y

Yes -

User
H1←→
user H3

Level VC12 The timeslot bound with the service
between user H1 and user H3 is at the
VC-12 level. The service level must be
consistent with the level of the path bound
with the VCTRUNK.

Direction Bidirectiona
l

The service between user H1 and user H3
is a bidirectional service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK4. In the case
of VCTRUNK4, Available Resources is
set to VC4-4.
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User Paramete
r

Value in
This
Example

Description

Source
Timeslot
Range(e.g.
1,3-6)

21-30 The value range of the source timeslots is
consistent with the value range of
Available Timeslot, which is set for the
paths bound with VCTRUNK4. In the case
of VCTRUNK4, the value of Available
Timeslot is from VC12-21 to VC12-30.

Sink Slot 8-SL4D-2
(SDH-2)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

6-15 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots. For
example, if the source timeslots are 10
VC-12s, the sink timeslots must be 10
VC-12s.

Activate
Immediatel
y

Yes -

Step 2 Configure the EPL services on NE2 and NE4.

NOTE
The Ethernet services of NE2 and NE4 are point-to-point transparent transmission services. See 4.4
Configuring EPL Services on an Ethernet Transparent Transmission Board to set the parameters.

Step 3 Check whether the services are configured correctly. For the operation procedures, see 7.15
Testing Ethernet Service Channels.

Step 4 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 5 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see Deleting SDH Services.
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4.10 Configuring EVPLAN Services (IEEE 802.1ad Bridge)
The QinQ technology provides a cheap and easy solution for Layer 2 virtual private networks
(VPNs). The IEEE 802.1ad bridge uses the QinQ technology to provide the VPN solution, thus
facilitating the identifying, differentiating and grooming EVPLAN services.

4.10.1 Networking Diagram
A network operator requires that the voice over IP (VoIP) and high speed Internet (HSI) services
sent to the transmission network be uniformly labeled and groomed at the convergence node.

4.10.2 Signal Flow and Timeslot Allocation
The services of user M and user N are transmitted from the access nodes NE2 and NE4
respectively to the convergence node NE1 through the Ethernet transparent transmission boards.
VoIP and HSI services carrying different C-VLAN IDs are tagged with different S-VLAN IDs.
The service data is isolated and exchanged at Layer 2 through S-VLAN filtering.

4.10.3 Configuration Process
An EVPLAN service (IEEE 802.1ad bridge) and the corresponding S-VLAN filtering table need
to be created for the convergence node NE1. The access nodes NE2 and NE4 need to be
configured with EPL transparent transmission services only.

4.10.1 Networking Diagram
A network operator requires that the voice over IP (VoIP) and high speed Internet (HSI) services
sent to the transmission network be uniformly labeled and groomed at the convergence node.

Service Requirement
As shown in Figure 4-32, the transmission network is required to carry the VoIP and HSI
services.

User requirements:

l The VoIP services of user M and user N are sent to the transmission network at NE2 and
NE4 respectively and to the VoIP server at the convergence node NE1. The services share
a 20 Mbit/s bandwidth.

l The HSI services of user M and user N are sent to the transmission network at NE2 and
NE4 respectively and to the HSI server at the convergence node NE1. The services share
a 40 Mbit/s bandwidth.

l The VoIP services need to be isolated from the HSI services.

l The data communication equipment of user M and user N provides 100 Mbit/s Ethernet
electrical interfaces of which the working mode is auto-negotiation, and does not support
VLAN.
– C-VLAN ID of the VoIP services: 10

– C-VLAN ID of the HSI services: 20

NOTE

The application scenarios where one branch needs to communicate with other branches are as follows:

l User M needs to communicate with user N.

l User M need not communicate with user N.

If user M and user N need to communicate with each other, skip Step 1.4.
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Requirement of the operator: The operator requires that all services received from the user side
should be uniformly labeled and groomed through planned S-VLANs.

l S-VLAN ID of the VoIP services: 100
l S-VLAN ID of the HSI services: 200

Figure 4-32 Networking diagram for configuring EVPLAN services (IEEE 802.1ad bridge)
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Board Configuration Information
For the EVPLAN (IEEE 802.1ad bridge) services supported by Ethernet switching boards, refer
to Table 8-1.

In this example, the convergence node NE1 is configured with an EFS8 board that supports the
IEEE 802.1ad bridge to implement EVPLAN services in which VoIP data is isolated from HSI
data.

l The VoIP services tagged with C-VLAN ID 10 from NE2 and NE4 are further tagged with
S-VLAN ID 100 when they arrive at the IEEE 802.1ad bridge of NE1. Then, the services
are forwarded to the VoIP server through Layer 2 switching.

l The HSI services tagged with C-VLAN ID 20 from NE2 and NE4 are further tagged with
S-VLAN ID 200 when they arrive at the IEEE 802.1ad bridge of NE1. Then, the services
are forwarded to the HSI server through Layer 2 switching.

The access nodes NE2 and NE4 each are configured with an EFT8 board. The EPL services are
configured to implement transparent transmission from NE2 and NE4 to NE1.

The ISU board integrates the SCC unit, cross-connect unit, clock unit, tributary unit, line unit,
and data transparent transmission unit. The data transparent transmission unit of the ISU board
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is displayed as EFT8 on the NMS and occupies logical slot 7. The STM-4 optical interface
module of the ISU board is displayed as SL4D on the NMS and occupies logical slot 8.

NOTE
As provided in Table 8-1, the Ethernet boards are classified into the Ethernet transparent transmission
boards and Ethernet switching boards, based on the type of the accessed service. The Ethernet transparent
transmission boards only support EPL services, whereas the Ethernet switching boards support EPL
services, EVPL services, and Layer 2 switching.

4.10.2 Signal Flow and Timeslot Allocation
The services of user M and user N are transmitted from the access nodes NE2 and NE4
respectively to the convergence node NE1 through the Ethernet transparent transmission boards.
VoIP and HSI services carrying different C-VLAN IDs are tagged with different S-VLAN IDs.
The service data is isolated and exchanged at Layer 2 through S-VLAN filtering.

Figure 4-33 shows the signal flow of the EVPLAN services (IEEE 802.1ad bridge) and the
timeslot allocation to the EVPLAN services (IEEE 802.1ad bridge).

For the method of calculating the bandwidth of the Ethernet services carried by a VCTRUNK,
see 8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of Ethernet Boards.

Figure 4-33 Signal flow of and timeslot allocation to EVPLAN services (IEEE 802.1ad bridge)
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l The services of user M:

– Occupy the first to thirtieth VC-12 timeslots of the first VC-4 (VC4-1:VC12:1-30) on
the SDH link from NE1 to NE2.

– Are added and dropped by using the first to thirtieth VC-12 timeslots of the fourth VC-4
(VC4-4:VC12:1-30) on the EFS8 board of NE1 and the first to thirtieth VC-12 timeslots
of the fourth VC-4 (VC4-4:VC12:1-30) on the EFT8 board of NE2.

l The services of user N:

– Occupy the first to thirtieth VC-12 timeslots of the first VC-4 (VC4-1:VC12:1-30) on
the SDH link from NE1 to NE4.
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– Are added and dropped by the using the thirty-first to sixtieth VC-12 timeslots of the
fourth VC-4 (VC4-4:VC12:31-60) on the EFS8 board of NE1 and the first to thirtieth
VC-12 timeslots of the fourth VC-4 (VC4-4:VC12:1-30) on the EFT8 board of NE4.

Table 4-26 Parameters of external ports on the Ethernet boards

Parameter NE1 NE2 NE4

Board EFS8 EFT8 EFT8

Port PORT1 PORT2 PORT1 PORT1

Enabled/
Disabled

Enabled Enabled Enabled Enabled

Working Mode Auto-
Negotiation

Auto-
Negotiation

Auto-
Negotiation

Auto-
Negotiation

Maximum
Frame Length

1522 1522 1522 1522

Port Type C-Aware C-Aware C-Aware C-Aware

Table 4-27 Parameters of internal ports on the Ethernet boards

Parameter NE1 NE2 NE3

Board EFS8 EFT8 EFT8

Port VCTRUNK1 VCTRUNK2 VCTRUNK1 VCTRUNK1

Mapping
Protocol

GFP GFP GFP GFP

Port Type C-Aware C-Aware - -

Bound Path VC4-4:VC12-1
–VC12-30

VC4-4:VC12-3
1–VC12-60

VC4-4:VC12-1
–VC12-30

VC4-4:VC12-1
–VC12-30

Table 4-28 Parameters of Ethernet LAN services (IEEE 802.1ad bridge)

Parameter Ethernet LAN Service of NE1

Board EFS8

VB Name VB1

Bridge Type IEEE 802.1ad

Bridge Switch Mode IVL/Ingress Filter Enable

Bridge Learning Mode IVL

Ingress Filter Enabled

Operation Type Add S-VLAN base for Port and C-VLAN
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Parameter Ethernet LAN Service of NE1

VB Port 1 2 3 4

Mount Port PORT1 PORT2 VCTRUNK1 VCTRUNK2

C-VLAN 10 20 10 20 10 20

S-VLAN 100 200 100 200 100 200

VLAN
Filterin
g

VLAN
Filtering

VLAN filter table 1 VLAN filter table 2

VLAN ID 100 200

Forwarding
Physical Port

PORT1, VCTRUNK1,
VCTRUNK2

PORT2, VCTRUNK1,
VCTRUNK2

Hub/
Spoke

PORT1 Hub

PORT2 Hub

VCTRUNK
1

Spoke

VCTRUNK
2

Spoke

4.10.3 Configuration Process
An EVPLAN service (IEEE 802.1ad bridge) and the corresponding S-VLAN filtering table need
to be created for the convergence node NE1. The access nodes NE2 and NE4 need to be
configured with EPL transparent transmission services only.

Prerequisite
You must be familiar with 4.3.1 Flow of Configuring EPL Services.

Background Information
If the Ethernet switching boards in the actual application scenarios are different from the boards
in this example, you need to learn about the requirements for configuring specific boards.

l For the EVPLAN services supported by Ethernet switching boards, see 8.1 Service
Support Capability of Ethernet Boards.

l For the VCTRUNK binding requirements of Ethernet transparent transmission boards, see
8.2 Requirements for Binding Paths with VCTRUNKs on Ethernet Boards.

The IEEE 802.1ad provider bridge supports ports with the C-Aware and S-Aware attributes only.

The C-Aware ports are used to add and strip the S-VLAN tags. The S-Aware ports are used to
transparently transmit the S-VLAN tag.

The IEEE 802.1ad provider bridge supports the following operation types:

l Adding the S-VLAN tag based on the port
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l Adding the S-VLAN tag based on the port and C-VLAN

l Performing port mounting based on the port

l Performing port mounting based on the port and the S-VLAN

This topic describes the four operation types when Bridge Switch Mode of the IEEE 802.1ad
provider bridge is set to IVL/Ingress Filter Enabled.

l Adding the S-VLAN based on the port: The packets that enter the C-Aware port are added
with the preset S-VLAN tag, and are forwarded in the bridge according to the S-VLAN
filtering table. Before the packets leave the C-Aware port, the S-VLAN tag is stripped.

l Adding the S-VLAN tag based on the port and C-VLAN: The entry detection is performed
for the packets that enter the C-Aware port. Then, the corresponding S-VLAN tags are
added to the packets according to the mapping relation between the C-VLAN tags and the
S-VLAN tags of the packets. If the mapping relation does not exist, the packets are
discarded. After the S-VLAN tags are added, the packets enter the bridge, where the packets
are forwarded according to the S-VLAN filtering table. Before the packets leave the C-
Aware port, the S-VLAN tag is stripped.

NOTE

l The same C-Aware port supports different C-VLAN tags being mapped to different S-VLAN
tags, but does not support the same C-VLAN tag being mapping to multiple S-VLAN tags.

l Performing port mounting based on the port: The packets that enter the S-Aware port are
not filtered. Instead, the S-VLAN switch is performed directly. The packets must have the
S-VLAN tags. Otherwise, the packets are discarded. When the packets leave the S-Aware
port, the packets are transparently transmitted.

l Performing port mounting based on the port and the S-VLAN: The entry filtering is
performed according to the preset S-VLAN tag. The packets that do not belong to the S-
VLAN are discarded. Then, the packets are forwarded according to the S-VLAN filtering
table. When the packets leave the S-Aware port, the packets are transparently transmitted.

In the case of the four operation types, the following conditions must be met before the packets
leave a port:

l The port is contained in the S-VLAN filtering table that is created by the user.

l The S-VLAN ID corresponding to the port must be specified when the user manually
mounts the port to the bridge.
– In the case of a C-Aware port, the S-VLAN ID corresponding to the port is the S-VLAN

ID that is added when the packets enter the port.
– In the case of an S-Aware port, the S-VLAN ID corresponding to the port is the S-VLAN

ID that is set when the user mounts the port to the bridge. If the S-Aware port is mounted
based on the port, the S-VLAN ID is considered to contain all the legal S-VLAN IDs.

Procedure

Step 1 Configure the EVPLAN services on NE1.
1. Set the attributes of the external ports (PORT1 and PORT2 on the EFS8 board) used by the

VoIP server and HSI server.
l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet

Interface Management > Ethernet Interface  from the Function Tree.
l Select External Port.
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l Click the Basic Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Enabled
/
Disable
d

PORT1: Enabled
PORT2: Enabled

In this example, PORT1 and PORT2 carry
the services and Enabled/Disabled is set to
Enabled for PORT1 and PORT2.

Workin
g Mode

PORT1: Auto-
Negotiation
PORT2: Auto-
Negotiation

In this example, the VoIP server and HSI
server support the auto-negotiation mode.
Hence, Working Mode is set to Auto-
Negotiation for PORT1 and PORT2.

Maximu
m
Frame
Length

PORT1: 1522
PORT2: 1522

Generally, this parameter adopts the default
value 1522.

MAC
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The MAC loopback setting is used for fault
diagnosis. In this example, MAC
Loopback is set to Non-Loopback.

PHY
Loopba
ck

PORT1: Non-Loopback
PORT2: Non-Loopback

The PHY loopback setting is used for fault
diagnosis. In this example, PHY Loopback
is set to Non-Loopback.

l Click the Flow Control tab. The parameters in the Flow Control tab page adopt the
default values.

l Click the Network Attributes tab. After setting the parameters, click Apply.

Parameter Value in This Example Description

Port Type PORT1: C-Aware
PORT2: C-Aware

The C-Aware or S-Aware attribute
must be selected for the port when you
configure the IEEE 802.1ad bridge.
The C-Aware port connects to the port
in the client network, identifies and
processes the packets that contain C-
VLAN tags (namely, client tags). The
S-Aware port connects to the port on
the network side, identifies and
processes the packets that contain S-
VLAN tags (namely, service tags of
the network operator).

l It is unnecessary to set the parameters on the TAG Attributes tab. If the port type is
set to C-Aware or S-Aware, the parameters on the TAG Attributes are meaningless.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

2. Set the attributes of the internal ports (VCTRUNK1 and VCTRUNK2 on the EFS8 board)
used by the services of user M and N.

l Select Internal Port.
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l Click the Network Attributes tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Port
Type

VCTRUNK1: C-Aware
VCTRUNK2: C-Aware

The C-Aware or S-Aware attribute must be
selected for the port when you configure the
IEEE 802.1ad bridge. The C-Aware port
connects to the port in the client network,
identifies and processes the packets that
contain C-VLAN tags (namely, client tags).
The S-Aware port connects to the port on the
network side, identifies and processes the
packets that contain S-VLAN tags (namely,
service tags of the network operator).

l It is unnecessary to set the parameters on the TAG Attributes tab. If the port type is
set to C-Aware or S-Aware, the parameters on the TAG Attributes are meaningless.

l Click the Encapsulation/Mapping tab. After setting the parameters, click Apply.

Parame
ter

Value in This Example Description

Mappin
g
Protocol

VCTRUNK1: GFP
VCTRUNK2: GFP

In this example, the EFS4 board is used. This
parameter adopts the default value GFP.
Mapping Protocol of the VCTRUNKs on
the Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Scrambl
e

VCTRUNK1:
Scrambling mode [X43
+1]
VCTRUNK2:
Scrambling mode [X43
+1]

In this example, this parameter adopts the
default value Scrambling mode [X43+1].
Scramble of the VCTRUNKs on the
Ethernet boards of the interconnected
equipment at both ends must be set to the
same value.

Check
Field
Length

VCTRUNK1: FCS32
VCTRUNK2: FCS32

In this example, this parameter adopts the
default value FCS32. Check Field Length
of the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.

FCS
Calculat
ed Bit
Sequenc
e

VCTRUNK1: Big endian
VCTRUNK2: Big endian

When Mapping Protocol is set to GFP, FCS
Calculated Bit Sequence is set to Big
endian. FCS Calculated Bit Sequence of
the VCTRUNKs on the Ethernet boards of
the interconnected equipment at both ends
must be set to the same value.
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Parame
ter

Value in This Example Description

Extensi
on
Header
Option

VCTRUNK1: No
VCTRUNK2: No

When Mapping Protocol is set to GFP, this
parameter is valid and adopts the default
value No. Extension Header Option of the
VCTRUNKs on the Ethernet boards of the
interconnected equipment at both ends must
be set to the same value.

l This operation is optional. Click the LCAS tab. After setting the parameters, click
Apply.

Parame
ter

Value in This Example Description

Enablin
g LCAS

VCTRUNK1: Enabled
VCTRUNK2: Enabled

In this example, Enabling LCAS is set to
Enabled.

LCAS
Mode

VCTRUNK1: Huawei
Mode
VCTRUNK2: Huawei
Mode

In this example, this parameter adopts the
default value Huawei Mode. If the
interconnected equipment at both ends is
Huawei equipment, LCAS Mode is set to
Huawei Mode for the interconnected
equipment.

Hold off
Time
(ms)

VCTRUNK1: 2000
VCTRUNK2: 2000

In this example, this parameter adopts the
default value 2000. You can set this
parameter according to the expected hold off
time of LCAS switching.

WTR
Time(s)

VCTRUNK1: 300
VCTRUNK2: 300

In this example, this parameter adopts the
default value 300. You can set this parameter
according to the expected WTR duration of
LCAS recovery.

TSD VCTRUNK1: Disabled
VCTRUNK2: Disabled

In this example, TSD is set to Disabled. In
this case, the LCAS protocol does not
monitor the status of the B3 or BIP bit errors
of a VCTRUNK member.

l Click the Bound Path tab. Click the Configuration button. Set the following in the
Bound Path Configuration dialog box that is displayed. Then, click Apply.

User Paramet
er

Value in
This
Example

Description

User
M

Configura
ble Ports

VCTRUN
K1

As shown in Figure 4-33, VCTRUNK1 of the
EFS8 board is used by the service of user M.
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User Paramet
er

Value in
This
Example

Description

Av
aila
ble
Bo
und
Pat
hs

Lev
el

VC12-xv The service of user M uses a 60 Mbit/s
bandwidth. Hence, 30 VC-12s need to be
bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried by
VCTRUNKs of Ethernet Boards.

Ser
vic
e
Dir
ecti
on

Bidirection
al

The service of user M is a bidirectional service.

Av
aila
ble
Res
our
ces

VC4-4 For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Av
aila
ble
Ti
me
slot
s

VC12-1 to
VC12-30

Thirty VC-12s need to be bound for user M. In
this example, the first to the thirtieth VC-12s
need to be selected in sequence.

User N Configura
ble Ports

VCTRUN
K2

As shown in Figure 4-33, VCTRUNK2 of the
EFS8 board is used by the service of user N.

Av
aila
ble
Bo
und
Pat
hs

Lev
el

VC12-xv The service of user N uses a 60 Mbit/s
bandwidth. Hence, 30 VC-12s need to be
bound.
For the method of computing the bound
timeslots based on the service bandwidth, see
8.3 Ethernet Service Bandwidths Carried by
VCTRUNKs of Ethernet Boards.

Ser
vic
e
Dir
ecti
on

Bidirection
al

The service of user N is a bidirectional service.
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User Paramet
er

Value in
This
Example

Description

Av
aila
ble
Res
our
ces

VC4-4 For the resources used by other boards, see 8.2
Requirements for Binding Paths with
VCTRUNKs on Ethernet Boards.

Av
aila
ble
Ti
me
slot
s

VC12-31
to
VC12-60

Thirty VC-12s need to be bound for user N. In
this example, the thirty-first to the sixtieth
VC-12s need to be selected in sequence.

l Click the Advanced Attributes tab. The parameters in the Advanced Attributes tab
page adopt the default values.

3. Create a bridge for the EFS8 board on NE1.
l In the NE Explorer, select the EFS8 board, and then choose  Configuration > Ethernet

Service  > Ethernet LAN Service from the Function Tree.
l Click New.

l Set the required parameters in the Create Ethernet LAN Service dialog box that is
displayed.

Parameter Value in
This
Example

Description

VB Name VB1 This parameter is a character string used to describe
the bridge. It is recommended that you set this
parameter to a character string that contains the
information about the detailed application of the
bridge.

VB Type 802.1ad The IEEE 802.1ad bridge supports data frames with
two layers of VLAN tags. This bridge adopts the
outer S-VLAN tags to isolate different VLANs and
supports only the mounted ports whose attributes are
C-Aware or S-Aware.

Bridge
Switch Mode

IVL/Ingress
Filter Enable

This bridge checks the contents of the VLAN tags
that are in the packets and performs Layer 2
switching according to the destination MAC
addresses and the S-VLAN IDs of the packets.

Bridge
Learning
Mode

IVL -

Ingress Filter Enabled -
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l Click Configure Mount.

l Set the parameters for service mounting in the Service Mount Configuration dialog
box that is displayed.

Attribute Attribute Value

Operation
Type

Adding S-VLAN tags based on Port and C-VLAN

VB Port 1 2 3 4

Mount Port PORT1 PORT2 VCTRUNK1 VCTRUNK2

C-VLAN 10 20 10 20 10 20

S-VLAN 100 200 100 200 100 200

l Click OK.

l In the Create Ethernet LAN Service dialog box, click OK.

4. Create a VLAN filtering table.
l Select the created bridge and click the VLAN Filtering tab.

l Click New.

l Create the VLAN filtering table of the VoIP service.

Parameter Value in
This
Example

Description

VLAN ID 100 According to the plan, the S-VLAN ID is 100 for the
VoIP service.

l In Available Forwarding Ports, select PORT1, VCTRUNK1, and VCTRUNK2. Click

. Then, click Apply.
l Create the VLAN filtering table of the HSI service.

Parameter Value in
This
Example

Description

VLAN ID 200 According to the plan, the S-VLAN ID is 200 for the
HSI service.

l In Available Forwarding Ports, select PORT2, VCTRUNK1, and VCTRUNK2. Click

. Then, click OK.
5. Change the Hub/Spoke attribute of the ports mounted to the bridge.

NOTE

If user M and user N need to communicate with each other, proceed to Step 1.6.

l Select the created bridge and click the Service Mount tab.

l Change the Hub/Spoke attribute of the port mounted to the bridge.
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Parameter Value in This
Example

Description

Hub/Spoke PORT1: Hub
PORT2: Hub
VCTRUNK1:
Spoke
VCTRUNK2:
Spoke

User M and user N need not communicate with
each other. In this case, set VCTRUNK1 and
VCTRUNK2 that access the services of user M
and user N to the Spoke attribute. Ports of the
Spoke attribute cannot communicate with each
other.
A port of the Hub attribute can communicate
with a port of the Spoke or Hub attribute.

6. Configure the cross-connections from the Ethernet service to the SDH link for user M and
user N.

l In the NE Explorer, select NE1, and then choose  Configuration > SDH Service
Configuration  from the Function Tree.

l Click Create on the lower-right pane to display the Create SDH Service dialog box.
Set the parameters as follows.

User Paramete
r

Value in
This
Example

Description

User M Level VC12 The timeslot bound with the service of user
M is at the VC-12 level. The service level
must be consistent with the level of the path
bound with the VCTRUNK.

Direction Bidirectiona
l

The service of user M is a bidirectional
service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK1. In the case
of VCTRUNK1, Available Resources is
set to VC4-4.

Source
Timeslot
Range(e.g.
1,3-6)

1-30 The value range of the source timeslots is
consistent with the value range of
Available Timeslot, which is set for the
paths bound with VCTRUNK1. In the case
of VCTRUNK1, the value of Available
Timeslot is from VC12-1 to VC12-30.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.
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User Paramete
r

Value in
This
Example

Description

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.

Sink
Timeslot
Range(e.g.
1,3-6)

1-30 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of sink timeslots must be, however,
consistent with the number of sink
timeslots.

Activate
Immediatel
y

Yes -

User N Level VC12 The timeslot bound with the service of user
N is at the VC-12 level. The service level
must be consistent with the level of the path
bound with the VCTRUNK.

Direction Bidirectiona
l

The service of user N is a bidirectional
service.

Source Slot 4-EFS8-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the Ethernet board as the source slot.

Source
VC4

VC4-4 The value range of Source VC4 is
consistent with the value range of
Available Resources, which is set for the
paths bound with VCTRUNK2. In the case
of VCTRUNK2, Available Resources is
set to VC4-4.

Source
Timeslot
Range(e.g.
1,3-6)

31-60 The value range of the source timeslots is
consistent with the value range of
Available Timeslot, which is set for the
paths bound with VCTRUNK2. In the case
of VCTRUNK2, the value of Available
Timeslot is from VC12-31 to VC12-60.

Sink Slot 8-SL4D-1
(SDH-1)

When you create a bidirectional SDH
service from an Ethernet board to a line
board, it is recommended that you set the
slot of the line board as the sink slot.

Sink VC4 VC4-1 In this example, VC4-1 is specified as the
VC-4 timeslot of the Ethernet service on the
line board.
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User Paramete
r

Value in
This
Example

Description

Sink
Timeslot
Range(e.g.
1,3-6)

1-30 The value range of the sink timeslots can be
the same as or different from the value
range of the source timeslots. The number
of source timeslots must be, however, the
same as the number of sink timeslots.

Activate
Immediatel
y

Yes -

Step 2 Configure the EPL services on NE2 and NE4.

NOTE
The Ethernet services of NE2 and NE4 are point-to-point transparent transmission services. See 4.4
Configuring EPL Services on an Ethernet Transparent Transmission Board to set the parameters.

Step 3 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 4 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End

Relevant Task
If the services are configured incorrectly and thus need to be deleted, see Deleting SDH Services.
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5 Configuring Broadcast Data Services

About This Chapter

When the OptiX OSN equipment is connected to the data terminal equipment through the
broadcast data port and is configured with broadcast data services, the broadcast data
communication can be realized.

5.1 Basic Concepts
The equipment uses the RS232 or RS422 broadcast data port to realize the full-duplex
communication of the universal asynchronous receiver/transmitter (UART).

5.2 Networking Diagram
NE1 is configured with the monitoring host. NE2, NE3, and NE4 are configured with the
environment monitors. Communication between the monitoring host and the environment
monitors is required.

5.3 Signal Flow and Timeslot Allocation
Before you configure the broadcast data services, you need to learn the signal flow of a broadcast
data service according to the networking diagram.

5.4 Configuration Process
To meet the requirements for the broadcast data services between the monitoring host and the
environment monitors, you need to configure the broadcast data services of NE1–NE4.
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5.1 Basic Concepts
The equipment uses the RS232 or RS422 broadcast data port to realize the full-duplex
communication of the universal asynchronous receiver/transmitter (UART).

Overview
The data is transparently transmitted through the broadcast data port. Hence, you need not
configure the port rate and transmission control protocol. The maximum transmission rate is
19.2 kbit/s. The broadcast data port is connected to the data terminal equipment. Hence, you can
configure the point-to-point and point-to-multipoint communication modes. The data can be
broadcast to multiple optical interfaces.

As shown in Figure 5-1, the overheads SERIAL1–SERIAL4 can be used as the broadcast data
channels. The broadcast data port uses the RJ-45 connector. For the pin assignment of the
broadcast data port, refer to Table 5-1.

NOTE

The broadcast data port accesses the asynchronous data and then transmits the data to the opposite end over
byte SERIAL1, SERIAL2, SERIAL3, or SERIAL4. The opposite end receives the digital signal and
converts the digital signal into an asynchronous serial signal.

Figure 5-1 Overhead channel

A1 A1 A1 A2 A2 A2 J0

B1 E1 F1

D1 D2 D3 Serial1 Serial2

AU_PTR

B2 B2 B2 K1 K2

D4 Serial4 D5 D6

D7 D8 D9

D10 D11 D12 Serial3

S1 M1 E2
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Table 5-1 Pin assignment of the broadcast data port

RJ-45 Connector Pin
Numbe
r

Signal Description

Pin 1
Pin 8

1 422TXD+ RS422 TX+

2 422TXD- RS422 TX-

3 422RXD+ RS422 RX+

4 232RXD RS232 RX

5 GND Grounding

6 422RXD- RS422 RX-

7 N.C Not defined

8 232TXD RS232 TX

Requirements of the Environment Monitor

The environment monitor has the following requirements for the power level and transmission
rate of the port:

l The port must be of the RS232 level, where logic 1 ranges from –5 V to –15 V and logic
0 ranges from +5 V to +15 V.

l When the data is not transmitted, the port must be of the RS232 high level (approximately
–9 V). Only one slave station can transmit data to the master station at a time.

l The maximum rate must not exceed 19.2 kbit/s.

Precautions for Configuring the Broadcast Data Port

When you configure the broadcast data port, note the following points (including the
configuration of the optical interfaces and the direction of the signal flow):

l The optical interfaces that are not required must not be configured in the broadcast domain
of the broadcast data port.

l The NEs where the broadcast ports are not used must not be configured in the broadcast
domain.

l It is recommended that the signal flow is in the same direction as the NE clock tracing
direction.

5.2 Networking Diagram
NE1 is configured with the monitoring host. NE2, NE3, and NE4 are configured with the
environment monitors. Communication between the monitoring host and the environment
monitors is required.

As shown in Figure 5-2, the service requirements are as follows:
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l NE1 is configured with the monitoring host. NE2, NE3, and NE4 are configured with the
environment monitors.

l The monitoring host functions as the master station, controls the data reporting from NE2,
NE3, and NE4, and broadcasts commands to the environment monitors of NE2, NE3, and
NE4.

l The environment monitors of NE2, NE3, and NE4 function as the slave stations, collect
data, and report the data to the monitoring host.

Figure 5-2 Networking diagram of the broadcast data port
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5.3 Signal Flow and Timeslot Allocation
Before you configure the broadcast data services, you need to learn the signal flow of a broadcast
data service according to the networking diagram.

l During the communication between the master station and the slave station, the signal flow
is as follows:

– The data of the monitoring host is added to the SDH line board of NE1 through the
broadcast data port of NE1 and is then transmitted towards the directions of NE2 and
NE4.

– On the NE2 side, the data that is transmitted from the NE1 side is dropped to the
broadcast data port of NE2 through the SDH line board of NE2, and is then transmitted
to the environment monitor of NE2. That is, the data of the monitoring host is transmitted
to the environment monitor on the NE2 side. At the same time, the data of the monitoring
host passes through the SDH line board and is then transmitted to the direction of NE3.

– On the NE3 side, the data that passes through the NE2 side is dropped to the broadcast
data port of NE3 through the SDH line board of NE3, and is then transmitted to the
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environment monitor of NE3. That is, the data of the monitoring host is transmitted to
the environment monitor on the NE3 side.

– On the NE4 side, the data that is transmitted from the NE1 side is dropped to the
broadcast data port of NE4 through the SDH line board of NE4 and is then transmitted
to the environment monitor of NE4. That is, the data of the monitoring host is transmitted
to the environment monitor on the NE4 side.

l The signal flow from each slave station to the master station is in the opposite direction to
the signal flow from the master station to each slave station.

You can determine the overhead bytes, source, and sink of the broadcast data of each NE
according to the service signal flow and Table 5-2.

Table 5-2 NE parameters

NE Overhead
Interface

Broadcast Data Source Broadcast Data Sink

NE1 SERIAL1 SERIAL1 8-SL4D-1, 8-SL4D-2

NE2 SERIAL1 8-SL4D-2 8-SL4D-1, SERIAL1

NE3 SERIAL1 8-SL4D-2 SERIAL1

NE4 SERIAL1 8-SL4D-1 SERIAL1

NOTE

After the settings are performed for NE1, NE1 broadcasts the data that is input from the broadcast data
source (broadcast data port) to the directions of the 8-SL4D-1 and 8-SL4D-2 at the same time. The 8-
SL4D-1 and 8-SL4D-2 transmit the input data to the broadcast data port. Hence, only one environment
monitor can transmit data to the monitoring host at a time.

5.4 Configuration Process
To meet the requirements for the broadcast data services between the monitoring host and the
environment monitors, you need to configure the broadcast data services of NE1–NE4.

Prerequisite
l The 2 Creating the Network task must be completed.

l You must be familiar with 5.3 Signal Flow and Timeslot Allocation.

Precautions

CAUTION
l The OptiX OSN 500 supports a maximum of six broadcast data sinks.

l When you configure the broadcast data ports, ensure that the broadcast data ports do not form
a loop. Certain optical interfaces cannot be configured as the broadcast data ports.
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Procedure

Step 1 To configure the broadcast data service of NE1, do as follows:
l In the NE Explorer, select NE1, and then choose  Configuration > Orderwire from the

Function Tree.
l Click the Broadcast Data Port tab and set the parameters as listed in the following table.

Then, click Apply.

Paramet
er

Value
in This
Exampl
e

Description

Overhea
d Byte

SERIAL
1

Select the broadcast data channel that needs to be set. Selects one
from SERIAL1, SERIAL2, SERIAL3, and SERIAL4, which
correspond to the SERIAL1, SERIAL2, SERIAL3, and SERIAL4
bytes as shown in Table 5-2. In this example, select SERIAL1.

Working
Mode

RS232 Set the working mode of the selected broadcast data port.

Broadcas
t Data
Source

SERIAL
1

The broad data source indicates the source channel of the
broadcast data.

Broadcas
t Data
Sink

8-
SL4D-2
and 8-
SL4D-1

The broadcast data sink indicates the sink channel of the broadcast
data. In the broadcast mode, one broadcast data source can
correspond to multiple broadcast data sinks.

Step 2 To configure the broadcast data service of NE2, do as follows:

l Click the quick NE switching icon  and select NE2. Click OK.

l In the NE Explorer, select NE2, and then choose  Configuration > Orderwire from the
Function Tree.

l Click the Broadcast Data Port tab and set the parameters as listed in the following table.
Then, click Apply.

Parameter Value in
This
Example

Description

Overhead Byte SERIAL1 Select the broadcast data channel that needs
to be set. The setting must be the same as the
setting of NE1.

Working
Mode

RS232 Set the working mode of the selected
broadcast data port.

Broadcast
Data Source

8-SL4D-2 The broad data source indicates the source
channel of the broadcast data.
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Parameter Value in
This
Example

Description

Broadcast
Data Sink

8-SL4D-1 and
SERIAL1

The broadcast data sink indicates the sink
channel of the broadcast data. In the
broadcast mode, one broadcast data source
can correspond to multiple broadcast data
sinks.

Step 3 To configure the broadcast data service of NE3, do as follows:

l Click the quick NE switching icon  and select NE3. Click OK.

l In the NE Explorer, select NE3, and then choose  Configuration > Orderwire from the
Function Tree.

l Click the Broadcast Data Port tab and set the parameters as listed in the following table.
Then, click Apply.

Parameter Value in
This
Example

Description

Overhead Byte SERIAL1 Select the broadcast data channel that needs
to be set. The setting must be the same as the
setting of NE1.

Working
Mode

RS232 Set the working mode of the selected
broadcast data port.

Broadcast
Data Source

8-SL4D-2 The broad data source indicates the source
channel of the broadcast data.

Broadcast
Data Sink

SERIAL1 The broadcast data sink indicates the sink
channel of the broadcast data.

Step 4 To configure the broadcast data service of NE4, do as follows:

l Click the quick NE switching icon  and select NE4. Click OK.

l In the NE Explorer, select NE4, and then choose  Configuration > Orderwire from the
Function Tree.

l Click the Broadcast Data Port tab and set the parameters as listed in the following table.
Then, click Apply.

Parameter Value in
This
Example

Description

Overhead Byte SERIAL1 Select the broadcast data channel that needs
to be set. The setting must be the same as the
setting of NE1.

Working
Mode

RS232 Set the working mode of the selected
broadcast data port.
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Parameter Value in
This
Example

Description

Broadcast
Data Source

8-SL4D-1 The broad data source indicates the source
channel of the broadcast data.

Broadcast
Data Sink

SERIAL1 The broadcast data sink indicates the sink
channel of the broadcast data.

Step 5 Enable the performance monitoring function of the NEs. For details, see 7.5 Setting
Performance Monitoring Parameters of an NE.

Step 6 Back up the configuration data of the NEs. For details, see 7.16 Backing Up the NE Database
to the SCC Board.

----End
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6 Modifying the Configuration Data

About This Chapter

When you need to adjust the existing configuration data related to topologies and services, you
can modify the configuration data.

6.1 Modifying NE Attributes
You can modify the existing NE configuration data that needs adjustment.

6.2 Modifying the Board Configuration Data
You can modify the existing board configuration data that needs adjustment.

6.3 Modifying the Fiber Configuration Data
You can modify the existing fiber configuration data that needs adjustment.

6.4 Modifying the Service Configuration Data
You can modify the existing service configuration data that needs adjustment.

6.5 Modifying the Protection Subnet
This topic describes how to modify the configuration data of the existing protection subnet.
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6.1 Modifying NE Attributes
You can modify the existing NE configuration data that needs adjustment.

6.1.1 Modifying the NE ID
The ECC protocol uses the NE ID as the unique identifier of an NE. The T2000 also uses the
NE ID to identify different NEs in the user interface and databases, and uses the NE ID as the
key word in searches. Hence, you need to assign a unique NE ID to each NE when planning a
network. If an NE ID conflicts with another NE, it results a collision in the ECC route. As a
result, it becomes difficult to manage some NEs. In the commissioning or expansion process,
when you need to adjust the original planning and modify the NE ID, you can use the T2000 to
achieve it.

6.1.2 Modifying the NE Name
You can modify the NE name as required. This operation does not affect the running of the NE.

6.1.3 Deleting NEs
If you have created a wrong NE, you can delete the NE from the T2000. Deleting an NE removes
all information of the NE from the T2000 but does not affect the running of the equipment.

6.1.4 Modifying GNE Parameters
During the network optimization and adjustment, you may need to change the GNE type or
modify the communication address.

6.1.5 Changing the GNE for NEs
When the GNE that the non-gateway NE belongs to is changed and this non-gateway NE does
not belong to another GNE, you need to change the GNE to maintain the communication between
the NEs and the T2000. Alternatively, if a GNE manages more than 50 NEs, change the GNE
for some NEs so that the communication between the T2000 and the NEs is not affected.

6.1.1 Modifying the NE ID
The ECC protocol uses the NE ID as the unique identifier of an NE. The T2000 also uses the
NE ID to identify different NEs in the user interface and databases, and uses the NE ID as the
key word in searches. Hence, you need to assign a unique NE ID to each NE when planning a
network. If an NE ID conflicts with another NE, it results a collision in the ECC route. As a
result, it becomes difficult to manage some NEs. In the commissioning or expansion process,
when you need to adjust the original planning and modify the NE ID, you can use the T2000 to
achieve it.

Prerequisite
l You must be an NM user with "NE operator" authority or higher.

l The NE must be created.

Precautions

CAUTION
Modifying the NE ID may interrupt NE communication and reset the NE.
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Procedure

Step 1 In the NE Explorer, select an NE and choose  Configuration > NE Attribute  from the Function
Tree.

Step 2 Click Modify NE ID, and the Modify NE ID dialog box is displayed.

Step 3 Enter the New ID and the New Extended ID. Click OK.

Step 4 Click OK in the Warning dialog box.

----End

6.1.2 Modifying the NE Name
You can modify the NE name as required. This operation does not affect the running of the NE.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Procedure

Step 1 In the NE Explorer, click the NE and choose Configuration > NE Attribute from the Function
Tree.

Step 2 In the NE Attribute dialog box, enter a new NE name in Name. Click Apply. A prompt appears
telling you that the operation was successful.

NOTE

An NE name can contain a maximum of 64 letters, symbols, and numerals, but cannot contain the following
special characters: | : * ? " < >.

Step 3 Click Close.

----End

6.1.3 Deleting NEs
If you have created a wrong NE, you can delete the NE from the T2000. Deleting an NE removes
all information of the NE from the T2000 but does not affect the running of the equipment.

Prerequisite
You must be an NM user with "NM maintainer" authority or higher.

Context

CAUTION
If an NE is deleted, the links related to the NE are also deleted.
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Procedure
l Delete a single SDH PTN NE.

1. Right-click the NE on the Main Topology and choose  Delete > Delete Device  from
the shortcut menu. The Confirm dialog box is displayed.

2. Click Yes. The Delete Device Results dialog box is displayed.
3. Click Close, The NE icon is deleted from the Main Topology.

l Delete NEs in batches.
1. Choose Configuration  > Configuration Data Management from the Main Menu.

The Configuration Data Management window is displayed.

2. In the left-hand pane, select multiple NEs and click . The Configuration Data
Management List pane displays the configuration data of all the selected NEs.

3. Select the NEs to be deleted, right-click and choose Delete from the shortcut menu.
The Delete the NE dialog box is displayed.

4. Click OK.

----End

6.1.4 Modifying GNE Parameters
During the network optimization and adjustment, you may need to change the GNE type or
modify the communication address.

Prerequisite
You must be an NM user with "NE maintainer" authority or higher.

Precautions

CAUTION
This operation is risky, because it may interrupt the communication.

Procedure

Step 1 Choose System > DCN Management from the Main Menu. Click the GNE tab.

Step 2 Select the GNE to be modified, right-click and choose Modify GNE from the shortcut menu.

Step 3 In the Modify GNE dialog box displayed, set Gateway Type .

l When Gateway Type is set to IP Gateway, modify IP Address.
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l When Gateway Type is set to OSI Gateway, modify NSAP Address.

NOTE

l Do not modify the Port No..

l Make sure that the IP address of the GNE is in the same network segment as the IP address of the
T2000. If they are not in the same network segment, set the corresponding network ports, to make sure
that the T2000 can log in to the GNE.

Step 4 Click OK. In the Operation Result dialog box that is displayed, click Close.

----End

6.1.5 Changing the GNE for NEs
When the GNE that the non-gateway NE belongs to is changed and this non-gateway NE does
not belong to another GNE, you need to change the GNE to maintain the communication between
the NEs and the T2000. Alternatively, if a GNE manages more than 50 NEs, change the GNE
for some NEs so that the communication between the T2000 and the NEs is not affected.

Prerequisite
You must be an NM user with "NE maintainer" authority or higher.
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Procedure

Step 1 Choose System > DCN Management from the Main Menu.

Step 2 Click the NE tab.

Step 3 Select an NE. Double-click the Primary GNE1 field and select a GNE from the drop-down list.

Step 4 Click Apply. Click Close in the Operation Result dialog box.

Step 5 Click Refresh.

----End

6.2 Modifying the Board Configuration Data
You can modify the existing board configuration data that needs adjustment.

6.2.1 Adding Boards
When manually configuring the NE dataAfter the NE data is configured, if physical boards are
added, you need to add boards on the NE Panel. You can either add the physical boards that
actually operate on the NE or add the logical boards that do not exist on the actual equipment.

6.2.2 Deleting Boards
To modify the network configuration or the NE configuration, you may need to delete the boards
from the NE Panel.

6.2.3 Modifying Board Configuration Parameters
You can modify the existing board configuration data that needs adjustment.

6.2.1 Adding Boards
When manually configuring the NE dataAfter the NE data is configured, if physical boards are
added, you need to add boards on the NE Panel. You can either add the physical boards that
actually operate on the NE or add the logical boards that do not exist on the actual equipment.

Prerequisite
l You must be an NM user with "NE operator" authority or higher.

l The NE must be created.

l There must be idle slot on the NE Panel.

Context
The physical boards are the actual boards inserted in the subrack. The logical boards are created
on the T2000 and are saved on the SCC board, but they do not exist on the actual equipment.

NOTE

The NE panel is able to indicate the mapping relation between slots that house processing boards and
interface boards. When you click a processing board that is paired with an interface board in the NE panel,
the ID of the slot that houses the mapping interface board is displayed in orange.
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Procedure

Step 1 Double-click the icon of the NE to open the NE Panel.

Step 2 Right-click the selected idle slot. Select the board you want to add from the drop-down list.

NOTE
If the cross-connect board is installed in the subrack, add its corresponding logical board on the T2000.

----End

6.2.2 Deleting Boards
To modify the network configuration or the NE configuration, you may need to delete the boards
from the NE Panel.

Prerequisite
l You must be an NM user with "NE maintainer" authority or higher.

l The services and protection groups must be deleted.

Procedure

Step 1 Double-click the icon of the NE to open the NE Panel.

Step 2 Right-click the board you want to delete and choose  Delete  from the shortcut menu.

NOTE

Some boards, such as PIU and AUX boards, cannot be deleted.

Step 3 Click OK in the Delete Board dialog box.

Step 4 Click OK to delete the board.

----End

6.2.3 Modifying Board Configuration Parameters
You can modify the existing board configuration data that needs adjustment.

Prerequisite
To modify different configuration parameters of different boards, you may need to operate as
NM users with different authorities. You must be an NM user with "NE operator" authority or
higher. must be available at least.

Procedure

Step 1 In the NE Explorer, select a board and choose a proper item from the Function Tree.

Board Type Parameters

SDH board Multiplex section shared attribute, laser
enabling/disabling, optical interface
loopback, hardware REG enabling
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Board Type Parameters

PDH board Tributary loopback, service load indication

Ethernet board Port enabling, working mode, maximum
frame length, MAC loopback, PHY
loopback, TAG, entry test

Step 2 In the right-hand pane, modify the existing parameter settings and click Apply.

----End

6.3 Modifying the Fiber Configuration Data
You can modify the existing fiber configuration data that needs adjustment.

6.3.1 Deleting Fibers
When adjusting the network if you need to delete the NEs or change the links between NEs, you
need to delete the fiber connections between the NEs.

6.3.2 Modifying Fiber Cable Information
You can modify the name, attenuation, length, and type of a fiber cable according to its
connection status and physical features.

6.3.3 Deleting DCN Communication Cables
In certain scenarios such as network adjustment, you can delete an unwanted DCN
communication cable that is created previously.

6.3.1 Deleting Fibers
When adjusting the network if you need to delete the NEs or change the links between NEs, you
need to delete the fiber connections between the NEs.

Prerequisite
You must be an NM user with "NE maintainer" authority or higher.

Procedure
Step 1 Choose File > Fiber/Cable Management from the Main Menu.

Step 2 Select the fiber you want to delete, right-click and choose  Delete Fiber/Cable from the shortcut
menu. The Warning dialog box is displayed. Click OK to delete the fiber cable.

Step 3 Click Close in the Operation Result dialog box.

----End

6.3.2 Modifying Fiber Cable Information
You can modify the name, attenuation, length, and type of a fiber cable according to its
connection status and physical features.

Prerequisite
You must be an NM user with "NE maintainer" authority or higher.
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Procedure

Step 1 Choose File > Fiber/Cable Management from the Main Menu. The information of all fiber
cables is displayed in the pane on the right.

Step 2 In the Name column, right-click the value for a fiber cable and choose Modify Fiber/Cable
from the shortcut menu. In the Modify Fiber/Cable dialog box displayed, enter a proper name
for the fiber cable and click OK. Click Close in the Operation Result dialog box.

Step 3 In the Length(km) column, right-click the value for a fiber cable and choose Modify Fiber/
Cable from the shortcut menu. In the Modify Fiber/Cable dialog box displayed, enter the actual
length for the fiber cable and click OK. Click Close in the Operation Result dialog box.

Step 4 Modify the attenuation of a fiber.

1. In the Attenuation column, right-click the value for a fiber and choose Modify Fiber/
Cable from the shortcut menu.

2. In the Modify Fiber/Cable dialog box, enter the actual loss and click OK. Click Close in
the Operation Result dialog box.

Step 5 Modify the type of the fiber.

1. In the Type column, right-click the value for a fiber and choose Modify Fiber/Cable from
the shortcut menu.

2. In the Modify Fiber/Cable dialog box displayed, select the actual type of the fiber from
the drop-down list and click OK. Click Close in the Operation Result dialog box.

----End

6.3.3 Deleting DCN Communication Cables
In certain scenarios such as network adjustment, you can delete an unwanted DCN
communication cable that is created previously.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Procedure

Step 1 On the Main Topology, select a cable, right-click and choose  Delete from the shortcut menu.

Step 2 In the Delete Link dialog box displayed, click OK.

----End

6.4 Modifying the Service Configuration Data
You can modify the existing service configuration data that needs adjustment.

6.4.1 Modifying SDH Services
To modify an SDH service, you can use the modification function of the T2000, or delete the
service and then create the cross-connection again.

6.4.2 Deleting SDH Services
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You can delete an existing SDH service.

6.4.3 Deleting Ethernet Private Line Services
Ethernet private line services need to be deleted when the Ethernet boards that are configured
with the Ethernet private line services need to be deleted or when the service configuration is
incorrect.

6.4.4 Deleting EPLAN Services
EPLAN services need to be deleted when the Ethernet boards that are configured with the
EPLAN services need to be deleted or when the configuration of the EPLAN services is incorrect.

6.4.5 Deleting EVPLAN Services
EVPLAN services need to be deleted when the Ethernet boards that are configured with the
EVPLAN services need to be deleted or when the configuration of the EVPLAN services is
incorrect.

6.4.1 Modifying SDH Services
To modify an SDH service, you can use the modification function of the T2000, or delete the
service and then create the cross-connection again.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Context

CAUTION
Performing this operation interrupts the service that you modify.

Procedure

Step 1 In the NE Explorer, select an NE and choose Configuration > SDH Service Configuration
from the Function Tree.

Step 2 Select a cross-connection and choose Display > Expand to Unidirectional.

Step 3 Optional: If the service to be modified is active, you should deactivate the service. Select the
service that you want to modify, and click Deactivate.

CAUTION
Deactivation will interrupt services.

Step 4 Click OK in the Confirm dialog box is displayed twice. The Operation Result dialog box is
displayed telling you that the operation was successful.

Step 5 Click Close.
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Step 6 After the cross-connection is deactivated, modify the SDH service in the mode in Step 7 or Step
8.

NOTE

l By using the mode in Step 7, you can modify the source or sink of a service, but the source and sink
must be on the same board before and after the modification.

l If the modification requirement cannot be met in the mode in Step 7 (for example, a pass-through
service needs to be configured to the local through modification), you can delete the original service
and create the cross-connection again in the mode in Step 8, to achieve the modification.

Step 7 Optional: To modify the SDH service, choose Modify from the shortcut menu.
1. Select the service that you want to modify, right-click, and choose Modify from the shortcut

menu. The Modify SDH Service dialog box is displayed.
2. Modify Source VC4 or Sink VC4, Source Timeslot Range, and Sink Timeslot Range.

NOTE

In this mode, you can modify only Source VC4 or Sink VC4. The source VC4 and sink VC4 cannot
be modified at the same time.

3. Click OK. The Operation Result dialog box is displayed telling you that the operation
was successful.

4. Click Close.
5. Select the service that is modified, and click Activate.
6. Click OK. The Operation Result dialog box is displayed.
7. Click Close.

Step 8 Optional: To modify the SDH service, delete the service and then create the service again.
1. Select the service that you want to modify, and click Delete.
2. Click OK and the Operation Result dialog box is displayed telling you that the operation

was successful.
3. Click Close. The service is deleted.
4. Create the service again as required. For details, see Creating SDH Services.

----End

6.4.2 Deleting SDH Services
You can delete an existing SDH service.

Prerequisite

You must be an NM user with "NE operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select an NE and choose Configuration > SDH Service Configuration
from the Function Tree.

Step 2 Click Query to query existing services.

Step 3 Optional: If the service to be deleted is active, you should deactivate the service. Select the
service that you want to delete and click Deactivate.
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CAUTION
Deactivation will interrupt services.

Step 4 Select the desired service and click Delete.

Step 5 In the Confirm dialog box displayed, click OK.

Step 6 In the Operation Result dialog box displayed, click Close.

----End

6.4.3 Deleting Ethernet Private Line Services
Ethernet private line services need to be deleted when the Ethernet boards that are configured
with the Ethernet private line services need to be deleted or when the service configuration is
incorrect.

Prerequisite
l You must be an NM user with "NE or network operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select an Ethernet board and then choose Configuration  > Ethernet
Service > Ethernet Line Service from the Function Tree.

Step 2 Click Query.

Step 3 Select the Ethernet private line service to be deleted and click Delete. Click OK in the
Prompt dialog box that is displayed. Then, a dialog box is displayed, indicating that the operation
is successful, that is, the Ethernet private line service is deleted successfully.

Step 4 Click Query to check whether the Ethernet private line service is deleted.

Step 5 See 6.4.2 Deleting SDH Services to delete the cross-connections of the Ethernet private line
service.

----End

6.4.4 Deleting EPLAN Services
EPLAN services need to be deleted when the Ethernet boards that are configured with the
EPLAN services need to be deleted or when the configuration of the EPLAN services is incorrect.

Prerequisite
l You must be an NM user with "NE or network operator" authority or higher.
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Context

CAUTION
When the EPLAN services are deleted, the VLAN unicast entries and disabled MAC address
entries are deleted.

Procedure

Step 1 In the NE Explorer, select an Ethernet board, and then choose Configuration  > Ethernet
Service > Ethernet LAN Service from the Function Tree.

Step 2 Click Query.

Step 3 Select the EPLAN service to be deleted and click Delete. Click OK in the Prompt dialog box
that is displayed. Then, a dialog box is displayed, indicating that the operation is successful, that
is, the EPLAN service is deleted successfully.

Step 4 Click Query to check whether the EPLAN service is deleted.

Step 5 See 6.4.2 Deleting SDH Services to delete the cross-connections of the EPLAN service.

----End

6.4.5 Deleting EVPLAN Services
EVPLAN services need to be deleted when the Ethernet boards that are configured with the
EVPLAN services need to be deleted or when the configuration of the EVPLAN services is
incorrect.

Prerequisite
l You must be an NM user with "NE or network operator" authority or higher.

Background Information

Deleting an EVPLAN service involves the following:

1. Deleting the VLAN filtering table
2. Deleting the service mounting configurations

Context

CAUTION
When the VLAN filtering table is deleted, the VLAN unicast entries and disabled MAC address
entries are deleted.
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Procedure

Step 1 In the NE Explorer, select an Ethernet board and then choose Configuration  > Ethernet
Service > Ethernet LAN Service from the Function Tree.

Step 2 Click Query.

Step 3 Click the VLAN Filtering tab.

Step 4 Select the VLAN filtering entry to be deleted and click Delete.

Step 5 Click the Service Mount tab.

Step 6 Select the EVPLAN service to be deleted and click Delete. Click OK in the Prompt dialog box
that is displayed. Then, a dialog box is displayed, indicating that the operation is successful, that
is, the EVPLAN service is deleted successfully.

Step 7 Click Query to check whether the EVPLAN service is deleted.

Step 8 See 6.4.2 Deleting SDH Services to delete the cross-connections of the EVPLAN service.

----End

6.5 Modifying the Protection Subnet
This topic describes how to modify the configuration data of the existing protection subnet.

6.5.1 Deleting Protection Subnets
Before you delete an NE or a fiber cable connection on the T2000, you need to delete the related
protection subnets first.

6.5.2 Setting Protection Subnet Parameters
For the SDH equipment, you can set parameters for MSP protection subnet by using the
protection subnet maintenance function.

6.5.1 Deleting Protection Subnets
Before you delete an NE or a fiber cable connection on the T2000, you need to delete the related
protection subnets first.

Prerequisite
l You must be an NM user with "network maintainer" authority or higher.

l If one or more trails are configured in the protection subnet that you want to delete, delete
the trails first.

Procedure

Step 1 Choose Protection Subnet > SDH Protection Subnet Management from the Main Menu.

Step 2 Right-click the protection subnet to be deleted and choose  Delete from the NMor Delete from
the NEor Delete All from the NM from the short-cut menu.
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NOTE

The methods to delete a protection subnet are as follows:

l Delete from the NM: Deletes the relation between the protection subnet and logical systems at the NE side,
to allow deleting of fibers, re-uploading, and so on. This command is not delivered to the NE and does not
affect the services. The deleted protection subnet can be located by using the search feature. The T2000
locates it according to the NE layer protection information.

l Delete from the NE: Deletes the protection subnet, logical systems at the NE side, and all traffic in the
protection subnet. The deleted protection subnet cannot be restored without being created again.

l Delete All from the NM : Deletes data other than fibers in the network layer. The deleted protection subnet
can be located by using the search feature. It is recommended that you do not select this option, as a large
amount of data can be deleted.

Step 3 In the Operation Promptdialog box, click Yes. After completion, the Operation Result dialog
box is displayed.

NOTE
If Delete from the NEis selected, you need to confirm the operation once more.

Step 4 ClickClose to complete the operation.

----End

6.5.2 Setting Protection Subnet Parameters
For the SDH equipment, you can set parameters for MSP protection subnet by using the
protection subnet maintenance function.

Prerequisite
l You must be an NM user with "network maintainer" authority or higher.

l On the T2000, the data of each NE must be configured, and fibers are created correctly.

l The MSP protection subnet must be configured.

Procedure

Step 1 Choose Protection Subnet > SDH Protection Subnet Maintenance from the Main Menu to
display the Protection Subnet Attributes dialog box.

Step 2 Select an MSP protection subnet from the left pane. The attribute information of the protection
subnet is displayed in the right pane.

Step 3 Click the Protection Subnet Parameters tab.

Step 4 Click Query to query the parameters of the protection subnet in the MSP ring.

Step 5 Click the WTR Time(s) text box and enter a value.

NOTE
By default, enter 600. You can also enter a value from 300 to 720.

Step 6 Optional: Select SD Condition.

Step 7 Click Apply to display the Operation Result prompt box. Then click Close.

----End
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7 Task Collection

About This Chapter

This topic describes each operation on the T2000 that is required during the service
configuration.

7.1 Creating SDH Services
To add or drop services between a tributary board and a line board, thereby realizing service
transmission in an SDH network, you need to create SDH cross-connections from the tributary
board to the line board.

7.2 Creating SNCP Services
The SNCP is characterized by the dual-fed and selective-receiving mode. The SNCP is used for
protecting services that travel across different subnets. When you configure SDH services on a
per-NE basis, you need to configure the SNCP if the services that travel across different subnets
need to be protected.

7.3 Configuring Trace Bytes
The trace bytes allow a receiving terminal to verify its continued connection to the intended
transmitting terminal. The characters in the trace byte must be set identically at both ends if the
interconnection involves only the equipment from the same vendor. If the interconnection
involves equipment from different vendors, the trace bytes should be set to defined characters.
Otherwise, the interconnection fails.

7.4 Configuring the C2 Byte
The C2 byte is used to indicate the multiplexing structure of the VC frames and the type of
payload (such as PDH services).

7.5 Setting Performance Monitoring Parameters of an NE
By setting performance monitoring parameters of an NE properly and starting the performance
monitoring for the NE, you can obtain the detailed performance record during the running of
the NE. This facilitates the monitoring and analysis of the NE running status performed by
maintenance personnel.

7.6 Verifying the Correctness of the SDH Service Configuration
According to the alarm reported on the T2000 and MSP switching status, you can check whether
the service configuration is correct. In addition, you can obtain the service switching time from
the SDH test meter.

7.7 Configuring External Ports on Ethernet Boards
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When an NE accesses Ethernet services through the external ports (that is, PORTs) on the
Ethernet board, you need to set the attributes of the PORTs so that the PORTs can work with
the data communication equipment on the client side. This ensures that the Ethernet services
can be accessed normally.

7.8 Configuring Internal Ports on Ethernet Boards
When an NE transmits Ethernet services through the internal ports (that is, VCTRUNK ports)
on the Ethernet board to the SDH side, you need to Set the attributes of the VCTRUNK ports
so that the VCTRUNK ports can work with the Ethernet board on the equipment at the opposite
end. This ensures that Ethernet services are transmitted normally on the SDH network.

7.9 Configuring Bound Paths
You can set the bandwidth and direction of a VCTRUNK by setting a bound path.

7.10 Creating EPL Services
When an Ethernet switching board carries private line services, the relevant information of the
private line services, such as the service source and service sink, must be specified.

7.11 Creating Ethernet LAN Services
When an Ethernet switching board carries LAN services, you need to create the bridge and set
the attributes of the bridge and the port mounted to the bridge.

7.12 Creating VLANs Filtering
In the case of Ethernet LAN services, when the type of the bridge is IEEE 802.1q or IEEE
802.1ad, the VLAN filtering table needs to be created for the bridge if VLANs are used to isolate
the data of different users.

7.13 Creating VLAN Unicast
You can configure VLAN unicast, to allow a packet whose destination address is the specified
MAC address to be forwarded through the specified port in the specified VLAN.

7.14 Disabling an MAC Address
You can disable an MAC address. As a result, this address receives no packets even in the same
VLAN.

7.15 Testing Ethernet Service Channels
If network cables are incorrectly connected or are faulty, the Ethernet service channels become
faulty. This affects the services. Hence, the Ethernet service channels must be normal.

7.16 Backing Up the NE Database to the SCC Board
You need to back up the NE database during daily maintenance, to ensure that the SCC board
of the NE automatically restores to normal operation after a data loss or equipment power failure.
When you back up the NE database to the SCC board, you actually back up the NE data to the
FLASH of the SCC board. When the NE is restarted after a power failure, the SCC board
automatically reads the configuration from the FLASH and issues the configuration to the
boards.

7.17 Checking the Network Communication Status
On some occasions, the T2000 cannot manage some NEs during the running of the network. By
checking the communication status of the network, you can know the communication status
between the T2000 and NEs.

7.18 Viewing the Clock Trace Search
Correct clock trace relations are critical to ensure the clock synchronization within the entire
network. Using the T2000, you can monitor the clock trace status of each NE.
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7.1 Creating SDH Services
To add or drop services between a tributary board and a line board, thereby realizing service
transmission in an SDH network, you need to create SDH cross-connections from the tributary
board to the line board.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select the NE and choose  Configuration > SDH Service Configuration
from the Function Tree.

Step 2 Click Query to query SDH services from the NE.

Step 3 Click Create and set the required parameters in the Create SDH Service dialog box that is
displayed.

Step 4 Click OK.

----End

7.2 Creating SNCP Services
The SNCP is characterized by the dual-fed and selective-receiving mode. The SNCP is used for
protecting services that travel across different subnets. When you configure SDH services on a
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per-NE basis, you need to configure the SNCP if the services that travel across different subnets
need to be protected.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select the NE and choose  Configuration > SDH Service Configuration
from the Function Tree.

Step 2 Click Query to query SNCP services from the NE.

Step 3 Click Create SNCP Service. Then, the Create SNCP Service dialog box is displayed.

Step 4 Set Service Type, Direction, Level, SNCP protection parameters, Working Service, and
Protection Service. Click OK. Then, the Operation Result dialog box is displayed, indicating
that the operation is successful.

Step 5 Click Close.

----End
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7.3 Configuring Trace Bytes
The trace bytes allow a receiving terminal to verify its continued connection to the intended
transmitting terminal. The characters in the trace byte must be set identically at both ends if the
interconnection involves only the equipment from the same vendor. If the interconnection
involves equipment from different vendors, the trace bytes should be set to defined characters.
Otherwise, the interconnection fails.

Prerequisite
l You must be an NM user with "NE maintainer" authority or higher.
l The VC-12/VC-3/VC-4 trace bytes can be queried or set only after the VC-12/VC-3/VC-4

cross-connection is created.

Procedure
Step 1 Select the trace byte to be configured.

If... Then...

You need to configure the J0 byte In the NE Explorer, select the board and choose
Configuration > Overhead Management >
Regenerator Section Overhead from the Function
Tree.

You need to configure the J1 byte l In the NE Explorer, select the board and choose
Configuration > Overhead Management > VC4
Path Overhead from the Function Tree. Then, click
the Trace Byte J1 tab.

l In the NE Explorer, select the board and choose
Configuration > Overhead Management > VC3
Path Overhead from the Function Tree. Then, click
the Trace Byte J1 tab.

You need to configure the J2 byte In the NE Explorer, select the board and choose
Configuration > Overhead Management > VC12
Path Overhead from the Function Tree. Then, click the
Trace Byte J2 tab.

Step 2 Click Options. Then, the Options dialog box is displayed. Select the mode of processing the
read and write attributes of the overhead byte.
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NOTE

l In the case of the J0 byte, the mode setting is unavailable.

l The T2000 uses Extended Mode or Standard Mode to process the read and write attributes of the
overhead byte. The T2000 functions more efficiently when processing the read and write attributes of
the overhead byte in extended mode than in standard mode.

Step 3 Right-click the trace byte and choose the input mode.

If... Then...

You choose Copy All Form Received Click Copy All Form Received.

You choose Manual Input Click Manual Input. Then, the Please input the
overhead byte dialog box is displayed. Choose Byte
Mode and Input Mode and enter the value of the
trace byte. Then, click OK.

NOTE

l If you choose Copy All Form Received, the value of the trace byte that is currently received is
automatically copied to the table.

l If you choose Manual Input, you can customize the value of the trace byte.

Step 4 Click Apply. Then, the Confirm dialog box is displayed.

Step 5 Click OK. Then, a dialog box is displayed indicating that the operation is successful. Click
Close.

----End

7.4 Configuring the C2 Byte
The C2 byte is used to indicate the multiplexing structure of the VC frames and the type of
payload (such as PDH services).

Prerequisite
l You must be an NM user with "NE maintainer" authority or higher.

l The cross-connection must be created on the NE.

Procedure

Step 1 Select the service level of the C2 byte.
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If... Then...

The service level of the C2 byte is VC-4 In the NE Explorer, select the board and choose
Configuration > Overhead Management > VC4
Path Overhead from the Function Tree. Then,
click the Signal Flag C2 tab.

The service level of the C2 byte is VC-3 In the NE Explorer, select the board and choose
Configuration > Overhead Management > VC3
Path Overhead from the Function Tree. Then,
click the Signal Flag C2 tab.

Step 2 Click Options. Then, the Options dialog box is displayed.

Step 3 Set Switch Mode to Extended Mode. Then, click OK.

NOTE

l You can set the C2 byte only when the mode is set to Extended Mode.

l The T2000 uses Extended Mode or Standard Mode to process the read and write attributes of the
overhead byte. The T2000 functions more efficiently when processing the read and write attributes of
the overhead byte in extended mode than in standard mode.

Step 4 Set C2 to be Sent and C2 to be Received.

Step 5 Click Apply. Then, the Confirm dialog box is displayed.

Step 6 Click OK. Then, a dialog box is displayed indicating that the operation is successful. Click
Close.

----End

7.5 Setting Performance Monitoring Parameters of an NE
By setting performance monitoring parameters of an NE properly and starting the performance
monitoring for the NE, you can obtain the detailed performance record during the running of
the NE. This facilitates the monitoring and analysis of the NE running status performed by
maintenance personnel.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

NE time is synchronized with the T2000 server.
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Procedure

Step 1 Choose Performance  > NE Performance Monitoring Time from the Main Menu.

Step 2 Select NEs from the NE list. Click the double-right-arrow button.

Step 3 Select one or more NEs, and set 15-minute and 24-hour performance monitor parameters
according to the requirement.

NOTE

l The start time must be later than the current time of the network management system and the end time must
be later than the start time.

l If the end time is not set, this indicates that the performance monitoring starts from the start time and does
not stop.

Step 4 Click Apply and click Close in the Operation Result dialog box.

----End

7.6 Verifying the Correctness of the SDH Service
Configuration

According to the alarm reported on the T2000 and MSP switching status, you can check whether
the service configuration is correct. In addition, you can obtain the service switching time from
the SDH test meter.

Prerequisite
l The creation of the physical topology of the network must be complete.
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l NEs, boards, and fibers must be successfully created on the T2000.

l The SDH test meter must be correctly connected to the source end and the sink end, and
the corresponding service type and rate must be configured.

l You must be a T2000 user with "NE and network administrator" authority or higher.

Background Information

When the service type and rate are set on the test meter, the "SIGNAL" and "FRAME" indicators
of the 37718 SDH analyzer turn green from red and are constantly on. If no alarm indicator is
flashing on the test meter, it indicates that the SDH test meter is connected properly to the
network.

Test Connection Diagram

As shown in Figure 7-1, the SDH test meters are connected to the source end and sink end of
the network to be tested. At the same time, the T2000 must be connected properly to the network
to be tested.

Figure 7-1 Test connection diagram

SDH ring

Source NE1

Source SDH analyzer
Sink NE2

Sink SDH analyzer

T2000

 

Precautions

CAUTION
An optical attenuator should be added at the "TX" optical interface on the board that is directly
connected to the SDH test meter. You also need to add an attenuator at the "RX" optical interface
if required. In this case, the attenuator can prevent the damage due to excessive optical power
on the test meter and board.
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Procedure

Step 1 Enable the SDH test meter at the source end and the SDH test meter at the sink end to monitor
the service switching in the network.

Step 2 In the Main Topology of the T2000, right-click the source NE and choose NE Explorer. In the
board directory tree on the left pane, Select the line board for service transmission. Then,
choose  Configuration > SDH Interface from the Function Tree.

Step 3 On the right pane, set Laser Switch to Close.

Step 4 Click Apply. Then, the Confirm dialog box is displayed. Click OK.

NOTE
By performing Steps 2–4, you can shut down the laser that transmits services at the source end. In this case,
the service on the working path is interrupted and the service switching condition is met.

Step 5 Choose Fault > Browse Current Alarms from the Main Menu on the T2000.

Step 6 Click OK in the Filter dialog box that is displayed. In the Current Alarms window, you can
browse various alarms such as the R_LOS alarm reported by the line board of the sink NE that
is directly connected to the line board of the source NE and whose laser is shut down, the
LASER_SHUT alarm reported by the source NE, and tributary alarms reported by the tributary
boards on the source NE and sink NE. For the meanings of the alarms and processing methods,
see the Maintenance Guide.

Step 7 The service interruption time displayed on the RESULT TS window on the test meter is equal
to the service switching time.

NOTE
On the test meter, the LONGEST and SHORTEST parameters in the RESULT TS window record the
longest switching time and the shortest switching time when the switching is performed multiple times.
The LAST parameter records the time of the latest switching.

Step 8 Query the switching state and service state on the T2000.

NOTE
Querying the MSP switching status is different from querying the SNCP switching status. Refer to Steps
9–11 to query the MSP service status. Refer to Steps 12 and 13 to query the SNCP service status.

Step 9 Choose Protection Subnet  > SDH Protection Subnet Maintenance from the Main Menu on
the T2000.

Step 10 Click the SDH Protection Subnet Maintenance tab on the right side of the Protection Subnet
Attributes pane. Query East Status and West Status. If the status is "Signal Fail Switching -
Ring", "SF Switching - Span", or "Lockout of protection-Span", the MSP switching is successful.

Step 11 Choose Fault > Browse Current Alarms from the Main Menu on the T2000. If no service
alarm is reported from the working path, the service switching is successful.

NOTE
According to the verification result obtained by performing Steps 10 and 11, the configuration of MSP ring
services is successful.
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Step 12 Select the NE to be queried in the Main Topology on the T2000, right-click the NE, and choose
NE Explorer. Then, choose Configuration  > SNCP Service Control from the Function Tree.

Step 13 Query Current Status, Trail Status, and Active Channel from the Working Service list and
Protection Service list on the right pane to check whether the service is switched successfully.

NOTE
The service switching and SNCP service configuration are successful if the following conditions are met:
1. The current status is SF switching. 2. The status of the working service path is SF. 3. The status of the
protection service path is normal. 4. The current path is the protection path.

----End

7.7 Configuring External Ports on Ethernet Boards
When an NE accesses Ethernet services through the external ports (that is, PORTs) on the
Ethernet board, you need to set the attributes of the PORTs so that the PORTs can work with
the data communication equipment on the client side. This ensures that the Ethernet services
can be accessed normally.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

The Ethernet boards must be created.

Procedure

Step 1 In the NE Explorer, select the Ethernet board and choose  Configuration > Ethernet Interface
Management > Ethernet Interface  from the Function Tree.

Step 2 Select External Port.

Step 3 Set the basic attributes of the external ports.
1. Click the Basic Attributes tab.
2. Set the basic attributes of the external ports.

NOTE

Working mode: By default, the working mode is auto-negotiation. That is, two ports operate in the
working mode of the highest level with pulse negotiation signals between them. The interconnected
ports must be set to consistent working modes. Otherwise, the services are unavailable.

3. Click Apply.
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Step 4 Set the flow control mode of the port.
1. Click the Flow Control tab.
2. Set the flow control mode of the port.

NOTE

l Auto-negotiation flow control mode: Select this flow control mode when the working mode of
the port is auto-negotiation. Enable Dissymmetric Flow Control indicates that flow control
frames are transmitted rather than being received. Enable Symmetric Flow Control indicates
that PAUSE frames can be transmitted and received. Enable Symmetric/Dissymmetric Flow
Control indicates that the auto-negotiation determines whether to adopt the symmetric or
dissymmetric flow control.

l Non-auto-negotiation flow control mode: Select this flow control mode when the working mode
of the port is not auto-negotiation. Enable Symmetric Flow Control indicates that PAUSE
frames can be transmitted and received. Send Only indicates that PAUSE frames can only be
transmitted. Receive Only indicates that PAUSE frames can only be received.

3. Click Apply.

Step 5 Set the tag attributes of the external ports.

NOTE

Ethernet transparent transmission boards do not support the tag attributes.

1. Click the TAG Attributes tab.
2. Set the tag attributes of the external ports.

3. Click Apply.

Step 6 Set the network attributes of the external ports.

NOTE

Ethernet transparent transmission boards do not support the network attributes.

1. Click the Network Attributes tab.
2. Set the network attributes of the external ports.

Figure 7-2 Attributes of the external ports on the Ethernet boards that support the QinQ function
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NOTE

l When the network attribute of the port is set to UNI, the port processes the TAG attributes of the
802.1Q-compliant packets. The UNI port has the tag aware, access, and hybrid attributes.

l When the network attribute of the port is set to C-aware, the port does not process the TAG
attributes of the 802.1Q-compliant packets. The C-aware port considers that the accessed packet
does not contain an S-VLAN tag and processes only the packets that contain a C-VLAN tag.

l When the network attribute of the port is set to S-aware, the port does not process the TAG
attributes of the 802.1Q-compliant packets. The S-aware port considers that the accessed packet
does not contain a C-VLAN tag and processes only the packets that contain an S-VLAN tag.

3. Click Apply.

Step 7 Set the advanced attributes of the external ports.

NOTE

Ethernet transparent transmission boards do not support the advanced attributes.

1. Click the Advanced Attributes tab.

2. Set the advanced attributes of the external ports.

3. Click Apply.

----End

7.8 Configuring Internal Ports on Ethernet Boards
When an NE transmits Ethernet services through the internal ports (that is, VCTRUNK ports)
on the Ethernet board to the SDH side, you need to Set the attributes of the VCTRUNK ports
so that the VCTRUNK ports can work with the Ethernet board on the equipment at the opposite
end. This ensures that Ethernet services are transmitted normally on the SDH network.

Prerequisite

You must be an NM user with "NE operator" authority or higher.

The Ethernet boards must be created.

Precautions

CAUTION
Incorrect configuration of binding paths may cause service interruption.
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Procedure

Step 1 In the NE Explorer, select the Ethernet board and choose  Configuration > Ethernet Interface
Management > Ethernet Interface  from the Function Tree.

Step 2 Select Internal Port.

Step 3 Set the tag attributes of the internal ports.

1. Click the TAG Attributes tab.

2. Set the tag attributes of the internal ports.

3. Click Apply.

Step 4 Set the network attributes of the internal ports.

1. Click the Network Attributes tab.

2. Set the network attributes of the internal ports.

Figure 7-3 Attributes of the internal ports on the Ethernet boards that support the QinQ function

 

3. Click Apply.

Step 5 Set the encapsulation/mapping protocol for the internal ports.

1. Click the Encapsulation/Mapping tab.

2. Set the mapping protocol and the protocol parameters.

NOTE

Mapping Protocol of the VCTRUNKs must be consistent on the Ethernet boards at both ends of the
transmission line. In addition, the protocol parameters must also be consistent.

3. Click Apply.

Step 6 Configure the LCAS function of the internal ports.

1. Click the LCAS tab.

2. Set Enabling LCAS and the other LCAS parameters.
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NOTE

Enabling LCAS of the VCTRUNKs must be consistent on the Ethernet boards at both ends of the
transmission line. In addition, the LCAS protocol parameters must also be consistent.

3. Click Apply.

Step 7 Set the paths to be bound with the internal ports.
1. Click the Bound Path tab and click Configuration. Then, the Bound Path

Configuration dialog box is displayed.
2. Select a VCTRUNK port as the port to be configured from the Configurable Ports drop-

down list. In Available Bound Paths, select the timeslots of the bearer layer. Then, click

.

3. Click OK, and then click Yes. The Operation Result dialog box is displayed indicating
that the operation is successful.

4. Click Close.

Step 8 Set the advanced attributes of the internal ports.
1. Click the Advanced Attributes tab.
2. Set the advanced attributes of the internal ports.
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3. Click Apply.

----End

7.9 Configuring Bound Paths
You can set the bandwidth and direction of a VCTRUNK by setting a bound path.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

The Ethernet board must be created.

Context

CAUTION
Configuring the bound path may interrupt services.

Procedure

Step 1 In the NE Explorer, select an Ethernet board and choose  Configuration > Ethernet Interface
Management > Ethernet Interface  from the Function Tree. Click the Internal Port option
button.

Step 2 Click the Bound Path tab. Click Configuration, and the Bound Path Configuration dialog
box is displayed.

Step 3 Select the VCTRUNK port you want to bind from Configurable Ports. Select the bearer layer
path from the Available Bound Paths combo box. Click .
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NOTE
Refer to the actual service requirement to select the level of the bound path. For example, if you want to
configure 10 Mbit/s services, select VC12-xv. To configure 100 Mbit/s services, select VC3-xv.

Step 4 Click OK. A dialog box is displayed.

Step 5 Click Yes, and click Close in the Operation Result dialog box.

----End

7.10 Creating EPL Services
When an Ethernet switching board carries private line services, the relevant information of the
private line services, such as the service source and service sink, must be specified.

Prerequisite
l You must be an NM user with "NE or network operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select the Ethernet board and choose  Configuration > Ethernet Service
> Ethernet Line Service from the Function Tree.

Step 2 Select the proper operation from the following options according to the type of the EPL services
to be created.

Option Description

EPL services Proceed to Step 3.

EVPL (QinQ) services Select Display QinQ Shared Service.

Step 3 Click New.
The Create Ethernet Line Service dialog box is displayed.

Step 4 Set the attributes of the private line service.
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Step 5 Set the attributes of the source port and sink port.

Figure 7-4 Attributes of the ports on the Ethernet boards that support the QinQ function

 

Step 6 Set the VC paths to be bound with the internal ports.
1. Click Configuration.

The Bound Path Configuration dialog box is displayed.
2. In Configurable Ports, select a VCTRUNK as the port to be configured.
3. In Available Bound Paths, set Level and Direction of the bound paths.
4. Select the required items in Available Resources and Available Timeslots and click

.
5. Repeat Steps Step 6.2 to Step 6.4 and bind other VC paths.
6. Click OK.

NOTE

The timeslots on the transmission line that correspond to the paths bound with the VCTRUNKs at
both ends of the transmission line must be consistent.
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Step 7 Click OK.
The Operation Result dialog box is displayed indicating that the operation is successful.

----End

7.11 Creating Ethernet LAN Services
When an Ethernet switching board carries LAN services, you need to create the bridge and set
the attributes of the bridge and the port mounted to the bridge.

Prerequisite
l You must be an NM user with "NE or network operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select the Ethernet board and choose  Configuration > Ethernet Service
> Ethernet LAN Service from the Function Tree.

Step 2 Click New.
The Create Ethernet LAN Service dialog box is displayed.

Step 3 Set the attributes of the bridge.
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Step 4 Configure service mounting relations.

Option Description

Configure the services that are mounted to the IEEE 802.1d or
IEEE 802.1q bridge.

Proceed to Step Step 5.

Configure the services that are mounted to the IEEE 802.1ad
bridge.

Go to Step Step 6.

Step 5 Optional: Configure the services that are mounted to the IEEE 802.1d or IEEE 802.1q bridge.
1. Click Configure Mount.

2. Select Available Mounted Ports and click .
3. Optional: Repeat Step Step 5.2 and select the other ports to be mounted.

4. Click OK.
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Step 6 Optional: Configure the services that are mounted to the IEEE 802.1ad bridge.
1. Click Configure Mount.
2. Set the parameters for configuring the mounted services.

3. Click Add Mount Port.
4. Repeat Steps Step 6.2 to Step 6.3 to add the other mount ports.
5. Click OK.

Step 7 Set the VC paths to be bound with the internal ports.
1. Click Configuration.

The Bound Path Configuration dialog box is displayed.
2. In Configurable Ports, select a VCTRUNK as the port to be configured.
3. In Available Bound Paths, set Level and Direction of the bound paths.
4. Select the required items in Available Resources and Available Timeslots and click

.
5. Repeat Step 7.2 to Step 7.4 and bind other VC paths.
6. Click OK.

NOTE

The timeslots of the paths bound with the VCTRUNKs on the Ethernet board must be consistent with
the timeslots on the line board.
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----End

7.12 Creating VLANs Filtering
In the case of Ethernet LAN services, when the type of the bridge is IEEE 802.1q or IEEE
802.1ad, the VLAN filtering table needs to be created for the bridge if VLANs are used to isolate
the data of different users.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

The bridge and mount ports must be created.

Make sure that you set Bridge Switch Mode to IVL/Ingress Filter Enable. Only in this way,
you can create VLAN filtering tables

Procedure

Step 1 In the NE Explorer, select an Ethernet board and choose Configuration > Ethernet Service >
Ethernet LAN Service from the Function Tree. Click the VLAN Filtering tab.

Step 2 Click New and the Create VLAN dialog box is displayed. Enter a VLAN ID, select an Available

forwarding ports, and then click .
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Step 3 Click OK. Close in the Operation Result dialog box.

Step 4 Create other VLAN filtering tables as required.

----End

7.13 Creating VLAN Unicast
You can configure VLAN unicast, to allow a packet whose destination address is the specified
MAC address to be forwarded through the specified port in the specified VLAN.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Procedure

Step 1 In the NE Explorer, select an Ethernet board and choose  Configuration > Ethernet Service
> Ethernet LAN Service from the Function Tree. Click the VLAN Unicast tab.

Step 2 Click New and the Create VLAN Unicast dialog box is displayed. Set VLAN ID, MAC
Address, and Physical Port.

Step 3 Click OK. Click Close in the Operation Result dialog box.

----End
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7.14 Disabling an MAC Address
You can disable an MAC address. As a result, this address receives no packets even in the same
VLAN.

Prerequisite

You must be an NM user with "NE operator" authority or higher.

Context

CAUTION
This operation may interrupt the service.

Procedure

Step 1 In the NE Explorer, select an Ethernet board and choose  Configuration > Ethernet Service
> Ethernet LAN Service from the Function Tree. Click the Disable MAC Address tab.

Step 2 Click New and the Disable MAC Address Creation dialog box is displayed. Set VLAN ID
and MAC Address.

NOTE
The first byte of the MAC Address of VLAN unicast must be even.

Step 3 Click OK and then click Close in the Operation Result dialog box.

----End

7.15 Testing Ethernet Service Channels
If network cables are incorrectly connected or are faulty, the Ethernet service channels become
faulty. This affects the services. Hence, the Ethernet service channels must be normal.

Prerequisite

The Ethernet services must be created and activated.
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Tools, Equipment, and Materials

Two laptops on which the Windows operating system is installed, two straight through cables

Test Connection Diagram

Figure 7-5 shows the connection for testing the Ethernet service channels.

If an Ethernet service is configured between NE1 and NE3, you can connect the two laptops to
the Ethernet boards through network cables and perform a ping test.

Figure 7-5 Connection for testing the Ethernet service channels

T2000

Laptop A

Laptop B

NE1

NE2

NE3

NE4

 

Precautions
NOTE

TAG of the external ports on the Ethernet boards at the source and sink ends of the accessed Ethernet
service must be set to Access. In addition, Default VLAN ID of the external ports must be set to the same
value.

Procedure

Step 1 Connect the external ports on the Ethernet boards to the network ports of the laptops at the source
and sink ends of the service by using network cables according to Figure 7-5.

Step 2 Set IP addresses for laptop A and laptop B. Ensure that the two IP addresses are in the same
network segment. Set the IP addresses as follows:
l Set an IP address for laptop A.

– IP address: 192.168.0.100

– Subnet mask: 255.255.0.0

l Set an IP address for laptop B.
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– IP address: 192.168.0.101

– Subnet mask: 255.255.0.0

NOTE

The IP addresses must not be set to loopback addresses within the 127.0.0.0 network segment.

Step 3 Choose Start > Run on laptop A. Then, a dialog box is displayed. Enter the following ping
command: ping 192.168.0.101.

Step 4 Click OK to run the ping command.

l If the information in the displayed window contains "Lost = 0 (0% loss)", it indicates that no
packet is lost and the Ethernet channels are normal.

l If the displayed window returns the message Request timed out, the Ethernet channels are
abnormal. Check the connection of the network cables and the configuration of the Ethernet
services. Rectify the fault and then continue the test.

----End

7.16 Backing Up the NE Database to the SCC Board
You need to back up the NE database during daily maintenance, to ensure that the SCC board
of the NE automatically restores to normal operation after a data loss or equipment power failure.
When you back up the NE database to the SCC board, you actually back up the NE data to the
FLASH of the SCC board. When the NE is restarted after a power failure, the SCC board
automatically reads the configuration from the FLASH and issues the configuration to the
boards.

Prerequisite

You must be an NM user with "NE operator" authority or higher.

You must log in to the NE as an NE user with system level authority.

Procedure

Step 1 In the Main Menu, choose Configuration  > Configuration Data Management.

Step 2 In the Object Tree on the left, select an NE and click .

Step 3 In Configuration Data Management List, select an NE or multiple NEs.

Step 4 Choose Back Up NE Data  > Back Up Database to SCC.

NOTE
Backing up the database may takes about 30 minutes.

Step 5 Click OK in the confirmation dialog box.

Step 6 The Operation Result dialog box is displayed. After the backup is successful, click Close.

----End

7 Task Collection

OptiX OSN 500 STM-1/STM-4 Multi-Service CPE Optical
Transmission System
Configuration Guide

7-26 Huawei Proprietary and Confidential
Copyright © Huawei Technologies Co., Ltd.

Issue 01 (2009-01-20)



7.17 Checking the Network Communication Status
On some occasions, the T2000 cannot manage some NEs during the running of the network. By
checking the communication status of the network, you can know the communication status
between the T2000 and NEs.

Prerequisite
You must be an NM user with "NE maintainer" authority or higher.

Context
If you know the IP address or the NSAP address of an NE, you can choose  File > Ping from
the Main Menu to use the ping command to check the communication status of the NE.

Procedure
l Check the communication status between the T2000 and a non-gateway NE.

1. Choose System  > DCN Management from the Main Menu.
2. Click the NE tab. Click Refresh to view the communication status of all NEs.
3. Select an NE. Right-click in the Communication Status column and choose Test

NE from the shortcut menu.
4. The Operation Result dialog box is displayed indicating the test result of the non-

gateway NE.
l Check the communication status between the T2000 and the GNE.

1. Choose System  > DCN Management from the Main Menu.
2. Click the GNE tab. Click Refresh to view the communication status of the GNE.
3. Right-click an NE and choose Test GNE from the shortcut menu.
4. The Operation Result dialog box is displayed indicating the test result of the GNE.

----End

7.18 Viewing the Clock Trace Search
Correct clock trace relations are critical to ensure the clock synchronization within the entire
network. Using the T2000, you can monitor the clock trace status of each NE.

Prerequisite
You must be an NM user with "NE operator" authority or higher.

Procedure
Step 1 In the Clock View, right-click and choose  Clock Trace Search from the shortcut menu.

Step 2 In the OK dialog box, click OK.

Step 3 If the clock trace relation changes, the Prompt dialog box is displayed, asking you whether to
refresh the clock trace relation. Click Yes. When the search for the clock trace relation is
complete, the Clock View displays the refreshed clock trace status.
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NOTE

If you right-click in the Clock View and choose Disable Clock Status Change Prompting from the
shortcut menu, the Prompt dialog box is not displayed even when the clock trace relation changes.

Step 4 In the Clock View, right-click and choose  Query Networkwide Clock Synchronization
Status  from the shortcut menu, to refresh the clock tracing relation.

----End
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8 Equipment Information

About This Chapter

You need to consider the service support capability of the boards used by the equipment and the
configuration requirements during the configuration process.

8.1 Service Support Capability of Ethernet Boards
Ethernet boards are classified into Ethernet transparent transmission boards and Ethernet
switching boards, based on the type of the accessed service. The Ethernet transparent
transmission boards support only EPL services, whereas the Ethernet switching boards support
EPL services, EVPL services, and Layer 2 switching function.

8.2 Requirements for Binding Paths with VCTRUNKs on Ethernet Boards
One VCTRUNK on an Ethernet board can only be bound with timeslots of the same level.

8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of Ethernet Boards
To determine the level of the bandwidths to be bound with a VCTRUNK and the number of
paths that are required for an Ethernet service, you need to calculate the theoretical bandwidth
of the Ethernet service that can be carried by a VCTRUNK.
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8.1 Service Support Capability of Ethernet Boards
Ethernet boards are classified into Ethernet transparent transmission boards and Ethernet
switching boards, based on the type of the accessed service. The Ethernet transparent
transmission boards support only EPL services, whereas the Ethernet switching boards support
EPL services, EVPL services, and Layer 2 switching function.

Table 8-1 Service support capability of Ethernet boards

Board Type Board
Name

Supported EPL Service Supported EPLAN Service

Ethernet
transparent
transmission board

EFT8 EPL -

EGT1 EPL -

Ethernet switching
board

EFS8 EPL
EVPL

EVPLAN (IEEE 802.1q bridge), EPLAN
(IEEE 802.1d bridge), and EVPLAN (IEEE
802.1ad bridge)

8.2 Requirements for Binding Paths with VCTRUNKs on
Ethernet Boards

One VCTRUNK on an Ethernet board can only be bound with timeslots of the same level.

Table 8-2 Requirements for binding paths with VCTRUNKs on Ethernet boards

Board Requirement for Binding Paths with a VCTRUNK

EFT8 l The VCTRUNKs can be bound with the VC-12 paths and VC-3 paths.

l Eight VCTRUNKs are supported.

l VCTRUNK1 to VCTRUNK8 can only be bound with the fourth VC-4, namely, VC4-4, if
the path binding is at VC-12 level.

l VCTRUNK1 to VCTRUNK8 can be bound with the first to third VC-4s, namely, VC4-1 to
VC4-3, if the path binding is at VC-3 level.

EGT1 l The VCTRUNKs can be bound with the VC-12 and VC-3 paths.

l Only one VCTRUNK is supported.

l VCTRUNK1 can only be bound with the fourth VC-4, namely, VC4-4, if the path binding
is at VC-12 level.

l VCTRUNK1 can be bound with the first to fourth VC-4s, namely, VC4-1 to VC4-4, if the
path binding is at VC-3 level.
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Board Requirement for Binding Paths with a VCTRUNK

EFS8 l The VCTRUNKs can be bound with the VC-12 paths and VC-3 paths.

l Eight VCTRUNKs are supported.

l VCTRUNK1 to VCTRUNK8 can only be bound with the fourth VC-4, namely, VC4-4, if
the path binding is at VC-12 level.

l VCTRUNK1 to VCTRUNK8 can be bound with the first to third VC-4s, namely, VC4-1 to
VC4-3, if the path binding is at VC-3 level.

8.3 Ethernet Service Bandwidths Carried by VCTRUNKs of
Ethernet Boards

To determine the level of the bandwidths to be bound with a VCTRUNK and the number of
paths that are required for an Ethernet service, you need to calculate the theoretical bandwidth
of the Ethernet service that can be carried by a VCTRUNK.

Bandwidth = Number of paths bound with the VCTRUNK x Payload rate of the binding
granularity x Encapsulation efficiency of the encapsulation protocol

The payload rate of the VC-12 is 2.176 Mbit/s and the payload rate of the VC-3 is 48.384 Mbit/
s. GFP encapsulation efficiency is equal to the Ethernet frame length that is divided by the sum
of the Ethernet frame length and an overhead of eight bytes. Hence, in the case of the VCTRUNK
that are bound with five VC-12 paths, when the transported Ethernet frame length is 1500 bytes,
the theoretical bandwidth is 10.82 Mbit/s; when the transported Ethernet frame length is 64
bytes, the theoretical bandwidth is 9.67 Mbit/s.

In actual situations, you can estimate the level and quantity of the paths according to the
following principle: One VC-12 path carries 2 Mbit/s services and one VC-3 path carries 48
Mbit/s services. For example, in the case of a 10 Mbit/s Ethernet service, the VCTRUNKs can
be bound with five VC-12 paths.
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9 Glossary

B  

Back up Copy the important data into a backing storage in case that the original is
damaged or corrupted.

BITS Building Integrated Timing Supply. A building timing supply that
minimizes the number of synchronization links entering an office.
Sometimes referred to as a synchronization supply unit.

Bound path The VC Trunk refers to the 2 Mbps paths which are bound together to
transmit Ethernet data. The VC Trunk is an entity between the Ethernet
port and the 2 Mbps path.

  

C  

CAR Committed Access Rate. The CAR limits the input or output transmission
rate on an interface.

  

E  

ECC Embedded Control Channel. An ECC provides a logical operations
channel between SDH NEs, utilizing a data communications channel
(DCC) as its physical layer.

EPL Ethernet Private Line. An EPL service is a point-to-point interconnection
between two UNIs without SDH bandwidth sharing. Transport bandwidth
is never shared between different customers.

EPLAN Ethernet Private LAN. An EPLAN service is both a LAN service and a
private service. Transport bandwidth is never shared between different
customers.

EVPL Ethernet Virtual Private Line. An EVPL service is a service that is both a
line service and a virtual private service.

EVPLAN Ethernet Virtual Private Local Area Network. An EVPLAN service is a
service that is both a LAN service and a virtual private service.
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Ethernet A data link level protocol comprising the OSI model's bottom two layers.
It is a broadcast networking technology that can use several different
physical media, including twisted pair cable and coaxial cable. Ethernet
usually uses CSMA/CD. TCP/IP is commonly used with Ethernet
networks.

  

G  

Gateway IP IP address is used for TCP/IP communication between an NE and the
T2000, which is effective only when it is used for TCP/IP communication.
That is, only the gateway NE needs the IP address. IP address cannot be
used to identify an NE uniquely. NEs in different TCP/IP networks may
have the same IP address. And one NE may have several IP addresses (for
example: an IP address of a dial-up network, an IP address of the Ethernet
port and so on).

  

L  

LCAS Link Capacity Adjustment Scheme. A solution features flexible
bandwidth and dynamic adjustment. In addition, it provides a failure
tolerance mechanism, which enhances the viability of virtual
concatenations and enables the dynamic adjustment to bandwidth (non-
service affecting).

Loopback The fault of each path on the optical fiber can be located by setting
loopback for each path of the line. There are three kinds of loopback
modes: No loopback, Outloop, Inloop.

  

M  

MPLS Multiprotocol Label Switching. Multi-protocol label switching. It is a
standard routing and switching technology platform, capable of
supporting various high level protocols and services. The data
transmission over an MPLS network is independent of route calculating.
MPLS, as a connection-oriented transmission technology, guarantees
QoS effectively, supports various network level technologies, and is
independent of the link layer.

MSTP Multi-service transmission platform. It is based on the SDH platform,
capable of accessing, processing and transmitting TDM services, ATM
services, and Ethernet services, and providing unified management of
these services.

  

O  

Orderwire It establishes the voice communication among the operators and
maintenance engineers work in each working station.
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P  

PDH Plesiochronous Digital Hierarchy. PDH is the digital networking
hierarchy that is used before the advent of Sonet/SDH.

PRBS Pseudo-random binary sequence. A sequence that is random in a sense
that the value of an element is independent of the values of any of the
other elements, similar to real random sequences.

  

R  

RSTP The Rapid Spanning Tree Protocol is an evolution of the Spanning Tree
Protocol, providing for faster spanning tree convergence after a topology
change.

  

S  

SDH Synchronous Digital Hierarchy. A hierarchical set of digital transport
structures, standardized for the transport of suitably adapted payloads over
physical transmission networks.

SNCP Subnetwork Connection Protection. A working subnetwork connection is
replaced by a protection subnetwork connection if the working
subnetwork connection fails, or if its performance falls below a required
level.

SSM Synchronization Status Message. ITU-T defines S1 byte to transmit the
network synchronization status information. It uses the lower four bits of
the multiplex section overhead S1 byte to indicate 16 types of
synchronization quality grades.

STP STP is a protocol that provides a loop free topology for any bridged LAN
and is used in switched networks to prevent loops.

Subnet mask Also referred to as the network mask off code, it is used to define network
segments, so that only the computers in the same network segment can
communicate with one another, thus suppressing broadcast storm between
different network segments.

Subnet Subnetwork is the logical entity in the transmission network and
comprises a group of network management objects. A subnetwork can
contain NEs and other subnetworks. A subnetwork planning can better
the organization of a network view.

Switching
priority

There may be the case that several protected boards need to be switched;
thus the tributary board switching priority should be set. If the switching
priority of each board is set the same, the tributary board that fails later
cannot be switched. The board with higher priority can preempt the
switching of that with lower priority.

  

T  
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TCP/IP Transmission Control Protocol/Internet Protocol. Common name for the
suite of protocols developed to support the construction of worldwide
internet networks.

Timeslot Single timeslot on an E1 digital interface—that is, a 64-kbps,
synchronous, full-duplex data channel, typically used for a single voice
connection.

TPS Tributary Protection Switching. A function provided by the equipment, is
intended to protect N tributary processing boards through a standby
tributary processing board.

Trail
management
function

A network level management functions of the T2000. Through trail
management, you can configure end-to-end services, view graphic
interface and visual routes of a trail, query detailed information of a trail,
filter, search and locate a trail quickly, manage and maintain trails in a
centralized manner, manage alarms and performance data by trail, and
print a trail report.

TUG A unit group that contains one or more Tributary Units, occupying fixed,
defined positions in a higher order VC-n payload. TUGs are defined in
such a way that mixed capacity payloads made up of different size
Tributary Units can be constructed to increase flexibility of the transport
network.

  

V  

VLAN ID Namely, it is the virtual LAN identifier. One Ethernet port can support
4K VLAN routes, and one NE can support up to 8K VLAN routes.

VLAN Virtual local area network. A subset of the active topology of a Bridged
Local Area Network. Associated with each VLAN is a VLAN Identifier
(VID).

  

W  

WTR time A period of time that must elapse before a – from a fault recovered – trail/
connection can be used again to transport the normal traffic signal and/or
to select the normal traffic signal from.

WTR Wait to Restore. This command is issued when working channels meet
the restoral threshold after an SD or SF condition. It is used to maintain
the state during the WTR period unless it is pre-empted by a higher priority
bridge request.
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10 Acronyms and Abbreviations

B  

BIP Bit-Interleaved Parity

BITS Building Integrated Timing Supply System

  

C  

CPE Customer Premises Equipment

  

E  

EPL Ethernet Private Line

  

G  

GFP Generic Framing Procedure

  

L  

LPT Link State Pass Through

LCAS Link Capacity Adjustment Scheme

  

M  

MSP Multiplex Section Protection

MSTP Multi-Service Transport Platform

MTU Maximum Transmission Unit

  

OptiX OSN 500 STM-1/STM-4 Multi-Service CPE Optical
Transmission System
Configuration Guide 10 Acronyms and Abbreviations

Issue 01 (2009-01-20) Huawei Proprietary and Confidential
Copyright © Huawei Technologies Co., Ltd.

10-1



P  

PDH Plesiochronous Digital Hierarchy

  

S  

SDH Synchronous Digital Hierarchy

SNCP Sub-Network Connection Protection

SNMP Simple Network Management Protocol

SSM Synchronization Status Message
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